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Control4 Disclaimer 
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or 
implied warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any 
and all parts of this publication at any time, without any obligation to notify any person or entity of such changes. 

 
Trademarks 
Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and company names 
mentioned in this document may be the trademarks or registered trademarks of their respective owners. 

 
Legal Notice 
 
GNU 
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
(Section 3.b.) 
You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the 
terms of Sections 1 and 2 above provided that you also do one of the following:  
Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of 
physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be 
distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange. 
The complete text for this license is available on the Control4 website at: http://www.control4.com.  

Gracenote 
Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a 
trademark of Gracenote, Inc. in the United States and/or other countries. 
Music and DVD recognition technology and related data are provided by Gracenote®.   
Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information 
visit www.gracenote.com. 

MPEG 
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of 
this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating 
broadcast systems (terrestrial, satellite, cable, and /or other distribution channels), streaming applications (via Internet, 
intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like) 
or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An 
independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the service provider of 
AM/FM channel list. 
© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text 
that enriches the Control4 user Navigators. 

Copyright 
© 2012 Control4. All rights reserved. Control4, the Control4 logo, the Control4 iQ logo and the Control4 certified logo are 
registered trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other brands or 
names may be claimed as property by their respective owners. Pricing and specifications subject to change without notice.  
 No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express 
written consent of the publisher.  
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1. Introduction 
Composer Professional Edition (Composer Pro) is a Control4® software application that Control4 
Dealers and Installers use to set up and configure Control4 and third-party devices to communicate 
with each other in the Control4 Home-Automation System. 

1.1 Purpose 
The purpose of this document is to provide steps, tips, and examples about how to use the Composer 
Pro software for the Control4 Operating System (OS 2.2) and later. 
 
Words that appear in red are either listed in the Glossary, or are tips, examples, and other important 
information. 

1.2 Scope 
This Control4® Composer Pro User Guide is divided into Basic and Advanced sections. 
  
The Basics sections provide information and instructions about: 

• Installing devices 
• What's new in this release 
• Configuring properties 
• Configuring devices 
• Customizing the Navigators 
• Updating Composer and Director 
• Example projects 
• Troubleshooting the system 
• Information about older releases 

  
The Advanced sections provide information and instructions about: 

• Setting up the network configuration 
• Creating device drivers 
• Connecting and verifying devices 
• Setting up the media 
• Programming the system 

 
If you've never used Composer Pro before, we suggest that you start by reading either Composer Pro 
Getting Started available in the Composer Pro application's Help menu or on the Control4 website in 
PDF. If you're already familiar with Composer Pro, you can skip through the Composer Pro Getting 
Started, and continue with the sections in this document.  
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1.3 Related Documents and Resources 
Document Title Location 

Composer Pro Getting 
Started (200-00168) 

Application Help: Available in the Composer Pro Help menu 
PDF: http://www.control4.com/dealer/products/documentation/  

Control4 System Quick 
Start Guide (200-00153) 

PDF Only: 
http://www.control4.com/residential/products/resources/#documentation/  

Control4 System User 
Guide (200-00001) 

Web Help: http://www.control4.com/documentation/System_User_Guide/  
PDF: http://www.control4.com/residential/products/resources/# 
documentation/ 

Control4 Operating 
System Release 
Version 2.0.1 Release 
Notes (TechDoc00031) 

PDF Only: Included with software package on the Control4 Dealer website. 
Also available on the Control4 Knowledgebase. 

Composer Pro 
Software Release 
Update Instructions - 
Release 1.7.4 to OS 2.0 
(TechDoc00024) 

PDF Only: Control4 Knowledgebase 

Managing Dealer 
Accounts on 
My.Control4.Com 
(TechDoc00025) 

PDF Only: Control4 Knowledgebase 

Control4 MyHome 
Setup Guide (DOC-
00003) 

PDF Only: http://www.control4.com/dealer/products/documentation/ 

1.4 What’s New in this Release? 
The Control4® system Composer Pro software for OS 2.0 and later contains new features and 
functions: 

1.4.1 OS 2.2 

1.4.1.1 Hardware and Software Support 
• Added the SNMP Configuration Agent. You can now manage Control4 home networks 

remotely. See "About SNMP" in the Composer Pro Getting Started for information. 
• Added support for a new 7" Portable Touch Screen with Camera (C4-TSMC7-EN-BL) and 

audio/video Intercom. 
• Added support for a new HC-800 Home Controller (C4-HC800-BL). 
• Added support for a new Intercom (used for Intercom with audio in the new 5” In-Wall Touch 

Screen or 7" In-Wall Touch Screen and audio/video Intercom in the new 7” Portable Touch 
Screen with Camera). 

http://www.control4.com/dealer/products/documentation/�
http://www.control4.com/residential/products/resources/#documentation/�
http://www.control4.com/documentation/System_User_Guide/�
http://www.control4.com/residential/products/resources/# documentation/�
http://www.control4.com/residential/products/resources/# documentation/�
https://support.control4.com/kb/login/index_enter/�
https://support.control4.com/kb/login/index_enter/�
https://support.control4.com/kb/login/index_enter/�
http://www.control4.com/dealer/products/documentation/�
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• UI improvements to the Intercom feature for the 5” In-Wall Touch Screen and 7" In-Wall 
Touch Screen. 

• You can now use Shift+Click or Ctrl+Click to specify device availability and display order for 
the Navigators. 

1.4.1.2 New or Updated Topics 
• A new SNMP Configuration Agent has been added. Six (6) related SNMP topics have been 

added also. See "Configuring the SNMP Configuration Agent" for details. 
• A new "Configure a 7" Portable Touch Screen with Camera" topic has been added. Note: 

This is a new product that will replace the existing 7" Portable Touch Screen (C4-TSM7-G) 
and 7" Tabletop Touch Screen (C4-TST7-EG and C4-TSTR7-EG) products. 

• Changed the name of "Configure Home Controller HC-200, HC-300, or HC-1000" to 
"Configure an HC-Class Home Controller." Added new information for HC-800 Home 
Controller (C4-HC800-BL). 

• "Configure an HC-Class Controller." Updated Step 8 with information about the ZigBee 
Network Settings dialog box. Also added a new Properties page. 

1.4.2 OS 2.1.0 

1.4.2.1 Hardware and Software Support 
• Added the Apps container to the default Control4 home page; 4Store is now in the Apps 

container. This means that there are currently seven (7) containers on the fully-populated 
default Control4 Home page (Watch, Listen, Lights, Security, Comfort, Apps, and More). 

• When there is only a single Thermostat in the project, selecting Comfort from the Home page 
automatically loads the Thermostat control UI. 

• Added the ability to turn off the Ambient Light Sensor on the SR-250 (V2) from the remote’s 
LCD menu. 

• Added a new 4Store agent. 
• Added the ability to create custom buttons for the Navigator screens. 
• Photo Screen Saver agent can now serve a single image on all connected graphical 

Navigators. 
• Added the ability to create new Themes using the Themes SDK. See the Control4 SDK 

program for details. 
• Added the ability to create a USB Install from the Control4 folder. Can now perform a USB 

install on systems not connected to the Internet. 
• MyHome apps now supported for mobile and PC/Tablet devices. See Control4 MyHome 

Setup Guide for Dealers or Control4 System Quick Start Guide for details. 
• New Detective Suite in Composer Pro. 
• Support for Internet radio stations. 
• Support for a Wireless Puck Dimmer Module or a Wireless Puck Switch Module. 

1.4.2.2 New or Updated Sections 
• The Composer Pro User Guide PDF version is now divided into two parts. Part 1 includes 

basic information; Part 2 includes programming and advanced tasks. 
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• Added Control4 Detective Suite (programming, binding, performance, etc.). Requires .NET 
Framework 4 (installed with Composer Pro for OS 2.1). Can be accessed through the Tools 
menu or as a standalone application. 

• Added the ability to change visibility and display the order of Thermostats (System Design > 
Properties > Navigator). 

• You can now hide the Thermostat as other Navigator devices through Composer menu 
settings. 

• Added a new section, “Configure Mobile Devices or PCs/Tablets as Navigators” and 
references to MyHome apps. 

• Replaced most screens with new Control4 logos. 
• Added a note in “Example: Using the Custom Buttons Agent.” 
• Added a new “Custom Buttons” section. 
• Added a new “Internet Radio” section. 
• Added a New “Configure a Wireless Puck Dimmer or Switch Module.” 
• Added information about EQ settings in “Configure a 4-Zone Amplifier” and “Configure a Multi 

Channel Amplifier.” 

1.4.2.3 Hardware and Software No Longer Supported 
• No update is provided for legacy Navigators (Mini Touch Screen, 10.5” Wireless Touch 

Screen V1, 10.5” In-Wall Touch Screen). These devices will continue to work in compatibility 
mode. 

• The Mobile Navigator has been replaced by the MyHome apps. 
• End of life: After OS 2.0.6, no update will be provided for the PoE LCD Keypad. 
• End of life: After OS 2.1, no updates will be provided for the Wireless LCD Keypad, WiFi Mini 

Touch Screen, and Sony Component Video Switcher. 

1.4.3 OS 2.0.5 
• New Control4 logos 
• Support for Intercom Agent. See the Agents section in this document for details. 
• Support for HC-200B as a Primary Controller (functionality included in software update) 
• 5” Mini Touch Screen end of life. Replaced by the 5” In-Wall Touch Screen. 

1.4.4 OS 2.0.1 
• New Media Player V2 (C4-MP2-E). 
• Updates to HC-200B (C4-HC200B-E-B-NR-1) and HC-300C (C4-HC300C-E-B). 
• Updates to HC-1000 V3 (C4-HC1000-V2-E-B). Support for rollback to Release 1.7.4 and 

1.8.2 using a USB drive. 
• Update to System Remote Control SR-250 (enhancements). 
• New 5" and 7" In-Wall Touch Screens (C4-TSWMC5-EG-xx and C4-TSWMC7-EG-xx) with 

Intercom feature. 
• Support for Android in Mobile Navigator. 
• Removed SRC V1 and V2 from documentation. 
• End of Life: 7" Wall-Mount Touch Screen (replaced by a new 7" In-Wall Touch Screen). 
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1.4.4.1 Hardware and Software No Longer Supported or Partially Supported 
• End of Life: 7" Wall-Mount Touch Screen (replaced by a new 7" In-Wall Touch Screen). 

1.4.4.2 New Media and Hardware 
• New Media Player V2 (C4-MP2-E). 
• Updates to HC-200B (C4-HC200B-E-B-NR-1) and HC-300C (C4-HC300C-E-B). 
• Updates to HC-1000 V3 (C4-HC1000-V2-E-B). Support for rollback to Release 1.7.4 and 

1.8.2 using a USB drive. 
• Update to System Remote Control SR-250 (enhancements). 
• New 5" and 7" In-Wall Touch Screens (C4-TSWMC5-EG-xx and C4-TSWMC7-EG-xx) with 

Intercom feature. 
• Support for Android in Mobile Navigator. 

1.4.4.3 New or Updated Sections 
• Configuring HVAC Systems 
• Configuring Controllers 
• Configuring AV Devices 
• Configuring Navigators 
• Configure an 5” and 7” In-Wall Touch Screen 
• Examples: Programming with Agents 
• Index 

1.4.4.4 Sections No Longer Supported 
• Configuring Navigators > Configure System Remote Control – Versions 1 and 2 
• Configuring Navigators > Program System Remote Control Programmable Buttons (Version 

2 Only) 
• Renamed section on 7” Tabletop and 7” Wall-Mount Touch Screens to “Configure a 7” 

Tabletop Touch Screen.” Removed references to 7” Wall-Mount Touch Screen. 

1.4.5 OS 2.0 
Electronic Licensing. New Dealer licensing and activation has been added. 4Sight and an Internet 
connection is required for activation. After activation, Composer can run without an Internet 
connection. There’s also a new feature to allow Dealers to assign licenses for their associates. This is 
set up during installation and registration. See TechDoc00024 Managing Dealer Accounts on 
My.Control4.Com on the Control4 Knowledgebase for details. 

• Installation. New Composer installation. 
• Flash Navigators.  

• New Flash user interface for current Controllers and Navigators (not including the Mini 
Touch Screens or 10.5" Touch Screens). 

• Easier navigation on the Navigators via Media Dashboard, views, bread crumbs, etc. 
• Ability to change backgrounds. 
• Customizable (change wallpaper; add new Custom Home pages; create Favorites; 

change buttons; create Custom Home pages; purchase applications from the 4Store; use 

https://support.control4.com/kb/login/index_enter/�
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4store applications in My Apps), easy to use (intuitive, fewer steps, consistent), and 
elegant (3-dimensional, translucent, simple). 

• Support for SSL configurations for tighter security. 
• Ability to edit DVDs via Disc Changer. 
• Whole-home views; room browse. 
• Uses a secure network connection to Director via SSL by default. Note: If you configure 

the system to accept only secure connections, the older Navigators (Legacy Navigators) 
will not work, as they use an insecure connection to Director. 

• The Flash player does not support HTML markups. Dealers who have programmed 
popups that rely on HTML formatted text will need to change their programming scripts. 

• Customization. Improved use of the Control4 system for users by providing: whole-home 
status and control functionality; and information delivery relevant to the homeowner. 

• Web Navigator. New and improved Web Navigator. Now you can view the system in Flash 
(same interface as on the Touch Screens and On-Screen Navigator). See the Control4 
System User Guide for details. 

• Mobile Navigator. New and improved Mobile Navigator that supports Apple iPod, iPod 
touch, iPhone, and iPad. See the Mobile Navigator License Activation and Setup Guide, 200-
00099 on the Dealer portal. 

• List Navigator. Support for analog sources in Zones. 
• Devices.  

• Support for new devices (Home Controller HC-1000 V3, IO Extender, and Black and 
Decker KwikSet SmartCode door locks). 

• Ability to change the System Remote Control's backlight, sleep mode, check battery 
levels, and more from the device's Properties pane in Composer Pro. 

• New accessories (7" Portable Touch Screen: battery pack and stand). 
• Disc Changer. New option in the Properties pane, "Ignore Unexpected Play, Stop, or 

Pause." This option should be checked if you are configuring a system with lighting, for 
example, when the movie starts playing, and the lights in the room dim. By nature, Disc 
Players typically use Play, Stop and Pause functions during movie viewing. 

• Wireless Networks. WPA is now supported on HC-class Controllers, 7" Touch Screens and 
the 10.5" V2 Touch Screen. 

• Platform. Support for Windows 7. 
• Localization. Support for internationalization. New Localization option in project > Properties. 

Note: Control4 is not internationalizing: 
• Composer 
• New UI 
• System Remote Control V1 and V2 (Note: SR-250 will be internationalized for OS 2.0.) 
• LCD Keypad 
• System functions (splash screens or diagnostics and logging) 

• Composer Pro.  
• New Macros agent. 
• Lighting Scenes. New Execute On and Execute Off buttons to turn Lighting Scene lighting 

on and off. Can change the order of Lighting Scenes and lights. Support for Lighting 
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Scenes in the room's Properties > Navigator view. Hide or show and change the order of 
lights and Lighting Scenes. 

• Media menu. New option 'Tag media files.' 
• Menu bar. New 'Go' menu to all views (System Design, Connections, etc.). 
• New System Design and Media view tab changes in Composer Pro. 
• Wireless Thermostat scheduling and options changes. 
• DriverWorks. Ability to add and replace drivers. 
• Lua engine. 
• Improved Media Management and performance 

o Improved performance. 
o Improved scalability. 
o Improved functionality. 
o Media Manager now runs on the Primary Home Controller's Director. 
o Formatting changes in the Media Database. 

o Third-party Media Management software now works more efficiently. 
o Composer Pro does not need to be connected when scanning files. 
o Storage locations are not available in the Navigators until the media device is 

scanned. 
o Additional audio codecs. 
o FLAC support (currently in Release 1.8). 
o AAC support (unencrypted, non-DRM). 

• ZigBee Pro now benefits the broader market. 
• Director. All Director interfaces will be preserved so that the legacy platforms continue to 

work using the older UI without a change in the system when updated to OS 2.0. New 
functionality may not be accessible, however, but older functionality still behaves the same 
way. 

• Security. Improved system security: 
• Composer Pro implements license activation. 
• Dealers can now create their own licenses for their Installers. With this license, Installers 

will not have to be connected to the Internet to use Composer, but a valid 4Sight license 
is required. See Managing Dealer Account on My.Control4.Com for details. 

• Secure device to device communications. 
• Documentation. Improved documentation: 

• Composer Pro Getting Started, Basics and some Advanced Help topics. Getting Started 
Help is available in the Composer Pro application or on the Control4 Dealer website. The 
Getting Started document links to the Composer Pro User Guide (this document) which is 
available on the Web (includes Basic and Advanced topics) or in PDF. 

• Composer HE and ME. Updated and restructured documents for Composer HE and ME 
are now available in the Composer HE and ME applications. More detailed Help and a 
PDF for Composer HE are available on the Control4 website (Composer HE User Guide). 
Composer ME is available in the application help (Composer ME User Guide) or as PDF 
on the Control4 website. 
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• Control4 System User Guide. A new Control4 System Quick Start Guide (Rev A) is 
available in PDF format on the Control4 website. More detailed online Help (Control4 
System User Guide) is available on the Control4 website or on the Dealer portal in PDF. 

• Product documents are still available on the Control4 Dealer website under Support > 
Product Information, but they will no longer be available in the box in printed form or on 
CD. 

• The consumer-facing documents (for example, Control4 System User Guide and Control4 
System Quick Start Guide) are available on the Control4 website (see the Control4 
System Quick Start Guide for details). 

• Network. The Network Status tab in Tools has been changed to Network Tools (Release 
1.8.0 and later). 

1.4.5.1 Hardware and Software No Longer Supported or Partially Supported 
• Home Theater Controller (functions as a Secondary Controller, but not as a Primary 

Controller; On-Screen Navigator continues to use the legacy interface – prior to OS 2.0). 
• Media Controller (functions as a Secondary Controller, but not as a Primary Controller; On-

Screen Navigator continues to use the legacy interface – prior to OS 2.0). 
• Home Controller HC-1000 V1 (no longer sold by Control4 but fully supported with OS 2.0). 
• Home Controller HC-500 (no longer sold by Control4 but fully supported with OS 2.0).  
• 10" Wall Mount Touch Screen (will be updated to OS 2.0, but continues to use the Navigators 

prior to OS 2.0. This is the last planned update for this device; future support will be limited to 
compatibility mode). 

• 10.5" Wireless Touch Screen V1 (will be updated to OS 2.0, but continues to use the 
Navigators prior to OS 2.0. This is the last planned update for this device; future support will 
be limited to compatibility mode). 

• Mini Touch Screen V1 and V2 (will be updated to OS 2.0, but continues to use the Navigators 
prior to OS 2.0. This is the last planned update for this device; future support will be limited to 
compatibility mode). 

• System Remote Control V1 and V2 do not support ZigBee® Pro (these remotes need to be 
replaced with SR-150 or SR-250 if used with OS 2.0).  

• Contact Relay Extender (does not support ZigBee Pro). Use an IP connection for OS 2.0.  
• Audio products (do not support ZigBee Pro). Use an IP connection for OS 2.0.  
• Easy Setup. 
• Easy Importer.  
• Pool Controller. The Flash-based Navigator UI for pool control is not completed in OS 2.0, 

although the drivers and proxies remain in place in Composer Pro. If this is important, keep at 
least one of the Legacy Navigators for this purpose. 

• USB Restore or USB Install. Because an Internet connection is required, these USB utilities 
are not supported in OS 2.0. Use the 1.7.x or 1.8.2 versions of these utilities. After a restore, 
you can update to OS 2.0 from 1.7.4 and 1.8.2 to OS 2.0. 

• Web Navigator. Rhapsody and 4Store cannot be accessed from the Web Navigator. Use the 
Touch Screens or On-Screen Navigators.  

  
For more information, see the Control4 Operating System Release Version 2.0 Release Notes. 
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1.4.5.2 New Media and Hardware 
The Control4® system Composer Pro now supports the following media and hardware: 

• A new Navigator interface has replaced the interface used in Release 1.8.x and earlier. This 
interface appears on all of the Touch Screens and On-Screen Navigators except for the Mini 
Touch Screen and 10” Touch Screens. See the Control4 System Quick Start Guide and 
Control4 System User Guide for details about how to use this interface. 

• A new IO Extender has been added to the Control4 product line. 
• A new Home Controller HC-1000 V3 has been added to the Control4 product line. 
• Support for a network-attached storage (NAS) device for auto-discovery of AAC music 

format.  
• The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc Changer 

uses Gracenote, but the Media Controller can no longer access album, title, or artist 
information from AMG. CDs, however, can be imported and will appear in the Media 
Database with a date and time stamp. 

• Other Media Manager: You can use other media managers, for example, iTunes, Windows 
Media Player, and Media Monkey to create MP3s. You can still use Composer ME and HE to 
add music files to Control4. 

1.4.5.3 New or Updated Sections 
These are the Control4® system Composer Pro User Guide (Getting Started, Basics, and Advanced 
sections) basic changes for OS 2.0. See the Control4 System Software Release Version 2.0 Release 
Notes for system details: 

• The Composer Pro and Composer Pro-related documents have been updated, sections have 
been rewritten, and the documents have been restructured for Composer Pro OS 2.0 and 
later to make it easier for you to get the information you need more quickly. Most sections are 
available in HTML and application Help in the Composer Pro application and on the Control4 
website (see “Related Documents and Resources”). 

• All sections have been restructured, re-ordered, and enhanced with: 
• A new and updated look. 
• New screen displays have been added. 
• New links have been added to the Help topics. 
• Text has been pared down or combined for ease of use and readability. 
• Back and Forward buttons have been added back in to the Help topics. 
• Glossary terms and definitions have been added 'in text' in the Help topics. A Glossary 

has been added to the PDF version also. 
• The Composer Pro User Guide for OS 2.0 has been broken up and restructured into: 

• Composer Pro Getting Started (application help and PDF). The Help files show you how 
to get set up in Composer Pro and are included in the Composer Pro software with links 
to the Composer Pro User Guide Web Help. Click the Help button in Composer Pro to 
launch the Getting Started Help. The PDF version of this document is located on the 
Dealer portal. See “Related Documents and Resources” for details. 

• Composer Pro User Guide (Web Help and PDF). The Help files and PDF version provide 
Basic and Advanced topics. The Help files are available on the Control4 website; the PDF 
is available in the Dealer portal. See “Related Documents and Resources.” 

• New sections have been added for these devices: IO Extender and Home Controller HC-
1000 V3. 
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• New sections: “Editing DVD Information” and “Programming the Control4 Thermostat 
Schedule” have been added. 

• Most references to Contact/Relay Extender, 10" Wireless Touch Screen, and Home 
Controller HC-500 have been removed. These products are either no longer sold or do not 
support the Flash-based interface. 

• General network information has been removed. You can get that information from the 
Control4 training materials and courses. 

• Third-party products may be mentioned, but specific details about how to set them up may or 
may not be included. Refer to the product documentation shipped with the product. 

• Release information for releases prior to OS 2.0 that apply to Composer Pro has been added 
to “Information About Older Releases.” 

1.4.5.4 Sections No Longer Supported 
The following Control4® system Composer Pro sections have been moved or are no longer mentioned 
in this document (as they were in previous releases): 

• Third-party product configurations. With some exceptions, configuring devices for third-party 
Thermostats, Pool Controllers and Security systems are no longer provided in the Composer 
Pro User Guide. 

• Networking Basics. These sections are now included in Control4's Networking training 
classes. 

• Products no longer supported or partially supported in OS 2.0: Contact/Relay Extender, 10" 
Wireless Touch Screen, Home Controller HC-500, Home Controller HC-1000 V1, Media 
Controller, Home Theater Controller, Easy Importer, and Easy Setup. See versions of this 
document earlier than OS 2.0 for information about these products. 

• References to older releases of Control4 products. These references have been moved into 
“Information about Older Releases.” 

2. Composer Pro Basics 
If you are a new user, start by using the application Help in Control4® Composer Pro (Composer Pro 
Getting Started). These sections assume that you are familiar with Composer Pro. This product runs 
on the Control4 Operating System (OS) Release 2.0 (OS 2.0) and later. 
  
Use the subsections in this Composer Pro User Guide "Basics" section to: 

• Learn how to install devices 
• Learn how to reboot or reset your Control4 system  
• Find out what's new in this release 
• Learn how to configure Composer properties 
• Learn how to configure the devices 
• Learn how to connect everything 
• Learn how to customize the Navigators 
• Learn how to update Composer and Director  
• Learn how to troubleshoot problems 
• Find out about specific details about older releases 
• Learn how to create a sample project using the Interviewer wizard or Composer views 

https://www.control4.com/account/login.php�
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To learn about the advanced features of Composer Pro (programming, setting up networks, device 
drivers, etc.) see “Advanced Topics.” 

2.1 Installing Devices 
Use the Control4® Dealer website at http://www.control4.com to access PDFs of all current and past 
product installation and setup guides, and then install and set up your Control4 system devices 
according to these guides. These are the same guides that are included with the hardware, for 
example, a Controller or Touch Screen. 
  
If you're installing devices that are not owned by Control4, you may need to edit an existing driver or 
create a new one. See “Creating Device Drivers.” 
 
To access the installation, setup, and user documents in PDF format: 
1. Go to http://www.control4.com/dealer/products/documentation/ 
2. Log in to the Dealer Login site using your Dealer username and password. 
3. If the list of documents doesn’t appear, click the Products link, and then select Documentation. 
4. View the list and click the link for the document you want to view or print. 

2.2 Rebooting the Control4 System 
At one time or another you may have configured the Control4® system incorrectly, or the connection 
to the network is not behaving the way it should be. In this case, you can reboot or reset the system. 
You don't have to do anything in Composer Pro for this procedure other than check that the device is 
on the network. 
 
To reboot a Controller: 
1. Disconnect the power cord from the Controller. 
2. Plug the power cord back in to the Controller. 
3. Verify that the Controller comes back on the network in Composer Pro. See “Connecting a Device 

to the Network” for details. 

2.3 Resetting the Control4 System 
Use the Control4® system Composer Pro to reset a Controller. You reset a Controller to reset it back 
to the factory defaults. 
 
To reset a Controller connected to a TV: 
1. Connect the yellow Composite video cable connectors to the Controller and TV. 
2. Connect one end to Composite on the Controller and the other end to a TV. 
3. Disconnect the power cord from the Controller. 
4. Turn on the TV and go to Video 1 or AUX. 
5. Connect the power cord back in to the Controller. 
6. Press and hold the ID button on the Controller to reset the Controller. 

http://www.control4.com/�
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7. Keep pressing the ID button for several minutes. The TV displays the Control4 information, and 
will display a message similar to “Release to reset the network configuration...” when the reset 
has completed. 

8. Release the ID button on the Controller. Wait several minutes. A message appears “loading, 
please wait...” After a few minutes, the TV screen may go blank. 

9. Continue to wait until the Control4 logo appears on the screen, at which point you can start 
Composer and connect to Director using the new IP address that appears (if you are using 
DHCP). 

10. Refresh the Navigators. 
11. Disconnect the Composite video connectors from the TV and Controller. 

2.4 Configuring Properties 
Use the Control4® Composer Pro Properties pane in System Design to change device properties. The 
Properties pane lets you make configuration changes to a project, room, or device. 

  
In the Control4 system, you have a choice of configuration options using these properties: 

• Project Properties—Lets you set project-specific configuration options. 
• Room Properties—Lets you set room-specific configuration options. 
• List View Properties—Lets you set device properties listed by location, such as room, floor, 

house, etc. 
• Device Properties—Lets you set device-specific configuration options. 

2.4.1 Procedure 
To configure properties: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Select one of the following property types: 

• Project—Select the root node in the project tree, for example the project name (such as 
Franklin Smith Home) to access the project properties and modify the: 
• Project name 
• Zip code 
• Latitude/longitude 
• Date 
• Time 
• Time zone 

For more information, see “Composer Pro Properties” in Composer Pro Getting Started. 
• Room—Select the room in the project tree, for example, Theater; the Properties tab is visible 

(default).  
Room properties let you: 

• View room-specific devices 
• View media information 
• Help you troubleshoot any incorrect room connections 

For more information, see “Room Properties” in the Composer Pro Getting Started. 
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• List View—Select a room, and then select the List View tab. This option lets you view and 
maybe modify the devices in the room. For more information, see “Device Properties” in the 
Composer Pro Getting Started. 

• Device—Select the device to modify the available user options. For more information, see 
“Device Properties” in Composer Pro Getting Started. 

2.4.2 Example of Device Properties Configurations 
Use the Control4® Composer Pro System Design view to check the properties of devices, rooms and 
projects. The properties in these examples, of course, will vary from product to product. 

2.4.2.1 Wireless Dimmer or Wireless Switch Properties 
When selecting a lighting product, for example, Wireless Dimmer or a Wireless Switch in System 
Design, the Properties and Advanced Properties are displayed. These properties let you customize 
the configuration of the Dimmer or Switch. 
 
Example Properties pane: 

 

2.4.2.1.1 Properties 
These properties are available only on the Wireless Dimmer. 
• Click Ramp Rate Up—The rate in seconds at which the light ramps from Off to On. 
• Click Ramp Rate Down—The rate in seconds at which the light ramps from On to Off. 
• Preset Level—The percentage of the load to which the Dimmer ramps when turned On.  

2.4.2.1.2 Advanced Properties 
• LED 

• Top Color On—The LED color for the top LED when the LED state is On. 
• Top Color Off—The LED color for the top LED when the LED state is Off. 
• Bottom Color On—The LED color for the bottom LED when the LED state is On. 
• Bottom Color Off—The LED color for the bottom LED when the LED state is Off. 

• Options 
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• Top LED Link—If checked, swap the On and Off state and color on the top LED. 
• Bottom LED Link—If checked, swap the On and Off state and color on the bottom LED. 
• Buttons Attached—If checked, pressing the buttons on the Dimmer or Switch directly 

controls the connected load. 
• LED Attached—If checked, the LED state is controlled by the button presses. If 

unchecked, the LED state and colors can be controlled by custom programming. 
• Hold Ramp Rate Up—The rate in seconds at which the load is increased when the top 

button is held down. 
• Hold Ramp Rate Down—The rate in seconds at which the load is decreased when the 

bottom button is held down. 
• Network—The current channel, gateway, MAC address and firmware version of the selected 

Dimmer or Switch. These boxes cannot be edited. 

2.4.2.1.3 Wireless Keypad Properties 
When selecting a Wireless 2, 3 or 6 Button Keypad in System Design, the Properties pane appears. 
This pane allows custom configuration of the Keypad. 
 
To configure a 3-Way Switch, see “Configuring Lights for 3-Way.” 
 
Keypad Properties: 

 
  

• LED—(button displayed when each button is selected in the Properties pane): 
• Keypad Managed—If checked, the LED state is controlled by pressing the buttons on the 

Keypad. 
o Push Color—Indicates the LED color when the button is pushed. 
o Release Color—Indicates the LED color when a pressed button is released. If 

unchecked, the LED state can be controlled by custom programming. 
o On Color—The button LED color when its state is On. 
o Off Color—The button LED color when its state is Off. 
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• Network—The current channel, gateway, MAC address and firmware version of the selected 
Dimmer or Switch. These boxes are not editable. To configure a 3-way Switch, see 
“Configuring Lights for 3-Way.” 

2.5 Configuring Devices 
The following sections provide steps for configuring Control4® devices. Configuration can mean 
anything from identifying the device to the network to configuring an option in the device.  

2.5.1 Guidelines for Configuring Devices 
Using the Interviewer method or Composer Pro, you can add a Control4-supported device driver or a 
third-party driver to an existing project any time. See "Using the Interviewer Wizard to Build a Project" 
or "Using Composer Views to Build a Project" in the Composer Pro Getting Started. 

  
Note: Some devices also require a free app from the Control4 4Store; for example, to take full 
advantage of Black & Decker KwikSet SmartCode lock management in a Touch Screen, MyHome 
app, or On-Screen Navigator, you can download their free app. See the 4Store sections in the 
Control4 System User Guide for details. 
  
For general guidelines about adding devices using the My Drivers tab, the Search tab, or the Online 
Database, see the following sections. 

2.5.2 Configuring Third-Party Devices 
Use the Control4® Composer Pro System Design and Connections views to configure third-party 
devices using third-party device drivers. 
  
Samples of third-party drivers and products have been described in previous releases of the 
Composer Pro User Guide. Due to the difficulty of upkeep, however, Control4 is no longer 
documenting detailed information about these devices and drivers, although they are still supported in 
a Control4 system. Go to the products’ websites for details. 
  
Refer to previous versions of the documentation (Release 1.8 and earlier) for some third-party 
instructions; for example, Thermostats, Pool Controllers and security systems. The same basic steps 
apply to third-party drivers as with Control4 devices. 
 
To configure a third-party device: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Locate and add the device to the project tree as described in “Using My Drivers or Search Tabs” 

or “Using the Online Database to Search for Drivers.” 
4. Identify the device to the Control4 system. 

2.5.3 Using My Drivers or Search Tabs 
Use the Control4® Composer Pro System Design view, My Drivers or Search tabs to locate and add 
device drivers to the project tree. 
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Prerequisites 
1. Read “Purpose of Device Drivers” and “Adding Items to the Project Tree” in Composer Pro 

Getting Started first to understand how to create a project tree for your project. 
2. Install and connect the physical devices that need to be added to the Composer Pro project. 
 
To add devices: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Click the object in the project tree where you want the device to reside; for example, you want to 

add a Controller to the Theater. 
4. In the Items pane, click either the My Drivers or Search tab. 
5. Double-click or drag the device to the System Design pane's project tree. 

Tip: To ensure that you’ve got the correct device driver (SKU) in your project tree, after you’ve 
added it to the tree, hover over it. The SKU appears. 

6. Make the necessary control, network or AV connections. See “Connecting a Device to the 
Network,” or “Connecting and Managing Control and AV Devices” in this document or 
“Connecting Devices” and “Testing the Device Connections” in the Composer Pro Getting Started 
for information. 

7. Set any necessary device properties by selecting the device (see “Properties Pane” in Composer 
Pro Getting Started). If any properties are available for a device, they will display in the Properties 
pane. 

8. If you are adding WiFi devices, refer to the Control4 training courses on the Control4 Dealer 
website to learn how to install and configure WiFi. 

2.5.4 Using the Online Database to Search for Drivers 
Use the Control4® Composer Pro System Design view > Online Database tab to add devices to the 
project tree. Thousands of third-party device drivers are supported in the Control4 Device Driver 
Database. Drivers that are not in the Local Database can be found here if they exist. 
  
Notes: Due to the large quantity of drivers in the database, Control4 has not validated every device 
driver provided. If you experience limited functionality using any device driver provided by Control4, 
please report the limitations to Control4 Technical Support. To report defects or enhancements, 
please contact Control4 (phone: 1-888-400-4072 or email: support@control4.com). 
 
On the other hand, some device drivers have been certified. Look for the certification icon to the right 
of the driver in the list. Certified drivers appear at the top of the list if you search under manufacturer 
> all certified. 
 
Prerequisites 
1. Read through “Purpose of Device Drivers” and “Adding Items to the Project Tree” in Composer 

Pro Getting Started to understand how to create a project tree for your project. 
2. Install the devices that need to be added to the project. 
 
To search for device drivers in the Online Database: 
1. Start Composer and connect to a Director. 

https://www.control4.com/account/login.php�
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2. Click System Design. 
3. In System Design in the Items pane, click the Search tab. 
4. Select the Online Database radio button. 
5. To get a device, use the pull-down menus and select Device Type, then Manufacturer or All 

Manufacturers. 
6. Select the room in the project tree, and double-click or drag the device to the project tree. 
7. Configure the device by setting up the connections (Network and/or Control/AV tabs). See 

“Connecting and Managing Control and AV Connections” and “Connecting and Verifying Devices” 
for details. 

2.5.5 Configuring Controllers 
Use the Control4® Composer Pro System Design view to add and identify a Controller to the network 
connection. Refer to the sections below for the Controller type you want to configure. This section also 
covers other Controller-related tasks. 
  
Note: Home Theater Controller, Home Controller HC-500, and Media Controller are no longer sold. 
See “What’s New in This Release” for details. 

2.5.5.1 Configure an HC-Class Home Controller  
Use the Control4® Composer Pro System Design view to add and configure the 'HC' line of Home 
Controllers. These steps are basically the same for every supported Controller, however, the 
Properties may vary. 
 
Note: Emphasis is placed on the most recent Controllers. 
 
Prerequisites 
Ensure that the Home Controller is installed as directed in the Control4 Home Controller Installation 
Guide for your Controller available on the Control4 Dealer website. 
 
To add and configure a Home Controller HC-x00 or HC-x000 (for example, HC-300): 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the System Design view on the project tree, select the room where the Home Controller 

resides. In the Items pane > My Drivers tab > Controllers > double-click Home Controller 
(including the HC version you want to add, for example, Home Controller HC300) to add the 
object to the project tree. The Digital Media object is added automatically also. 

  
Notes: Home Controller HC-1000 V2 and HC-1000 V3 use the same driver, e.g., HC1000V2/V3. 
Release 1.7.3 and later use these driver versions. For OS 2.0.1, the HC-200 (C4-HC200B-E-B-NR-1) 
and HC-300 (C4-HC300C-E-B) have been updated. For OS 2.2, the HC-800 (C4-HC800-E-B) has 
been added. 
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Note: If a Controller is not listed in My Drivers, right-click in My Drivers and select Restore Default 
List. This action updates the list. See “Using My Drivers or Search Tabs.” 

  
4. In the Connections view, use the Network tab to make the necessary network connections. To do 

this, select the Home Controller object, and click the Identify button. 
5. In Identify mode, go to the physical Home Controller, and press the specified button (listed below) 

on the device to identify the Controller to the Control4 system. 
• HC-200 only: Press the LINKS button on the Front of the device. 
• HC-300 and HC-800 only: Press the ID button on the Back of the device. 
• HC-1000 only: Press the ID button on the Front of the device.  

  
Note: The HC-1000 V3 has a Reset button on the front of the unit also, which differs from HC-
1000 V1 and V2. 
  
Example Home Controller (HC200) identification screen in the Theater: 
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6. Click Close to exit the wizard. 
7. To establish a WiFi network connection to this Controller, configure a USB WiFi Adapter for Home 

Controllers (sold separately). To do so, see “Configuring a WiFi Connection” or “Configure a USB 
WiFi Adapter for HC-300.” Check with your Control4 Sales representative for details. 

8. (Optional) For additional Home Controller setup, configure the Properties.  
a. In the System Design view project tree, select the Home Controller object.  
b. Modify the properties in the Properties pane: 
• Controller Status—Shows whether the Controller is Online or Offline. 
• ZigBee Server Configuration—Lets you view, enable and disable the Zserver. Edit ZigBee 

Configuration opens the ZigBee Network Settings dialog.  
Note: The ZigBee Network Settings box shows which ZAPs are configured, identified, or 
enabled. See also Tools > Network Tools and select the ZigBee Network tab. 

• ZigBee Server Status—Shows whether the Controller as ZigBee Server is Running or 
Not Running. Older Controllers show Not Supported. 

• ZAP Configuration Type—Shows whether the Controller is the Coordinator or ZAP. 
Older Controllers show Not Supported. 

• ZAP Status—Shows whether the Controller as ZAP is Running or Not Running. Older 
Controllers show Not Supported. 

• SD Video Mode (HC-200 and HC-300 only)—Lets you set the Standard Definition video 
format that the Controller handles. NTSC mode is used in the U.S. Canada, Central America, 
and Japan; PAL mode is generally used in Europe, Africa, Australia, South America, and 
China. (Release 1.8 and earlier: This option is called Video Mode.) 

• For Video Connection (HC-800 only)—Choose component or HDMI, change the Video 
Resolution, and then click Set Resolution. This will cause the Controller to set the 
configuration and restart. Select HDMI only for video, as it won't stream audio. Note: This 
does not reflect what is set in the Connections view for video output. 

• Video Resolution (HC-800 only)—If your video doesn’t display properly, use the drop-down 
to select your correct video resolution. 

• Current Resolution (HC-800 only)—Displays what hardware resolution is currently 
configured. 

• I/O Firmware Version (HC-800 only)—Lists the current firmware version of this Controller. 

2.5.5.2 Configure a USB WiFi Adapter for Home Controller HC-300 
Use the Control4® Composer Pro Tools menu and Connections > Network tab to configure a USB 
WiFi adapter (sold separately). 
  
USB WiFi Adapter for Home Controller HC-300 lets the Home Controller HC-300 communicate with 
system devices via a WiFi (wireless) network. These steps can apply to the HC-500 also. 
 
Notes: The USB WiFi Adapter should be used for Secondary Controllers. Control4 recommends that 
the USB WiFi Adapter not be used in a Primary Controller for a large system or a Controller that is 
streaming digital audio to other end points on the network. Those usage scenarios will be better 
served by an Ethernet connection to the Primary Controller.  
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To connect and set up the USB WiFi Adapter for a Home Controller HC-300: 
1. Connect the Home Controller HC-300 to the Ethernet network using an Ethernet CAT5 cable (this 

is a temporary connection to support set-up activities). 
2. Plug the adapter to the USB port on the Controller. 
3. Start Composer and connect to Director on Local Network. 

a. In the Tools menu, select System Manager. 
b. In the Devices pane, select the network address of the device where you want to set up the 

network configuration, and click Connect.  
• If the device’s network address is not on this list, click Refresh.  
• If it still does not appear, click Add to enter it manually.  
• If you do not know the network address, find it at the Connections view > Network tab. 

c. Click the Network tab, and click Configure.  
4. Click Next when a Network Configuration wizard dialog appears.  

a. Continue through the wizard screens, and provide the following information appropriate for 
your system. Much of this information has to match that of your Wireless Access Point (WAP). 

b. Enter the new device name, but do not include spaces in the new name.  
c. Indicate the network type: Wireless (WiFi) network. 
d. Indicate the method for obtaining the DNS server address: DHCP or Static IP. Control4 

recommends DHCP (automatically selected). 
e. Enter the SSID. 
f. Enter the WEP key (if any). 
g. Enter the encryption type (64 or 128). 
h. Click on a Key type (hex or ascii). 
i. Click Finish to complete the wizard and reboot the adapter to apply the network configuration 

changes. 
5. Disconnect the Ethernet CAT5 cable from the Controller. 

2.5.5.3 Ensure that ZigBee Server Is Running  
Use the Control4® Composer Pro System Design view to check the Controller's properties and ensure 
that ZigBee server is running on a Controller. 
  
Note: This does not apply to Home Controller HC-1000. 
 
To ensure the Controller properties are set correctly: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the Controller object for the properties to appear. 
4. Ensure that the ZigBee server is running. If not, see “Example: Verify the Network Connections” in 

this document. 
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2.5.5.4 Ensure That Video Mode Is Set Correctly 
Use the Control4® Composer Pro System Design view to check the Controller's properties and ensure 
that video mode is set correctly on a Controller. Video Mode lets you set the video format that the 
Home Controller handles. 
 
To ensure the Controller properties are set correctly: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the Controller object for the properties to appear. 
4. Ensure that the video format is set correctly. NTSC mode is used in the U.S. and PAL mode is 

generally used in Europe. 
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2.5.5.5 Configure Multiple Controllers 
Use the Control4® Composer Pro System Design view and Connections > Network tab to configure 
multiple Controller. If you have more than one (1) Controller in your Control4 system, you must 
designate one of them as the Primary Controller. The others will be Secondary Controllers. 
 
To add and configure multiple Controllers: 
1. Start Composer and connect to a Director on Local Network. 
2. From the Directors dialog that appears, choose the Director’s network address of the Primary 

Controller hardware you are setting up, and click Connect. 
3. If you have multiple Controllers in the system, then when you make this selection, you are 

defining the Primary Controller to the system. The next time you launch Composer Pro, only the 
network address of the Director of the Primary Controller appears on this screen. If the correct 
address is not listed, click Add to add the address manually. 

  

 
  

4. Click System Design. 
5. In the System Design view, add the room where Controller resides. 
6. While selecting a room, click the My Drivers tab under the Controller, and double-click Controller 

to add it to the system. Do the same for all the Controllers you plan to add to the system. 
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7. Click the Connections view. 
8. In the Connections view, select the Network tab. 
9. Select the first Controller listed, and click Identify. 
10. On the dialog that appears, follow the on-screen instructions, and click Next to continue to identify 

the other Controllers you have added to the system. 
11. When you finish identifying all of the Controllers and any other devices in your project, click Close 

to return to the Network tab in the Connections view. 
12. In the IP Network Connections pane under Address make sure that all the devices in your project 

have an address on the list. 
  

 
 

2.5.5.6 Configure an IO Extender 
Use the Control4® Composer Pro System Design view to add and configure the IO Extender.  
  
The Control4 IO Extender opens up a whole world of options in the Control4 system to control home 
theaters, distributed audio systems, video devices, motion sensors, and other devices that use 
infrared (IR), serial, contact, and relay connections and has digital and analog audio outputs. This 
device serves as a great companion to the Home Controller HC-1000 to expand output capability. 
 
Prerequisites 
Ensure that the IO Extender is installed and set up as directed in the Control4 IO Extender Installation 
Guide available on the Control4 Dealer website. 
 
To add and configure an IO Extender: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
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3. In the System Design view on the project tree, select the room where the IO Extender is installed. 
In the Items pane > My Drivers tab > Controllers, double-click IO Extender to add the object to 
the project tree.  

4. In the Connections view, use the Network tab to make the necessary network connection. To do 
this, select the IO Extender object, and click the Identify button. 

5. In Identify mode, go to the physical IO Extender, and press the same button highlighted in the 
Composer Pro illustration of the physical device to identify it to the Control4 system. 

  

 
  

6. Click Close to exit the wizard. 
7. (Optional) For additional IO Extender setup, you can adjust the volume for three (3) outputs.  

a. In the System Design view project tree, double-click the IO Extender object.  
b. Use the slider bar to adjust the Stereo Volume x as needed. 

2.5.6 Configuring AV Devices 
Configuring audio-video (AV) devices means that you want to 'identify' or make the device connection 
to the Control4® system so the devices communicate with the Controller and other devices in the 
system. Use the Control4 Composer Pro System Design and Connections views to configure audio-
video devices. 
  
These sections provide information about the specific AV devices. 
 
“Configure an Audio Matrix Switch” 
“Configure an Audio or AV Switch” 
“Configure a Dock for iPod” 
“Configure a 4-Zone Amplifier” 
“Configure a Multi Channel Amplifier” 
“Configure a Multi Tuner” 
“Configure a Speaker Point” 
“Configure a Media Player” 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  30 of  199 

 

 

2.5.6.1 Configure an Audio Matrix Switch 
Use the Control4® Composer Pro System Design and Connections views to identify an Audio Matrix 
Switch to the Control4 system. This device switches up to 16 input sources and up to 16 simultaneous 
zones. 
 
Prerequisites 
Ensure that the Home Controller is installed as directed in the Control4 Audio Matrix Switch 
Installation Guide on the Control4 Dealer website. 
 
To add and configure an Audio Matrix Switch: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the Composer Pro, System Design view on the project tree, select the room where the Audio 

Matrix Switch - 16 resides. 
4. In the Items pane > My Drivers tab > Audio/Video > Audio Switch double-click Audio Matrix 

Switch - 16 to add the object to the project tree. 
5. In the Connections view, click the Network tab to make the necessary network connection. To do 

this, select the Audio Switch object, and click the Identify button. 
  

IMPORTANT: The Audio Switch can be identified by IP or ZigBee. The Audio Switch can 
communicate with the Control4 system either using the TCP/IP network or via the ZigBee 
network. Identify it to the network you want to use for communications. Do not identify it on both 
the IP and the ZigBee networks. 

  

 
  

Note: If using a TCP/IP network and the latest shipping version of this device, you can set this 
device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see 
the LCD screen menu on the device. 

  
6. In Identify mode, go to the physical Audio Matrix Switch - 16, and press the Top button to identify 

it to the Control4 system. 
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7. Click Close to exit the wizard. 

2.5.6.2 Configure an Audio or AV Switch 
Use the Control4® Composer Pro System Design and Connections view to set up an audio or 
audio/video switch. 
  
You can access the AV switch drivers from the System Design view in the Items pane by clicking the 
Search tab > Device Type: A/V Switch or Audio Switch > Manufacturer: All Manufacturers. Use 
the Driver Wizard for additional support for your audio or AV switch. 
 
Prerequisites 
Install the Audio or AV Switch according to the manufacturer’s instructions. 
 
To add and configure an Audio or Audio/Video Switch: 
1. Install and set up the audio or audio/video switch and any associated hardware. 
2. Add the audio or audio/video switch to your project from the System Design view. To locate the 

driver, click the Search tab > Device Type: Audio Switch or A/V Switch > Manufacturer: All 
manufacturers. 

  
Example: To add the applicable Knox AV switch (RS-232) driver, in the System Design view, 
click the Search tab > Device Type: A/V Switch > Manufacturer: All manufacturers. 

  
3. Select the Audio Video or AV Switch object in the project tree to view the device properties for 

that object and make configuration changes if applicable. 
  

Example: The Knox AV Switch has no properties to modify, but other switches have properties, 
such as the Control4 Audio Switch. 

  
4. Make any necessary network or control/AV connections as necessary for your configuration. See 

“Connecting and Managing Control and AV Connections” for details. 
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5. Modify any room connections as needed for your configuration. 
 

2.5.6.3 Configure a Dock for iPod 
Use the Control4® Composer Pro System Design view to configure the Dock for iPod. The Dock for 
iPod is a dock in which your iPod sits. With your iPod connected to the dock and the Control4 system, 
you can enjoy music throughout the home. 
 
Prerequisites 
Configure the Dock for iPod as directed in the Control4 Dock for iPod Tabletop Kit Setup Guide 
available on the Control4 Dealer website. 
 
To add and configure Dock for iPod: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the System Design view select the room where the Dock for iPod resides. 
4. On the My Drivers tab or Search tab, double-click iPod to add it to the project. 
5. Identify the Dock for iPod. In the Connections view: 

a. Click the Network tab, select iPod in the list, and then click Identify in the IP Network 
Connections tab. 

b. Enter the IP address assigned to your Dock for iPod in the DriverWorks box that appears. 
  

 
  

6. Connect the Dock for iPod. 
a. Click the Control/ AV tab. 
b. Select iPod in the project tree. 
c. Define the correct video and audio connections. 

7. Check the properties. In the System Design view, select iPod. 
8. In the Properties pane, click the Properties tab. View and change the properties as needed: 

• Cover Art: Select the delay or Off. 
• Now Playing Timer: Select when to play. 
• Room Off: Select whether to stop the iPod from playing or pause it when Room Off is 

pressed on the System Remote Control. 
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• Debug Mode: Use the drop-down list to select an option to log or print in this mode. Select 
from Print, Log, or Print and Log. This option is tied to the output options in the Lua tab (Step 
9). 

• Firmware Version: Shows the version number for the firmware. 
9. (Optional) See the Documentation tab for more information. 
10. Click the Lua tab to view logging output. 

2.5.6.4 Configure a 4-Zone Amplifier 
Use the Control4® Composer Pro System Design and Connections views to add and configure a 4-
Zone Amplifier. This device lets you enjoy up to four (4) zones (rooms) of music in the home. 
 
Prerequisites 
Ensure that the 4-Zone Amplifier is installed as directed in the Control4 4-Zone Amplifier Installation 
Guide available on the Control4 Dealer website. 
 
To add and configure a 4-Zone Amplifier: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the Composer Pro, System Design view, select the room where the 4-Zone Amplifier resides. 
4. In the My Drivers tab under Audio/Video > Amplifier, double-click Multi Channel Amplifier 4 

Zone to add the object to the project tree. 
5. Click Connections. 
6. In the Connections view, use the Network tab to make the necessary network connection. To do 

this, select the Amplifier object, and then click the Identify button. 
  

IMPORTANT: The Amplifier can be identified by IP only. The Amplifier can communicate with the 
Control4 system using the TCP/IP network. 

  
Note: If you are using a TCP/IP network and the latest shipping version of this device, you can 
set this device to either DHCP Client (default) or a client that uses Static IP. To change this 
setting, see the LCD screen menu on the device. 

  
7. In Identify mode, go to the physical 4-Zone Amplifier, and press the Select dial to identify the 4-

Zone Amplifier to the Control4 system. Click Close. 
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8.  (Optional) Configure additional 4-Zone Amplifier properties. 
a. In the System Design view on the project tree, select the Amplifier object. 
b. Modify the properties in the Properties pane: 

  

 
  

Modifiable properties include: 
• Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have one (1) Audio 

Input with several Audio Outputs, but an Audio Output may only have one Audio Input. 
• Power Save Enabled—Check to save power. 
• Device Firmware—This displays the firmware version. 
• Power Save Status—This displays that power save is enabled. 
• Volume Curve— 
• Output Settings: 
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Output Zones—Select zones 1 through 8. 

Maximum Volume—Use the drop-down menu to select the volume up to 100. Click Set. 
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Advanced properties: 
 

 
 
• Parametric EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 
• Quality Factor (Q)—Width of the EQ boost/cut settable from 0.5 to 1.0 in 0.1 steps and 

1.0 to 10.0 in 1 step (there are no units for Q). 
• Shelving EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 

 
Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth of the boosted 
frequency (or cut frequency). 
 
The Quality Factor is the center frequency divided by the bandwidth (Q=Center 
Frequency/Bandwidth), where bandwidth is determined by the frequency points are either side of 
the center frequency are -3dB from the center frequency. A setting of 1kHz with a Q of 1 means 
that the boosted frequencies affected are from 500Hz to 1.5kHz (1kHz wide to the -3dB points 
centered at 1kHz). 
 
Example: If the Q is increased to 10 with the same 1kHz center frequency, then the bandwidth 
must decrease by the same ratio. Mathematically: 
 

Q = Freq/BW  

10 = 1kHz/BW 

BW = 100Hz 

Affected frequencies are Center Frequency +/- ½ (BW) 
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1kHz +/- ½ (100Hz) 

1kHz +/- 50Hz = 950Hz to 1,050Hz 

 
The higher the Q setting the narrower the frequency range affected by the gain setting, while a 
lower Q setting increases the frequency range affected by the gain setting at each EQ frequency.  

 
The frequency response can be visualized as a tall, skinny building with a high Q value or a tall, 
wide (or pyramid shaped) building with a low Q value. The peak (or height of the building) at the 
center frequency is set by the Gain setting. 

2.5.6.5 Configure a Multi-Channel Amplifier 
Use the Control4® Composer Pro System Design and Connections views to add and configure a Multi 
Channel Amplifier. This device provides eight (8) stereo inputs and outputs with full audio switching. 
  
Note: In Release 1.8 and later, the Multi-Channel Amplifier does not work with ZigBee Pro. Configure 
this device with Ethernet. 
 
Prerequisites 
Ensure that the Multi Channel Amplifier is installed as directed in the Control4 Multi Channel Amplifier 
Installation Guide available on the Control4 Dealer website. 
 
To add and configure a Multi Channel Amplifier: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the Composer Pro, System Design view on the project tree, select the room where the Multi 

Channel Amplifier resides. 
4. In the Items pane > My Drivers tab > Audio/Video > Amplifier > double-click Multi Channel 

Amplifier - 16 to add the object to the project tree. 
5. In the Connections view, click the Network tab to make the necessary network connection. To do 

this, select the Amplifier object, and then click the Identify button. 
  

IMPORTANT: Two (2) amplifier objects appear for identification. The amplifier can be identified 
either by IP or by ZigBee. The amplifier can communicate with the Control4 system either using 
the TCP/IP network or via the ZigBee network. Identify it on the network you want to use for 
communications. Do not identify it on both the IP and the ZigBee networks. 
  
Note: If using a TCP/IP network and the latest shipping version of this device, you can set this 
device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see 
the LCD screen menu on the device. 

  
6. In Identify mode, go to the physical Multi Channel Amplifier, and press the Select dial to identify 

the Multi Channel Amplifier to the Control4 system. After the device is identified, click Close. 
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7. (Optional) Configure additional Multi Channel Amplifier properties. 
a. In the System Design view on the project tree, select the Amplifier object. 
b. Modify the properties in the Properties pane: 

  

 
  

Modifiable properties include: 
• Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have one Audio Input 

with several Audio Outputs, but an Audio Output may only have one Audio Input. 
• Device Firmware—This displays the version of firmware. 
• ZigBee Firmware—This displays the version of firmware. 
• Volume Curve— 
• Output Settings: 

Output Zones—Select zones 1 through 8. 
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Maximum Volume—Use the drop-down menu to select the volume up to 100. Click Set. 

• Parametric EQ Settings: 
Frequency— Center frequency to be adjusted. 

Gain— Set from -24dB (cut) to +6dB (boost) for the center frequency. 

 
Advanced Properties: 
 

 
 
• Parametric EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 
• Quality Factor (Q)—Width of the EQ boost/cut settable from 0.5 to 1.0 in 0.1 steps and 

1.0 to 10.0 in 1 step (there are no units for Q). 
• Shelving EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 

 
Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth of the boosted 
frequency (or cut frequency). 
 
The Quality Factor is the center frequency divided by the bandwidth (Q=Center 
Frequency/Bandwidth), where bandwidth is determined by the frequency points are either side of 
the center frequency are -3dB from the center frequency. A setting of 1kHz with a Q of 1 means 
that the boosted frequencies affected are from 500Hz to 1.5kHz (1kHz wide to the -3dB points 
centered at 1kHz). 
 
Example: If the Q is increased to 10 with the same 1kHz center frequency, then the bandwidth 
must decrease by the same ratio. Mathematically: 
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Q = Freq/BW  

10 = 1kHz/BW 

BW = 100Hz 

Affected frequencies are Center Frequency +/- ½ (BW) 

1kHz +/- ½ (100Hz) 

1kHz +/- 50Hz = 950Hz to 1,050Hz 

 
The higher the Q setting the narrower the frequency range affected by the gain setting, while a 
lower Q setting increases the frequency range affected by the gain setting at each EQ frequency.  

 
The frequency response can be visualized as a tall, skinny building with a high Q value or a tall, 
wide (or pyramid shaped) building with a low Q value. The peak (or height of the building) at the 
center frequency is set by the Gain setting. 

2.5.6.6 Configure a Multi Tuner – Versions 1 and 2 
Use the Control4® Composer Pro System Design view to add and configure a Multi Tuner for Versions 
1 and 2. This device provides up to three (3) audio signals and an optional satellite radio signal for 
multi-zone versatility. 
  
Notes: (1.) Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide available on the 
Control4 Dealer website for instructions about how to add and configure the XM Module that is 
compatible with Multi Tuner V2. (2.) If you are installing C4-TUN2-E-B or C4-TUN2-E-B_with_C4-
XMOD, refer to Version 2 notes. (3.) In Release 1.8 and later, the Multi-Tuner, Version 1 does not 
work with ZigBee Pro. 

2.5.6.6.1 Installation Scenarios 
There are several possible installation scenarios for the Multi Tuner products exist, depending on the 
version. 

  
Version 1: 

• Model AVM-TUN1-B (AM/FM tuner): Use the Multi Tuner in the My Drivers tab. 
• Model AVM-TUN1X-B (AM/FM/XM tuner): Use the Multi Tuner w/XM in the My Drivers tab. 
• XM module being added to an existing AVM-TUN1-B: Remove the original Multi-Tuner driver 

(AVM-TUN1-B) and replace it with Multi Tuner w/XM (AVM-TUN1X-B), then re-create the 
connections. 

  
Version 2: 

• Model C4-TUN2-E-B: Adding a C4-Multi Tuner V2 (with AM/FM tuners). 
• Model C4-TUN2-E-B_with_C4-XMOD: Adding a Multi Tuner V2 (with AM/FM tuners) that also 

has the XM module installed. 
• To add an XM Module to a tuner already installed, you must (1) delete the original tuners in 

the project tree, Tuner and Tuner 2 (which were added for C4-TUN2-E-B), (2) replace them 
with C4-TUN2-E-B_with_C4-XMOD (which adds Tuner, Tuner 2, and TunerXM to the tree), 
and (3) re-create the connections. 
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See the following sections as applicable to configure the tuner: 
“Activate the XM Satellite Radio Service” 
“Configure the Multi Tuner” 
“Set Up Radio Stations” 
 
Prerequisites 
Ensure that the Multi Tuner, Version 1 or 2, is installed as directed in the Control4 Multi Tuner 
Installation Guide. 

2.5.6.6.1.1 Activate the XM® Satellite Radio Service 
Notes: 

• Version 1: Model # AVM-TUN1X-B or tuners upgraded with the XM Module Kit require a 
monthly subscription to the XM Satellite Radio service to receive XM radio channels. 

• Version 2: Model # C4-TUN2-E-B_with_C4-XMOD or tuners upgraded with the XM Module 
Kit require a monthly subscription to the XM Satellite Radio service to receive XM radio 
channels. 

  
To subscribe and activate these services: 
1. Use the Select dial to tune the XM tuner to channel 0 and record the XM Radio ID (SDARS ID) 

that displays in the LCD window. 
2. Contact XM Satellite Radio Inc., to subscribe to the XM radio service. Go to 

http://www.xmradio.com or call XM’s Listener Care at 1-800-XMRADIO (800-967-2346), which 
requires your SDARS ID. 

3. When instructed to do so by XM Satellite Radio Inc., tune the XM tuner to Channel 1 for about 20 
minutes. When the tuner begins receiving XM stations, the LCD screen is enriched with station-
specific information. 

4. If the XM tuner is not receiving XM stations after 20 minutes: 
a. Move your antenna to a new location. 
b. Go to http://www.xmradio.com/refresh/. 
c. Tune to Channel 1 again, and wait approximately 20 minutes for the LCD screen to refresh. 

 

2.5.6.6.1.2 Configure the Multi Tuner 
Notes: (1.) If you are installing C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD, refer to the Version 2 
notes. (2.) If you are installing models AVM-TUN1-B or AVM-TUN1X-B, refer to Version 1 notes. 

  
To add and configure the Multi Tuner V1 to an existing system: 
1. Start Composer and connect to a Local or Remote Director. 
2. Click System Design. 
3. In the System Design view, select the room in the tree where the Multi Tuner will reside. 
4. In the My Drivers tab, go to Audio/Video > Tuner and double-click Tuner. 
5. In the list displayed, double-click the applicable Control4 Multi Tuner model: 

• Version 1: Multi Tuner for the AVM-TUN1-B model. 

http://www.xmradio.com/�
http://www.xmradio.com/refresh/�
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• Version 1: Multi Tuner w/XM for the AVM-TUN1X-B model or if adding the XM Module to the 
AVM-TUN1-B model. 

• Version 2: C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD if the XM Module upgrade kit 
[sold separately] is being used with an C4-TUN2-E-B model. 

6. Set the AV and Network connections: 
a. In the Connections view, click the Control/AV tab. 
b. For each tuner object in the project tree —such as Tuner, Tuner 2, and Tuner XM (XM 

Models only)—select each one, and ensure it is connected to a radio. 
c. For each tuner object in the project tree, select each Audio Video Output, and then drag 

them one-by-one onto an item in the Input Devices list below. The association displays in both 
lists. 

d. Click the Network tab, right-click on the tuner with the appropriate address type: IP or 
ZigBee, and then choose Identify. 

 
IMPORTANT: (Version 1 only) Two (2) Tuner objects appear for identification. The Tuner can be 
identified either by IP or by ZigBee. The Multi-Tuner, V1 can communicate with the Control4 
system either using the TCP/IP network or via the ZigBee network. Identify it on the network you 
want to use for communications. Do not identify it on both the IP and the ZigBee networks. 

  
7. Press the Select dial on the Multi Tuner front panel to identify this device to the system. After a 

brief delay, the network address for this Multi Tuner is added to the Device list. 
  

 
  

8. Verify that Multi Tuner is an accessible device. In the System Design view, select the room, and 
then click the Properties tab and Audio Video Devices tab to view the Available Audio Sources 
list for that room. 

9. Go to the next section. 
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2.5.6.6.1.3 Set Up Radio Stations 
To provide users easy access to radio stations throughout the system and to enrich the graphical 
interfaces, use Composer Pro to search for radio broadcasts and refresh your Navigators. 
1. Start Composer and connect to Director on Local Network. 
2. Click Media. 
3. Select a radio in the Media list (on the left): XM Radio, FM Radio, or AM Radio, and then click 

Search. 
4. When the dialog box appears, enter your zip code in the box, and then click Search. The 

available stations display in the Search Results list. 
5. In the Search Results list, select the stations to add to the Navigators (On-Screen Navigator, 

Touch Screen, MyHome, and System Remote Control). Select them individually or click Select 
All. 

6. Click OK. The selected stations populate the XM, FM, or AM Radio pane. 
7. Repeat Steps 3 through 6 for the remaining radios. 
8. Refresh the Navigators (see Composer Pro Getting Started for details). Each radio station you 

select is now available in the Navigators. 
  

For XM Tuner models: 
1. Click System Design, and select Tuner XM in the project tree. 
2. In the Properties tab, ensure that the tuner has a good signal and that the SDARS ID matches the 

Radio ID listed on Channel 0 of the tuner. 

2.5.6.6.1.4 Configure an XM Module for Multi Tuner V2 
Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide on the Control4 Dealer website 
for instructions about how to add and configure this module. 

2.5.6.7 Configure Speaker Point – Ethernet or Wireless 
Use the Control4® Composer Pro System Design and Connections views to add and configure 
Speaker Point. This device provides output to multiple speakers while connected to a Control4 
system. 
 
Prerequisites 
1. Ensure that the Speaker Point device is installed as directed in the Control4 Speaker Point 

Installation Guide available on the Control4 Dealer website. 
2. Connect the Speaker Point device to an Ethernet CAT5 cable to set up the Ethernet or wireless 

connection. 
  

IMPORTANT TIP: The Speaker Point device requires an Ethernet connection for initial setup. 
 
The following procedures teach you to configure: 

• Speaker Point for Ethernet use, or 
• Speaker Point for WiFi use. 

https://www.control4.com/account/login.php�
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2.5.6.7.1.1 Configure Speaker Point for Ethernet Use 
To add and configure an Ethernet Speaker Point to a Control4 project: 
Note: By default, Speaker Point is configured for Ethernet use. If you are using WiFi, however, also 
follow the instructions in the section, "Configure Speaker Point for WiFi Use" later in this section. 

  
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In System Design on the project tree, select the room where the Speaker Point resides. 
4. In the My Drivers tab, go to Audio/Video > Speaker Point, and then double-click to add the 

Speaker Point object to the project tree. 
5. In the Connections view, use the Network tab to make the necessary network connection. To do 

this, select the Speaker Point object, and click Identify. 
6. In Identify mode, go to the physical Speaker Point, and press the front panel button to identify 

the Speaker Point to the Control4 system. Click Close. 
  

 
  

7. Ensure that the room connections are set correctly for the room. 
  

Note: When you add a Speaker Point, Audio or AV switch to a room, by default the Audio End 
Point is assigned by the first device added to the room. When you add a Receiver to a room, it is 
automatically set or reset as the Audio End Point. 

  
a. To get to Room Connections, go to Connections and select the room. 
b. Verify that the Audio End Point setting matches the intended setup of your Control4 system. 

The Room Connections appear in the center pane. If you are setting up a custom 
configuration, adjust the Room Connections accordingly. For more information about Room 
Connections, see ”Connecting Rooms.” 

  
8. Preset Treble, Bass, and Balance. In either the System Design or Connections view, double-click 

the Speaker Point object in the project tree to bring up its on-screen controls, and then click to 
make the adjustments for Treble, Bass, and Balance (supported values are 0 - 100). 
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9. (Optional) Configure the Speaker Point properties. 
  

Modifiable properties include: 
• Local Amp Mode not checked (default). When the box is not checked, the Speaker Point 

streams the analog input through the Control4 audio distribution system, making the source 
digitized and available to other audio zones throughout the house. 

• Local Amp Mode checked. When the box is checked, it sets the Speaker Point in Local Amp 
Mode, enabling a local input source outputs directly, is not digitized and provides audio and 
video in one room. This enables devices that provide audio and video, such as a DVD, VCR, 
or Satellite Receiver to send output to the amplified audio outputs: the Right and Left 
Speakers in the room. If Local Amp Mode is not checked and you try to watch video in the 
room, the video or audio sound will be out of sync with the video. 

  
10. Now configure the system for WiFi. By default, the Speaker Point is configured for Ethernet use. If 

you are using WiFi, follow the instructions next. 

2.5.6.7.1.2 Configure Speaker Point for WiFi Use 
To configure Speaker Point for WiFi use: 
1. Start Composer and connect to Director on Local Network. 
2. In the Tools menu, select System Manager. 
3. In the Devices pane, select the network address of the device you want to configure, and click 

Connect. 
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Tip: If the device’s network address is not on this list, click Refresh. If it still does not appear, 
click Add to enter it manually. If you don’t know the network address, look in the Tools menu > 
Network Tools. 

  
4. Click the Network tab, and click Configure. 

  

 
  

5. Click Next when a Network Configuration wizard dialog appears. 
6. If desired, enter a new name for the device, and click Next. 
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IMPORTANT TIP: If the device has already been identified on the Control4 system, and you 
change the name (on this wizard screen), identify the device again. Until it is identified again, the 
Controller cannot recognize the name and will not be able to communicate with the device. 

  

 
  

7. Select the type of network you want the device to be a part of, and click Next. 
  

Example: Wireless network. 
  

8. Select the method to obtain an IP address, such as DHCP (first option) or Status IP (second 
option) distribution, and click Next. 

  
Example: Obtain an IP address automatically using DHCP. 

  
9. Select the method to obtain the DNS server address automatically, and click Next. 

  
Example: Obtain the DNS server address automatically. 

  
10. Enter the Network Name (SSID) of your wireless access point. 
11. Use the pull-down menu to indicate your Data encryption preference (64 or 128 bit). 
12. Select the Key type (hex or ASCII). 
13. Enter your Network Key (WEP Key), and click Test. 

• Hex: 64 bit (10 digits) or 128 bit (26 digits)—acceptable values 0 - 9, A- F 
• ASCII: 64 bit (5 digits) or 128 bit (13 digits)—acceptable values ASCII characters 
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Example: 
• Network Name (SSID): <name of wireless access point> 
• Data encryption: wep64 
• Key Type: hex 
• Network Key (in hex): ABCDE12345. 

  

 
  

Note: If the hex Network Key you insert is not valid, a screen with a red exclamation point comes 
up. In this case, enter your key again. 

  
14. Click Test to test your network connection. If it fails, follow the on-screen instructions. 
15. Click Finish when you come to the “Congratulations! You have successfully changed your 

network configuration” screen. 
16. At this time, the system reboots. Do not disconnect any temporary Ethernet cables until the 

device has successfully rebooted and is powered on. 
17. If you are using the WiFi to communicate to your Control4 Controller, disconnect the Ethernet 

CAT5 cable. 

2.5.6.8 Configure a Media Player 
Use the Control4® Composer Pro System Design and Connections views to add and configure a 
Media Player. This device auto-scans videos. A Media Player (such as Netgear EVA8000) lets you 
play media that is stored on a network drive or available through the Internet to a TV. 
  
The Media Player driver lets the Control4 system interact with the Media Player hardware through one 
of the Control4 System Remote Controls. The driver also supports the video playback functionality of 
the hardware, allowing the Control4 Navigators to be used to select a video title. 
  
Note: In Release 1.8, the Media Player (V1) does not work with ZigBee Pro. Use Media Player V2. 
The Media Player V2 driver is C4-MP2-E, located in the driver database.  
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Prerequisites 
Ensure that your Media Player is installed as directed in the Media Player Installation Guide and 
Media Player User Guide shipped with the hardware or available on the Control4 Dealer website. 
 
To configure a Media Player in your system: 
1. Add a Network File Storage driver to your Composer Pro project (available on the My Drivers 

tab), then configure the properties including browsing to the network location. For information on 
adding and configuring network file storage, see “Using External Storage Devices.” The network 
location must be an open share location (no password required). The Network File Storage driver 
supports both audio and video content. 

2. Start Composer and connect to a Director. 
3. Click System Design. 
4. In the System Design view, select the room where the Media Player resides. 
5. On the My Drivers tab or Search tab, double-click the Media Player model (such as Media Player 

EVA8000) to add it to the project. 
6. Identify the Media Player. In the Connections view: 

a. Click the Network tab, select Media Player in the list, and then click Identify in the IP 
Network Connections tab. 

b. Enter the IP address assigned to your Media Player in the box provided. 
  

 
  

7. Connect the Media Player. 
a. Click the Control/AV tab. 
b. Select Media Player in the project tree. 
c. Define the correct video and audio connections. 

8. Do one of the following: 
• Scan the videos. In the Media view, scan the videos that are in video_ts format: 

• Select Video Media under the network file share where you want to add the videos. 
• Click Scan. The scan operation identifies the video_ts format video files, adds them to the 

media database, and automatically associates the video metadata including cover art. 
When the scan completes, the videos in video_ts format are available for playback from 
the Navigators. 

• Manually add the videos. In the Media view, manually add videos that are in formats other 
than video_ts. Video formats other than video_ts that are supported by your Media Player 
can be added to the media database in Composer Pro manually. 
• Select Video Media under the network file share where you want to add the videos. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  50 of  199 

 

 

• Click New, and then choose the Browse option next to the Location text box in the pop-
up window. A new pop-up window will appear. 

• In the pop-up window, select the drop-down menu for Files of type, and then select the *.* 
option. 

• Select the file format you want to add to the database. 
  

When the videos in alternative video formats are added to the system manually, those videos 
become available for playback from the Navigators. 
 
Note: When using a System Remote Control Version 2, the Cancel button is mapped to the 
EVA8000 Back button and the DVR button toggles between aspect ratios. 

  
9. Check the properties. In the System Design view, select the Media Player. 
10. In the Properties pane, click the Properties tab.  

Modifiable properties include: 
• Debug Mode: Use the drop-down list to select an option to log or print in this mode. Select 

from Print, Log, or Print and Log. This option is tied to the output options in the Lua tab (see 
Step 13). 

• Resolution: Use the drop-down list to select the video output screen resolution. Auto 
indicates that the device negotiates over HDMI. 

• Current Resolution: Indicates the current video output screen resolution. If you know the 
highest resolution allowed for this device, set it to that resolution for best results. 

• Background Image URL: Indicates the background image. 
• Screen Saver Image URL: Indicates the screen saver image. 
• Firmware Version: Indicates the device's firmware version. 
• Update Status: Indicates status of current update if being updated. This status box is used 

with the Actions tab. See Step 12. 
• Last Error: Displays error messages if found. 
• Update URL: Indicates the URL for the updates. 
• Switchable Resolutions: Use all of the boxes below this box with the System Remote 

Control Pg up and Pg down buttons. If set to True, the option can be changed on the remote. 
11. Click the Documentation tab for more information about this device. 
12. To update this device, in the Properties pane, click the Actions tab, and then click Start Update 

to update this device. Note: Updates to this device occur separately from Update Manager 
updates. 

13. To view logging output, in the Properties pane, click the Lua tab. 

2.5.7 Configuring Lighting and Keypads 
Use the Control4® Composer Pro System Design and Connections views to configure Dimmers, 
Switches and Keypads. 
  
Tip: Double- and triple-tap events apply to the Control4 Dimmers, Switches, and Keypads. When you 
tap a button consecutively two (2) or three (3) times for about one-half of one second the events fire. 
You can use these events for programming without requiring the more complex programming logic 
tied to timers and button 'Press/Release' events. 
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Note: When programming using double and triple-tap events, be aware that Press and Release 
events also occur when double and triple-tap events occur. Plan your programming using these 
events so that they don't conflict with the intended outcome. In most cases, when using double and 
triple-tap programming events, don't program on the Press and Release events. 
  
These sections provide information about how to configure the lights or Keypads types for your 
Control4 system. 
 
“Configure a 2, 3 or 6-Button Keypad” 
“Configure a Wireless Switch or Dimmer or an Inline Dimmer” 
“Configure a Wireless Outlet Dimmer” 
“Configure a Wireless Outlet Switch” 
“Configure a Wireless Outlet Switch for Power Sensing AV Devices” 
“Configure a Wireless Puck Dimmer or Switch Module” 

2.5.7.1 Configure a 2-, 3-, or 6-Button Keypad 
Use the Control4® Composer Pro System Design and Connections views to configure Keypads. 
  
Note: To configure a 2, 3, or 6-Button Keypad for a 3-way switch, see “Configuring Lights for 3-Way,” 
“Configuring a 2-Button Keypad as a 3-Way Light,” or “Configuring a 3-Button Keypad to Control a 3-
Way Light.” 
 
Prerequisites 
Ensure that the Keypad is installed as directed in the Control4 Wireless 2, 3, or 6-Button Keypad 
Installation Guide available on the Control4 Dealer website. 
 
To add and configure a 2, 3, or 6-Button Keypad: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the 2, 3, or 6-Button Keypad resides. 
4. In the Items pane > My Drivers tab > User Interface > double-click 2, 3, or 6 Button Keypad to 

add the object to the project tree. 
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5. Click Connections. 
6. Click the Network tab to make the necessary network connection. To do this, select the 2, 3, or 6 

Button Keypad object, and click the Identify button. 
  

 
  

7. In Identify mode, go to the physical 2, 3, or 6-Button Keypad, and press the Top button to 
identify the Keypad to the Control4 system. 
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8. Click Close to exit the wizard. 
9. (Optional) To configure the properties, click System Design. In the project tree, select the 2, 3, or 

6 Button Keypad object for the properties to appear. 
  

Modifiable properties include (depending on the device selected): 
• LED 

Keypad Managed. The LED state is controlled by pressing the buttons on the Keypad. This is 
the factory default for the Keypad. 

  

If you uncheck Keypad Managed, the following buttons can be activated. 

  
• Set LED State ON—Ensures that the LED state is ON with the selected color. 
• Set LED State OFF—Ensures that the LED state is OFF with the selected color. 
• Set LED Color—Color when LED is ON or OFF. You can change the color in conjunction 

with the ON state and OFF state (Set LED State ON and Set LED State OFF). 
  
Follow Bound Color. If checked, the Keypad LED colors are set based on the device to which 
they are bound using the button-link bindings. This lets the Installer specify the On/Off colors for 
the Keypad LEDs independently of the device to which they are linked. 
  

Example: a 3-way Dimmer or Switch can be set to use the same colors for On and Off for the 
two (2) physical Dimmers if requested by the customer. 

  

Push Color—Indicates the LED color when the button is pushed. 

Release Color—Indicates the LED color when a pressed button is released. 

  

If Keypad Managed is unchecked, the LED state can be controlled by custom programming. 
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On Color—LED color when button is pressed to ON. 

Off Color—LED color when button is pressed to OFF. 

• Network 
MAC—Lets you view the device’s MAC address. 
Version—Lets you view the version of the firmware you are running. 

2.5.7.2 Configure a Wireless Switch or Dimmer or an Inline Dimmer 
Use the Control4® Composer Pro System Design and Connections views to configure Switches and 
Dimmers. 
 
Prerequisites 
Ensure that the Wireless Switch or Dimmer or Inline Dimmer is installed as directed in the Control4 
Wireless Switch Installation Guide, Control4 Wireless Dimmer Installation Guide or Control4 Inline 
Dimmer Installation Guide available on the Control4 Dealer website. 
 
To add and configure a Wireless Switch or Dimmer or an Inline Dimmer: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Wireless Switch, Wireless Dimmer or Inline Dimmer 

resides. 
4. In the Items pane > My Drivers tab > Lighting > Light > double-click Wireless Switch, Wireless 

Dimmer or Control4 LCZ-IL51-B (Inline Dimmer; search under Local Database) to add the object 
to the project tree. 

  
Note: The Wireless ELV Dimmer uses the same driver as the Wireless Dimmer. 

  
5. When the device shows up in the project tree, you can rename it to Switch or Dimmer (or 

whichever name works the best). 
6. Click Connections. 
7. Click the Network tab to make the necessary network connection. To do this, select the Wireless 

Switch, Wireless Dimmer or Inline Dimmer object, and click the Identify button as shown below. 
8. In Identify mode, go to the physical Switch or Dimmer, and press the Top button to identify the 

Switch or Dimmer to the Control4 system. The network address appears in the IP Network 
Connections pane. 
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9. Click Close to exit the wizard. 
10. (Optional) To configure the properties, click System Design. In the project tree, select the Switch 

or Dimmer object for the properties to appear as shown below. 
  

 
  

Modifiable properties include: 
Properties (these properties are available only on the Wireless Dimmer and the Inline Dimmer) 

• Click Ramp Rate Up—The rate in seconds when the light ramps from OFF to ON. 
• Click Ramp Rate Down—The rate in seconds when the light ramps from ON to OFF. 
• Preset Level—The percentage of the load to which the Dimmer ramps when turned on. 

Advanced Properties 
LED 

• Top Color On—The LED color for the top LED when the LED state is ON. 
• Top Color Off—The LED color for the top LED when the LED state is OFF. 
• Bottom Color On—The LED color for the bottom LED when the LED state is ON. 
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• Bottom Color Off—The LED color for the bottom LED when the LED state is OFF. 
Options 

• Top LED Link—If checked, swap on and off the state and color on the top LED. 
• Bottom LED Link—If checked, swap the on and off state and color on the bottom LED. 
• Buttons Attached—If checked, pressing the buttons on the Dimmer or Switch directly 

controls the connected load. 
• LED Attached—If checked, the LED state is controlled by the button presses. If 

unchecked, the LED state and colors can be controlled by custom programming. 
Hold Ramp Rate 

• Up—The rate in seconds when the load increases when the Top button is held down. 
• Down—The rate in seconds when the load decreases if the Bottom button is held down. 

Network—The current MAC address and firmware version of the selected Dimmer or Switch. 
These fields are not editable. 

  
The following properties apply to the Wireless Dimmer only. 
  
Load Profile—The minimum and maximum load settings for light output which includes the Cold Start 
Level and time. Test the settings to determine what fits best with your bulb type. Click Set to save 
your changes. 

  
Note: The Navigators show 0% to 100% even though the settings may be set at Minimum On 
Level percent at 25%, and the Max On Level percent at 80%. 
  
Minimum On Level (%)—Use the drop-down box to select the minimum % in 1% increments. 
The default is 0. The minimum level can vary, depending on the light type (incandescent, 
flourescent, LED, etc.). 
  
This is especially important in compact fluorescent (CLF) and LED lighting that sometimes have a 
minimum threshold for producing visible light that could be anywhere from the 10 – 40% range. 
Some loads will flicker or pulse right at their minimum threshold. 
  
Example: A bulb doesn’t produce visible light until it reaches 20%. The minimum On to 25% will 
ensure a clean On transition. 

  
Cold Start Level (%)—Use the drop-down box to select the start level in 1% increments. The default 
is 0. This level is set above the Minimum on level % setting. 

  
This setting is mainly applicable to CFL loads. Switching from an Off state to On sometimes 
exhibits a higher visible light threshold than after the CFLs have been on and have warmed up. If 
a Cold Start % is set (above the Minimum On %), the Dimmer cleanly jumps to that level from Off 
to On. However, when the Dimmer has been on for the time period designated by the Cold Start 
timer, the Dimmer can ramp below the Cold Start On % to the minimum On%. 
  
Example: Fluorescent lights go on, warm up, and then will dim down to the Minimum On Level % 
setting. Tapping the keypad on a 2-button Dimmer sets the light to its preset level. If you press 
and hold the button, the light checks the Minimum On Level % setting. 
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Cold Start Time (milliseconds)—Use the drop-down box to select the time in milliseconds. The 
default is 0. This is the length of time a light takes to warm up before it dims down to the Cold Start 
Level setting. 
  
Max On Level (%)—Use the drop-down box to select the maximum % light level in 1% increments. 
The default is 100. This is the level set for maximum light output, such as 100%. This setting enables 
capping of the light level for a given load below 100%, either to enhance bulb life or better match the 
light level in a given living space. This is an absolute maximum level rather than the Preset On level, 
which can be bypassed. 

  
11. To apply the changed settings on the Properties tab, click the Apply to... button and select the 

room's Dimmer or Switch. 
12. Click OK. 

2.5.7.3 Changing LED Colors on a Switch or Dimmer 
After you verify that your connections are correct in Control4® Composer Pro, you can set the 
properties and configure the system to meet the home control needs. 
 
To change the LED colors on a Switch or Dimmer: 
1. Start Composer and connect to a Director. 
2. Click System Design. In the project tree, select the Switch or Dimmer object for the properties 

to appear. 
  

 
  

3. For each LED light (Top and Bottom), click the color box to set a different color for the On and Off 
states. 

  
• Top Color: On. The LED color for the Top LED when the LED state is On. 
• Top Color: Off. The LED color for the Top LED when the LED state is Off. 
• Bottom Color: On. The LED color for the Bottom LED when the LED state is On. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  58 of  199 

 

 

• Bottom Color: Off. The LED color for the Bottom LED when the LED state is Off. 
  

Tip: You can change the LED lights based on programming. See the Programming view > Switch or 
Dimmer objects for the events available. Also, see the actions available for both Switch and Dimmer. 

2.5.7.4 Changing LEDs on 2-, 3-, or 6-Button Keypads 
Use the Control4® Composer Pro System Design view to change Keypad button LEDs. 
 
To change the LED colors on the Keypad: 
1. Start Composer and Connect to a Director. 
2. Click System Design. 
3. In the project tree, select a 2, 3, or 6 Button Keypad object for the properties to appear. 

  

 
  

4. To change the LED color when the button is pushed and released, check Keypad Managed. 
• If Keypad Managed is checked, the LED state is controlled by pressing the buttons on the 

keypad. 
• If Keypad Managed is unchecked, the LED state can be controlled by custom programming. 

  
Tip: You can change the LED lights based on programming. See the Programming view > 2 Button 
Keypad, 3 Button Keypad, or 6 Button Keypad objects for the events available. Also, see the actions 
available for the Keypads. 

  
5. Select the Push and Release colors: 

a. Click the color box next to Push Color for a color dialog to appear where you can select the 
color. The Push Color indicates the LED color when the button is pushed. 

b. Click the color box next to Release Color for a color dialog to appear where you can select 
the color. The Release Color indicates the LED color when a pressed button is released. 
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2.5.7.5 Configure a Wireless Outlet Switch 
Use the Control4® Composer Pro System Design and Connections views to configure a Wireless 
Outlet Switch. 
  
Configure and use the Wireless Outlet Switch and its plugged-in device to: 

• Control a plugged-in audio/video component (such as a DVD player or VCR) or other 
electrical equipment controlled by IR. 

• Control power to a plugged-in relay device (such as a pump) or other household appliances. 
• Switch a plugged-in lamp On or Off. 

  
Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet 
Switch is plugged into the wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 
 
Prerequisites 
1. Ensure that the Wireless Outlet Switch is installed as directed in the Control4 Wireless Outlet 

Switch Installation Guide available on the Control4 Dealer website. 
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system. 
 
To add and configure a Wireless Outlet Switch: 
 
IMPORTANT TIP: When configuring the Wireless Outlet Switch, add two (2) drivers: one for the 
Wireless Outlet Switch and one for the plugged-in device. In addition, define the connection between 
these two (2) devices In the Connections view > Control/AV tab. 

  
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Select the My Drivers tab > Lighting > Light, and double-click the Wireless Outlet Switch 

object to add it to the project tree. 
4. Identify the Wireless Outlet Switch on the network. 
5. Click Connections. 
6. From the IP Network Connections pane, select the Wireless Outlet Switch, and click Identify. 
7. When the Identify screen appears, go to the physical Wireless Outlet Switch, and press the top 

right button four (4) times to identify the Wireless Outlet Switch to the network. 
8. Add a driver for the device you want to plug into the Wireless Outlet Switch as appropriate for 

your use (power sensing, power controlling, or switching lamps on and off). 
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Power Sensing (Contact)—Using the Wireless Outlet Switch, the system can sense the power 
state of the plugged-in device, and the Controller can send the appropriate control commands 
based on the power state. 
  
For a plugged-in device: 
  
a. Add the appropriate driver. 
b. (For an AV device only, such as a DVD Player) Edit the driver to change the power 

management option in the driver for the correct connection to appear in the Connections view. 
To do this, see the "Change Power Management Options." For other devices, it is not 
necessary to edit the driver. 

c. Before you can use power sensing for the plugged-in device, perform Power Learning on the 
Wireless Outlet Switch for the plugged-in device on the appropriate outlet. For information 
about Power Learning when using the Wireless Outlet Switch power sensing, see “Perform 
Power Learning” later in this section.  

  
Power Control (Relay)—For a plugged-in device, add the appropriate driver. 

  
Example: Add a relay device by selecting a Pump to the project. Go to the System Design view 
in the Items pane, select the My Drivers tab > Motorization, and double-click the Pump object. 
 
Lighting—For a lamp, add an Outlet Light to the project. Go to the System Design view in the 
Items pane. Select the My Drivers tab > Lighting > Light, and double-click the Outlet Light 
object. 

  
Note: This is the Outlet Light object, and not the regular Wireless Outlet Switch object. 
 

9. Define the connection between the Wireless Outlet Switch and the plugged-in device. 
a. Click the Control/AV tab. 
b. Make a connection between the Wireless Outlet Switch and the device that is plugged into 

the Wireless Outlet Switch. Make this connection for any of these three (3) possible uses: 
power sensing (contact), power control (relay), and switching a lamp On or Off. 

c. In the Connections view, select the device that is plugged into the Wireless Outlet Switch. 
d. From the top screen, drag the appropriate connection to the Wireless Outlet Switch 

connection on the bottom screen. 
  
Example: Connection between the Wireless Outlet Switch and the Light Outlet. 
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2.5.7.5.1 Perform Power Learning 
To enable use of the power-sensing features, configure your Wireless Outlet Switch to read the power 
state of the devices that you plug into it. 
 
To perform Power Learning: 
1. Follow the steps in the previous section. 
2. Turn Off the device plugged into the Wireless Outlet Switch. 
3. Push and hold the button on the Top panel of the Wireless Outlet Switch until the two (2) LEDs 

toggle Orange On/Off, alternating back and forth. 
4. Choose an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that 

corresponds to that outlet number lights up. 
  

Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. Upon 
doing so, the LED you chose flashes orange, indicating that the Wireless Outlet Switch is learning 
a steady state of the device (such as On or Off). When the LED turns solid orange, the Wireless 
Outlet Switch has learned the steady state, but has not yet determined whether the state is On or 
Off. 

  
5. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch to an On 

state. The LED again flashes orange while the Wireless Outlet Switch is learning the On state of 
the device. When learning completes, the LED glows solid orange again to indicate the Wireless 
Outlet Switch has learned the steady state. 

6. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate the 
Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady state, the 
LED glows red to indicate the Wireless Outlet Switch has learned the Off state. 

7. With the LED now solid red, turn the device On again. The LED flashes orange to indicate it is 
waiting for a steady state. When the device reaches a steady state, the LED glows green to 
indicate the Wireless Outlet Switch has learned the On state. 

8. With the LED now solid green, press the button on the Wireless Outlet Switch one time to save 
and exit the Power Learning mode. 
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IMPORTANT TIP: You can use a quick button press during any step of this process prior to the 
LEDs turning solid Red or Green to exit the Learning mode without saving. 

  
9. Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional plugged-

in device. 
  

Note: To unlearn a device, press the button nine (9) times, but use with care; this will reset both 
outlets. 

2.5.7.6 Configure a Wireless Outlet Switch for Power Sensing AV Devices 
Use the Control4® Wireless Outlet Switch and its plugged-in device to: 

• Control a plugged-in audio/video component (such as a DVD player or VCR) or other 
electrical equipment controlled by IR. 

• Control power to a plugged-in relay device (such as a pump) or other household appliances. 
• Switch a plugged-in lamp On or Off. 

  
The instructions below describe how to configure an Outlet Switch in Composer Pro for a Samsung 
television. For instructions about how to configure the other actions, see Configure a Wireless Outlet 
Switch. 

  
Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet 
Switch is plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 
  

IMPORTANT: When configuring the Wireless Outlet Switch, you need to add two (2) drivers: 
• One (1) for the Wireless Outlet Switch 
• One (1) for the plugged-in device. 

 
In addition, define the connection between these two (2) devices in the Connections view > 
Control/AV tab. 
 
Prerequisites 
1. Ensure that your project has a Control4 Controller added and identified on the Control4 system. 
2. Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified on the 

Control4 system. 
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3. Ensure that the AV device, such as the Samsung Television object, is added and configured for 
the device. 

 
To configure a Wireless Outlet Switch to use an AV device, do the following: 
 
Select the Power Codes 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, right-click the Samsung Television and select Edit Driver. The Driver Wizard 

opens. 
4. In the Driver Wizard, check Has power feedback. 
5. Change the Power Management option to Contact sensor; ensure that the Send toggle code is 

selected. 
6. Click Codes. 

a. In Codes under Default Commands, make sure Power On and Power Off, or Power Toggle 
items are not checked. If they are, any programming you do in conjunction with power using 
the Wireless Outlet Switch and the television is invalid. 

b. Click Finish. 
c. Click next to close the window. 

  
IMPORTANT: Don’t click back to check if the selection was saved because it refreshes the screen; in 
that case, you will need to redefine what you just defined. 

  

 
 
Define the Connection 
7. Define the connection between the Wireless Outlet Switch and the plugged-in device (Samsung 

Television). 
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8. To do this, in the Connection > Control & Audio Video Connections pane select the Samsung 
Television that is plugged into the Wireless Outlet Switch. 

9. From the top screen drag the Contact Sensor connection to the correct sensor on the Wireless 
Outlet Switch in the bottom screen. 

10. Before you can use power sensing for the plugged-in device, perform Power Learning on the 
Wireless Outlet Switch for that plugged-in device on the appropriate outlet. Those steps are 
explained next. 
a. Turn off the device plugged into the Wireless Outlet Switch. 
b. Push and hold the button on the top panel of the Wireless Outlet Switch until the two (2) 

LEDs toggle orange On/Off, alternating back and forth. 
c. Choose an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that 

corresponds to that outlet number lights up. 
  

Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. The 
LED you chose flashes orange, indicating that the Wireless Outlet Switch is learning a steady 
state of the device (such as On or Off). When the LED turns solid orange, the Wireless Outlet 
Switch has learned the steady state, but has not yet determined whether the state is On or Off. 

  
d. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch On. 

The LED again flashes orange while the Wireless Outlet Switch is learning the On state. 
When the learning completes, the LED glows solid orange again to indicate the Wireless 
Outlet Switch has learned the steady state. 

e. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate 
the Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady 
state, the LED glows red to indicate that the Wireless Outlet Switch has learned the Off state. 

f. With the LED now solid red, turn the device On again. The LED flashes orange to indicate it is 
waiting for a steady state. When the device reaches a steady state, the LED glows green to 
indicate the Wireless Outlet Switch has learned the On state. 

g. With the LED now solid green, press the button on the Wireless Outlet Switch one time to 
save and exit the Power Learning mode. 

  
Tip: Use a quick-button press during any step prior to the LEDs turning solid red or green to exit 
the Power Learning mode without saving. 

  
11. Repeat these steps to configure the other outlet (Outlet 1or 2) as needed for any additional 

plugged-in device. 
12. To unlearn a device, press the button nine (9) times, but use with care; as this will reset both 

outlets. 

2.5.7.7 Configure a Wireless Outlet Dimmer 
Use the Control4® Composer Pro System Design and Connections views to configure a Wireless 
Outlet Dimmer. Configure the Wireless Outlet Dimmer to control and dim lamps. 
 
Prerequisites 
1. Ensure that the Wireless Outlet Dimmer is installed and set up as directed in the Control4 

Wireless Outlet Dimmer Installation Guide available on the Control4 Dealer website. 
2. Ensure that your project has a Control4 Controller added and identified on the Control4 system. 
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To add and configure a Wireless Outlet Dimmer: 
 
Note: Each Wireless Outlet Dimmer has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless 
Outlet Dimmer is plugged into a wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 
  

1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the Items pane > My Drivers tab > Lighting > Light double-click the Wireless Outlet Dimmer 

object driver to add to the project. 
4. Double-click the Outlet Light twice to add one for each outlet. 
5. Ensure that three (3) objects are added to the project tree: 

• One (1) for the Wireless Outlet Dimmer 
• Two (2) other objects representing Outlet 1 and Outlet 2 (Light 1 and Light 2) 

6. In the Connections view, use the Network tab to make the necessary network connection. To do 
this, select the Wireless Outlet Dimmer object, and click the Identify button. 

7. In Identify mode, go to the physical Wireless Outlet Dimmer and press the Button four (4) times 
to identify the device to the network. The address appears in the box. 

8. Click Close to exit the wizard. 
9. To configure the properties, click System Design. In the project tree, select the Wireless Outlet 

Dimmer object to view the device properties. 
• LEDs—Enabled/Disabled radio buttons—Lets you enable or disable the LED lights on the 

Wireless Outlet Dimmer. 
• Networking 

Channel—Lets you view the channel that the device is using to communicate on the 
network. 

Gateway —Lets you view the Gateway that the Wireless Outlet Dimmer is using on the 
network. 

MAC—Lets you view the MAC address that the Wireless Outlet Dimmer is using on the 
network. 

Version—Lets you view the Wireless Outlet Dimmer version. 

2.5.7.8 Configuring Lights for 3-Way 
Rather than creating programming to tie lighting variables and Control4® 3-way lights together, you 
can use a simplified lighting configuration to set up lighting control. In the Connections view, you can 
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configure global changes in Composer Pro Properties, and configure 3-way lights by dragging the 
lighting and control connections. 
  
The Push and Release features available on the Keypads let you dim lights like a Dimmer. 
  
Tip: To find out how to configure global changes for lights and other devices, see "Accessing 
Properties from the Project Tree" in Composer Pro Getting Started. 

2.5.7.8.1 Configuring a 2-Button Keypad as a 3-Way Light 
Use the Control4® Composer Pro Connections view to configure a 3-way light using a 2-button 
Keypad. 
  
Example: Configure a 2-Button Keypad to turn On (Top button) and turn Off (Bottom button) a 
Dimmer, and to use the Push/Release function available on the 2-Button Keypad to dim a light. 
 
Prerequisites 
1. Ensure that your Controller hardware is added and identified to the Control4 system. 
2. Ensure that you have a 2-Button Keypad and Dimmer (or Switch) added and identified to the 

project. 
 
To configure a 2-Button Keypad as a 3-way light: 
1. Start Composer and connect to a Director. 
2. Click Connections. 
3. Select the 2-Button Keypad in the project tree. 
4. In the Control & Audio Video Connections pane under Control Inputs, click the Button 1 Link 

connection, and drag it to the Dimmers’s Top Button Link in the bottom pane. 
5. Click the Button 2 Link connection, and drag it to the Dimmer’s Bottom Button Link in the 

bottom pane. 
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6. Test to ensure that the 2-Button Keypad turns the light on and off, and that the Push/Release 
functions dim the light. 

2.5.7.8.2 Configuring a 3-Button Keypad to Control a 3-Way Light 
Use the Control4® Composer Pro Connections view to configure a 3-Button Keypad to use a toggle 
for a 3-way light. 
  
Example: Configure a 3-Button Keypad to toggle the light On and Off. Use Push and Release to dim 
and brighten the light as desired. 
 
Prerequisites 
1. Ensure that your Controller hardware is configured properly, and that the 3-Button Keypad and 

Dimmer (or Switch) are added to the project and identified. 
2. Ensure that you have a 3-Button Keypad added and identified to the project. 
 
To configure a button on a 3-Button Keypad to control a 3-way light: 
1. Start Composer and connect to a Director. 
2. Click Connections. 
3. In the project tree, select the 3-Button Keypad. 
4. In the Control & Audio Video Connections pane, drag the Button 1 Link connection from the top 

list over the light’s Toggle Button Link in the bottom list. 
  

 
  

5. Test to ensure that the 3-Button Keypad turns the light On and Off, and that the Push/Release 
functions dim the light. 

2.5.7.9 Configure a Wireless Puck Dimmer or Switch Module 
Use the Control4® Composer Pro System Design and Connections views to configure Wireless Puck 
Dimmer or Switch modules. 
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Prerequisites 
Ensure that either the Puck Switch Module or Puck Dimmer Module is installed as directed in the 
Control4 Wireless Puck Dimmer or Switch Module Installation Guide available on the Control4 Dealer 
website. 
 
To add and configure a Wireless Puck Dimmer or Switch Module: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Wireless Puck Switch Module or Wireless Puck 

Dimmer Module resides. 
4. In the Items pane > Search tab > Device Type: Light > Manufacturer: Control4 double-click the 

Wireless Puck Dimmer Module: C4-DM201-Z or the Wireless Puck Switch Module: C4-SM201-Z 
to add the object to the project tree. 

5. When the device shows up in the project tree, you can rename it to whatever name works the 
best for you or your customer. 

6. Click Connections. 
7. Click the Network tab to make the necessary network connection. To do this, select the Wireless 

Puck Switch Module or Wireless Puck Dimmer Module, and click the Identify button shown 
below. 

8. In Identify mode, go to the physical Puck Switch or Puck Dimmer, and press four (4) times the 
button on the puck or the button that is connected to Contact 1 on the puck to identify the Switch 
or Dimmer to the Control4 system. The network address appears in the IP Network Connections 
pane. 

9. Click Close to exit the wizard. 
10. (Optional) To configure the properties, click System Design. In the project tree, select the Puck 

Switch or Puck Dimmer object for the properties to appear as shown below. Click Set to save 
your changes. 
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Puck Dimmer Properties:  
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Puck Switch Properties:  
 

 
 

Modifiable properties for the Wireless Puck Dimmer Module or Wireless Puck Switch Module include: 
Properties (Wireless Puck Dimmer Module Only) 

• Click Ramp Rate Up—The rate the light ramps from off to on when the button is clicked. 
• Click Ramp Rate Down—The rate the light ramps from on to off when the button is clicked. 
• Preset Level—The percentage of the load to which the Puck Dimmer Module ramps when 

turned on. 
Advanced Properties 

Aux 1 or Aux 2 Properties 
Set these properties when you want to control the Puck module with a switch connected to the 
auxiliary terminals. 
• Aux Type—From the drop down select the type of auxiliary switch connected to the terminal. 

• Momentary—A momentary switch only closes the circuit when the button is pressed. 
Momentary switches typically have a “spring-back” action that returns the button to its 
original position after it is released. 

• Latch—A latching switch typically takes the form of a toggle or rocker button and opens 
or closes the circuit depending upon the position of the switch. When using a latching 
switch with the Puck Module, the Puck reacts to each transition of the switch from on-to-
off or off-to on. It does not react to the actual on/off state of the switch. Each transition is 
treated as a “click.” Note: It is not possible to perform a press-and-hold with a latching 
switch. 

• Aux Behavior—From the drop down select the desired behavior that will occur when a 
momentary button is pressed or a latching switch is toggled. 
• Load On—The load is set to on (not available with latching switches). 
• Load Off—The load is set to off (not available with latching switches). 
• Load Toggle—The load is toggled between on and off. 
• Generic—The button/switch is not tied to the load and can be programmed as desired. 

• LED Behavior—From the drop down select the desired behavior for the associated LED. 
• Load On—The LED is on when the load is on. 
• Load Off—The LED is on when the load is off. 
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• Contact Open—The LED is on when the auxiliary contact is in the Open position. 
• Contact Closed—The LED is on when the auxiliary contact is in the Closed position. 
• Unmanaged—The LED is not tied to the contact or load and can be controlled using the 

Programming view. 
 
Virtual Button Colors 
The virtual button color defines the LED color that will appear on a keypad button that is bound to 
the Puck module when that keypad button is set to Follow Bound Color. 
 
Select a virtual button LED from the drop-down list, choose the LED color and then click the Set 
button. (Note: the Set button must be clicked before selecting a different virtual button LED from 
the drop-down list or the previous selection will be lost.) 
 
Fault Detection 
The status field indicates whether the Puck Module is in a fault state. Fault conditions can be 
caused by a short circuit, overloading the module, or potentially an incandescent bulb blowing.  
 
To reset the device, click the Reset button. Alternatively, the button on the Puck or the button 
attached to Contact 1 can be clicked 15 times to reset the device.  
 
If the device returns to a fault state after reset, verify the wiring and and/or the total wattage of 
loads connected to the device. 

 
Load Profile (Wireless Puck Dimmer Module Only) 
These are the minimum and maximum load settings for light output which includes the Cold Start 
Level and time. Test the settings to determine what fits best with your bulb type. 

 
Note: The Navigators show 0% to 100% even though the settings may be set at Minimum On 
Level percent at 25%, and the Max On Level percent at 80%. 
 
Minimum On Level (%)—Use the arrows selection box to select the minimum % in 1% 
increments. The default is 0. The minimum level can vary, depending on the light type 
(incandescent, fluorescent, LED, etc.). 
 
This is especially important in compact fluorescent (CLF) and LED lighting that sometimes have a 
minimum threshold for producing visible light that could be anywhere from the 10 – 40% range. 
Some loads will flicker or pulse right at their minimum threshold. 
 
Example: A bulb doesn’t produce visible light until it reaches 20%. The minimum On to 25% will 
ensure a clean On transition. 

 
Cold Start Level (%)—Use the arrows selection box to select the start level in 1% increments. 
The default is 0. This level is set above the Minimum on level % setting. 

 
This setting is mainly applicable to CFL loads. Switching from an Off state to On sometimes 
exhibits a higher visible light threshold than after the CFLs have been on and have warmed up. If 
a Cold Start % is set (above the Minimum On %), the Dimmer cleanly jumps to that level from Off 
to On. However, when the Dimmer has been on for the time period designated by the Cold Start 
timer, the Dimmer can ramp below the Cold Start On % to the minimum On%. 
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Example: Fluorescent lights go on, warm up, and then will dim down to the Minimum On Level % 
setting. 

  
Cold Start Time (milliseconds)—Use the arrows selection box to select the time in milliseconds. 
The default is 0. This is the length of time a light takes to warm up before it dims down to the Cold 
Start Level setting. 

  
Max On Level (%)—Use the arrows selection box to select the maximum % light level in 1% 
increments. The default is 100. This is the level set for maximum light output, such as 100%. This 
setting enables capping of the light level for a given load below 100%, either to enhance bulb life 
or better match the light level in a given living space. This is an absolute maximum level rather 
than the Preset On level, which can be bypassed. 

 
Dimming Mode 

• Autodetect—Automatically detects the load type and determines whether the Dimmer should 
use Forward or Reverse Phase dimming. This is the default and should not be changed 
unless the load is not dimming properly. 

• Forward Phase—Forces the Dimmer Module to use Forward Phase dimming. Should only 
be used with magnetic transformers. 

• Reverse Phase—Forces the Dimmer Module to use Reverse Phase dimming. 
Hold Ramp Rate (Wireless Puck Dimmer Module Only) 

• Up—The time, in seconds, it takes the load to ramp to 100% when a button controlling the 
load is pressed and held. 

• Down—The time, in seconds, it takes the load to fade to 0% when a button controlling the 
load is pressed and held. 

Energy Information 
• Minutes Off—The number of minutes that the load has been off since the Puck Module was 

last reset. 
• Minutes On—The number of minutes that the load has been on since the Puck Module was 

last reset. 
• Minutes On Today—The number of minutes that the load has been on today. 
• Current Power—The current power being used by the load (in watts). 
• Energy Used—The total number of watt hours used by the load since the device was last 

reset. 
• Energy Used Today—The total number of watt hours used by the load from 12:00 AM until 

11:59 PM today. 
Network 
This is the current MAC address and firmware version of the selected Puck Dimmer or Switch. These 
fields are not editable. 

  
11. To apply the changed settings on the Properties tab to another Puck Module, click the Apply to... 

button and select the Puck Dimmers or Puck Switches to which the settings should be applied. 
12. Click OK. 
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2.5.7.10 Examples of Lighting Configurations 
This section provides examples about how to change various Switch, Dimmer and Keypad settings in 
the Control4® system. 

2.5.7.10.1 Configure a Wireless Outlet Switch for Power Sensing AV Devices 
Use the Control4® Wireless Outlet Switch and its plugged-in device to: 

• Control a plugged-in audio/video component (such as a DVD player or VCR) or other 
electrical equipment controlled by IR. 

• Control power to a plugged-in relay device (such as a pump) or other household appliances. 
• Switch a plugged-in lamp On or Off. 

  
The instructions below describe how to configure an Outlet Switch in Composer Pro for a Samsung 
television. For instructions about how to configure the other actions, see “Configure a Wireless Outlet 
Switch.” 
  
Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet 
Switch is plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 
  

IMPORTANT: When configuring the Wireless Outlet Switch, you need to add two (2) drivers: 
• One (1) for the Wireless Outlet Switch 
• One (1) for the plugged-in device. 

In addition, define the connection between these two (2) devices in the Connections view > 
Control/AV tab. 
 
Prerequisites 
1. Ensure that your project has a Control4 Controller added and identified on the Control4 system. 
2. Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified on the 

Control4 system. 
3. Ensure that the AV device, such as the Samsung Television object, is added and configured for 

the device. 
 
To configure a Wireless Outlet Switch to use an AV device: 

 
Select the Power Codes 
1. Start Composer and connect to a Director. 
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2. Click System Design. 
3. In the project tree, right-click the Samsung Television and select Edit Driver. The Driver Wizard 

opens. 
4. In the Driver Wizard, check Has power feedback. 
5. Change the Power Management option to Contact sensor; ensure that the Send toggle code is 

selected. 
6. Click Codes. 

a. In Codes under Default Commands, make sure Power On and Power Off, or Power Toggle 
items are not checked. If they are, any programming you do in conjunction with power using 
the Wireless Outlet Switch and the television is invalid. 

b. Click Finish. 
c. Click next to close the window. 

  
IMPORTANT: Don’t click back to check if the selection was saved because it refreshes the screen; in 
that case, you will need to redefine what you just defined. 

  

 
 
Define the Connection 
7. Define the connection between the Wireless Outlet Switch and the plugged-in device (Samsung 

Television). 
8. To do this, in the Connection > Control & Audio Video Connections pane select the Samsung 

Television that is plugged into the Wireless Outlet Switch. 
9. From the top screen drag the Contact Sensor connection to the correct sensor on the Wireless 

Outlet Switch in the bottom screen. 
10. Before you can use power sensing for the plugged-in device, perform Power Learning on the 

Wireless Outlet Switch for that plugged-in device on the appropriate outlet. 
a. Turn off the device plugged into the Wireless Outlet Switch. 
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b. Push and hold the button on the top panel of the Wireless Outlet Switch until the two (2) 
LEDs toggle orange On/Off, alternating back and forth. 

c. Choose an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that 
corresponds to that outlet number lights up. 

  
Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. The LED 
you chose flashes orange, indicating that the Wireless Outlet Switch is learning a steady state of 
the device (such as On or Off). When the LED turns solid orange, the Wireless Outlet Switch has 
learned the steady state, but has not yet determined whether the state is On or Off. 
  
d. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch On. 

The LED again flashes orange while the Wireless Outlet Switch is learning the On state. 
When the learning completes, the LED glows solid orange again to indicate the Wireless 
Outlet Switch has learned the steady state. 

e. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate 
the Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady 
state, the LED glows red to indicate that the Wireless Outlet Switch has learned the Off state. 

f. With the LED now solid red, turn the device On again. The LED flashes orange to indicate it is 
waiting for a steady state. When the device reaches a steady state, the LED glows green to 
indicate the Wireless Outlet Switch has learned the On state. 

g. With the LED now solid green, press the button on the Wireless Outlet Switch one time to 
save and exit the Power Learning mode. 

  
Tip: Use a quick-button press during any step prior to the LEDs turning solid red or green to exit 
the Power Learning mode without saving. 

  
11. Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional plugged-

in device. 
12. To unlearn a device, press the button nine (9) times, but use with care; as this will reset both 

outlets. 

2.5.8 Configuring Navigators 
Use the Control4® Composer Pro System Design and Connections views to configure Navigators for 
the Control4 system. 
  
Note: You may have noticed a "Commissioning Remote Control SR-250" driver in the Online 
Database; this driver is not used for residential customers. 
 
These subsections provide information about configuring System Remote Controls and Touch 
Screens: 
 
“Configure System Remote Control SR-150B” 
“Configure System Remote Control Version 3, SR-250” 
“Configure a 7-inch Portable Touch Screen” 
“Configure a 7-inch Tabletop or Wall-Mounted Touch Screen” 
“Configure a 5” or 7” In-Wall Touch Screen” 
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“Configure Mobile Devices or PCs/Tablets as Navigators” 

2.5.8.1 Configure System Remote Control SR-150B 
Use the Control4® Composer Pro System Design and Connections views to add and identify this 
device. 
 
Prerequisites 
Ensure that the SR-150B is installed as directed in the Control4 System Remote Control System 
Remote Control SR-150B Setup Guide. 
 
To add and configure an SR-150B: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the System Remote Control resides. In the Items pane 

> My Drivers tab > User Interface > double-click System Remote Control SR-150 to add the 
object to the project tree. 

  

 
  

4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 
6. Select the System Remote Control SR-150 object, and click the Identify button. 
7. In Identify mode, go to the physical System Remote Control, and press the Red 4 button to 

identify the System Remote Control to the Control4 system. 
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Note: To complete the identification process, the System Remote Control must be on the same 
ZigBee channel as the Controller, and the Controller must have Zserver enabled. To change the 
ZigBee channel on the remote, see Step 12. 

  
8. When the MAC address appears in the window, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the System Remote Control object. 
11. View and change the properties in the Properties pane. 

  
Note: Press any button on the System Remote Control to display the configurable property 
values in the Properties pane. Because the SR-150B has no window, some of the options below 
are not supported in the SR-150B. 

  
Modifiable properties include: 
• Screen Backlight—Not used. 
• Keypad Backlight—Lets you set the light level of the backlight. The default is 0%. Click Set 

Level. 
• Sleep Mode—Lets you configure sleep mode settings. The default is five (5) seconds, but 

can be extended to 60 seconds. Select Wake on Movement if you want the SRC to wake up 
when moved. 

• Batteries—Lets you view the battery level on your System Remote Control. 
• Network—Lets you view the System Remote Control’s ZigBee channel, gateway, MAC 

address and firmware version. 
• MAC—Displays the remotes own MAC address. 
• Firmware Version—Displays the current firmware version of the remote. 

• Watch/Listen Button Behavior—If you select one of the options below, the following action 
occurs when you press the Watch button. 
• No Action—When you press the Watch button, nothing happens. This option can be tied 

to programming a button (see the section below). 
• Select Most Recently Used Device—Lists the last three (3) devices; e.g., DVD player, 

Media Player, Television, etc. 
12. Change the System Remote Control settings as needed at the physical System Remote Control 

SR-150B using the applicable button-press sequence: 
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• Check ZigBee Channel—To determine the current ZigBee channel, press Room Off, 0, 0, 3 
(or Room Off, 7, 4, 7) (in that order), and then count the blinks of Room Off. The number of 
blinks corresponds with the channel number. 

• Reset to Factory Defaults—To reset all settings to the factory defaults (including ZigBee 
channel), press Room Off, 9, 9, 9. 

2.5.8.1.1 Program the System Remote Control SR-150B Programmable Buttons 
On the System Remote Control SR-150, you can program six (6) buttons (Red, Green, Yellow, Blue, 
*, and #) to perform programmed activities. The buttons can be programmed to execute any of the AV 
device’s macros or IR codes or be programmed by room. 
 
To program the buttons: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Ensure that you have the following devices in your project: 

• Controller 
• System Remote Control SR-150B 
• An AV device to be controlled 

4. Click Connections. 
5. Click the Network tab. Ensure that the Controller and the System Remote Control are both 

network identified. 
6. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the 

selected AV device or the selected room. 
  

Based on AV Device: 
a. Click System Design. 
b. Select an AV device to display the device’s Properties page. 

  

 
  

c. On the device’s Properties page, choose Code or Macro for the button you want to program, 
and then choose a code or macro from the drop-down list. 
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d. Edit the Help text as needed, and then choose Set. 
  

Note: Help text describes custom programming to users in the House option in any of the 
Navigators. 

  
Example: (1) In System Design, select Disc Changer. (2) In the Red button, choose Code. (3) 
From the drop-down list, choose Subtitle. (4) Choose the Set button to create a Subtitle button. 

  
Based on Room: 
a. Click Programming. 
b. Select a room in the Device Events pane. 
c. Select the Commands radio button in the <Room> Events pane. 
d. Use the drop-down menu to select a command or button (example, Blue Button). 
e. In the Actions pane, build the script using the items to program the actions in the selected 

room when the selected command or button is used. 

2.5.8.2 Configure System Remote Control SR-250 
Use the Control4® Composer Pro System Pro Design and Connections views to add and identify this 
device. 
 
Prerequisites 
Ensure that the System Remote Control SR-250 is installed as directed in the Control4 System 
Remote Control SR-250 Setup Guide available on the Control4 Dealer website. 
 
To add and configure an SR-250: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the System Remote Control resides. In the Items pane 

> My Drivers tab > User Interface > double-click System Remote Control SR-250 to add the 
object to the project tree. 
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4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 
6. Select the System Remote Control SR-250 object, and click the Identify button. 
7. In Identify mode, go to the physical System Remote Control, and press the Red 4 button to 

identify the System Remote Control to the Control4 system. 
  

 
  

Note: To complete the identification process, the System Remote Control must be on the same 
ZigBee channel as the Controller, and the Controller must have Zserver enabled. To change the 
ZigBee channel on the remote, see Step 12. 

  
8. When the MAC address appears in the window, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the System Remote Control object. 
11. View and change the properties in the Properties pane. 

  
Note: Press any button on the SR-250 to display the configurable property values in the 
Properties pane.  
  
Tip: You can also change most of these settings on the SR-250 using Info > Config. 
  
Modifiable properties include: 
• Screen Backlight—Lets you set the light level of the screen's backlight. Choose a 

percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set Level. 
• Keypad Backlight—Lets you set the light level of the keypad's backlight. Choose a 

percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set Level. 
• Sleep Mode—Lets you set how long the System Remote Control stays awake after no 

activity. The default setting is five (5) seconds, but can be extended to 60 seconds. Select 
Wake on movement to wake the SR-250 up when moved. 

• Batteries—Lets you view the battery level (strength in %) of your System Remote Control. 
• Network—Lets you view the System Remote Control’s ZigBee channel, gateway, MAC 

address and firmware version. 
• Channel—Displays your ZigBee channel (1-15), which should match the ZigBee channel 

set for the Controller. 
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• Gateway—Displays the MAC address of the ZigBee server (usually your Controller 
unless you specify otherwise). 

• MAC—Displays the System Remote Control's own MAC address. 
• Firmware Version—Displays the current firmware version of the System Remote 

Control. 
• Watch/Listen Button Behavior—If you select one of the options below, the following action 

occurs when you press the Watch button. 
• No Action—If you select this option and you press the Watch button, nothing happens. 

This option can be tied to programming a button (see the section below). 
• Select Most Recently Used Device—Lists the last three (3) devices; e.g., DVD player, 

Media Player, Television, etc. 
• Show Device List—Lists the source device of the selection. 

 
12. (Conditional) Change ZigBee Channel: If you need to change the ZigBee channel to match the 

Controller’s channel or to improve reception, do the following at the System Remote Control SR-
250. 

  
If the System Remote Control is NOT identified, follow these steps: 
a. Press buttons 2, 4, 8, 6, #, *, and then press the List button (in that order) to get into Edit 

mode. 
b. Use the up or down arrows to pick the ZigBee channel. 
c. Press Select to change the ZigBee channel. 
d. Press CNCL to exit Edit mode. 

  
If the System Remote Control IS identified, follow these steps: 
a. Press the List button once or twice to display the menu options. 
b. Press buttons 2, 4, 8, 6, #, * and then press the List button (in that order) to get into Edit 

mode. 
c. Use the up or down arrows to pick a ZigBee channel. 
d. Press Select to change the ZigBee channel. 
e. Press CNCL to exit Edit mode. 

2.5.8.2.1 Program the SR-250 Programmable Buttons 
On the System Remote Control SR-250, you can program six (6) buttons (Red, Green, Yellow, Blue, 
*, and #) to perform programmed activities. You can program these buttons to execute any of the AV 
device’s macros or IR codes or they can be programmed by room. 
 
To program the SR-250 programmable buttons: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Ensure that you have the following devices in your project: 

• Controller 
• System Remote Control SR-250 
• An AV device to be controlled 
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4. Click Connections. 
5. Click the Network tab. Ensure that the Controller and the System Remote Control are both 

network identified. 
6. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the 

selected AV device or the selected room. 
  

Based on AV Device: 
a. Click System Design. 
b. Select an AV device to display the device’s Properties page. 

  

  
c. On the device’s Properties page, choose Code or Macro for the button you want to program, 

and then choose a code or macro from the drop-down list. 
d. Edit the Help text as needed, and then choose Set. 

  
Note: Help text describes custom programming to users in the House option in any of the 
Navigators. 
  
Example: (1) In System Design view, select Disc Changer. (2) In the Red button, choose Code. 
(3) From the drop-down list, choose Subtitle. (4) Choose the Set button to create a Subtitle 
button. 

  
Based on Room: 
a. Click Programming. 
b. Select a room in the Device Events pane. 
c. Select the Commands radio button in the <Room> Events pane. 
d. Use the drop-down menu to select a command or button (example, Blue Button). 
e. In the Actions pane, build the script using the items to program the actions in the selected 

room when the selected command or button is used. 
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2.5.8.2.2 Program the SR-250 Paging Feature 
Configure the Beep paging feature for this System Remote Control version through programming. Use 
this feature to page a lost System Remote Control. You can program a Keypad or a custom button to 
cause the System Remote Control to beep when pressed. 
 
To program the paging feature for this System Remote Control: 
1. Start Composer and connect to a Director. 
2. Click Programming. 
3. Select the Event that you want to use to start the page. Example: To select a Keypad button 

press, first select the Keypad in the Device Event pane, and then select the button in Events. 
4. In the Actions list, select System Remote Control SR-250. 
5. In the Commands list, choose an action below for the System Remote Control, and then drag the 

green arrow to the Script pane. 
  

 
  

• Beep until button press—The System Remote Control beeps until you press one of its 
buttons. 

• Beep for X seconds (<254)—The System Remote Control beeps until X seconds have 
elapsed or you press one of its buttons. 

• Stop Beep—The System Remote Control stops beeping. 
6. Click Execute. 

2.5.8.2.3 Change the Order of Watch/Listen Sources 
To change the order of your customer's sources when they press Watch/Listen: 
1. In Composer Pro, click System Design. 
2. In the project tree, click the room to control. 
3. Click the Navigator tab. 
4. From the Menu (left side), select the function to change; for example, Watch or Listen. 
5. Select the item in 'Device Visibility and Display Order,' and then click Modify. 
6. Change to the desired order, and then click OK. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  84 of  199 

 

 

2.5.8.3 Configure a 7” Portable Touch Screen (C4-TSM7) 
Use the Control4® Composer Pro System Design and Connections views to add and configure this 
device. Note: If you want to use the new 7” Portable Touch Screen with Camera, released with OS 
2.2, see the next section. 
 
Prerequisites 
1. Ensure that the 7" Portable Touch Screen (C4-TSM7-G-B) is installed as directed in the Control4 

7" Portable Touch Screen Installation Guide available on the Control4 Dealer website.  
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system. 
 
To add and configure a 7" Portable Touch Screen: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My 

Drivers tab > User Interface > double-click Touch Screen - 7" Portable to add the object to the 
project tree. 

4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 
  

Note: If this Touch Screen will be providing audio output, the Touch Screen needs to be identified 
as an Audio end point for the room. 

  
6. Select the Touch Screen - 7" Portable object, and click the Identify button. 
7. In Identify mode notice the Touch Screen button highlighted in the Composer Pro pane. Go to the 

physical 7" Portable Touch Screen, and press the button indicated in Composer Pro to identify the 
Touch Screen to the Control4 system. 

8. When the address appears on the Composer Pro screen, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the Touch Screen - 7" Portable object. 
11. View and change the properties in the Properties pane. 

  
Modifiable properties include: 
Backlight Level—Use the up or down arrows to set the light level of the backlight. You can 
change the brightness of the backlight with this option by percentage, so 100% is On at full 
brightness and 0% is Off. 
Backlight Preset Level—Lets you set the default backlight level. If you ever restart or power the 
Mini Touch Screen again, this is the backlight level it would go to. 
Button Animation Enabled—Lets you select a button to glow. 
Volume Control Follows Selected—Lets you select other rooms aside from the one that 
contains the Touch Screen, and change its volume when leaving the room. 
Wake on motion—Select to wake up the Touch Screen when it is moved. 
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2.5.8.4 Configuring a 7” Portable Touch Screen with Camera (C4-TSMC7) 
Use the Control4® Composer Pro System Design and Connections views to add and configure this 
device. 
 
Prerequisites 
1. Ensure that the 7" Portable Touch Screen with Camera (C4-TSMC7-EN) is installed as directed in 

the Control4 7" Portable Touch Screen with Camera Setup Guide available on the Control4 
Dealer website. Note: If you want to install the new 7" Portable Touch Screen with Camera, 
ensure that the part number says "C4-TSMC7-EN" when you add the driver. 

2. Ensure that your project has a Control4 Controller added and identified in the Control4 system. 
 
To add and configure a 7" Portable Touch Screen with Camera: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My 

Drivers tab > User Interface > double-click Touch Screen - 7" Portable to add the object to the 
project tree. 

4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 
  

Note: If this Touch Screen will be providing audio output, the Touch Screen needs to be identified 
as an Audio end point for the room. 

  
6. Select the Portable 7” Touch Screen V2 object, and click the Identify button. 
7. In Identify mode notice the Touch Screen button highlighted in the Composer Pro pane. Go to the 

physical 7" Portable Touch Screen with Camera, and press the button indicated in Composer Pro 
to identify the Touch Screen to the Control4 system. 

8. When the address appears on the Composer Pro screen, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the Portable 7” Touch Screen V2 object. 
11. View and change the properties in the Properties pane. 

  
Modifiable properties include: 
Backlight Level—Use the up or down arrows to set the light level of the backlight. You can 
change the brightness of the backlight with this option by percentage, so 100% is On at full 
brightness and 0% is Off. Click Set to save. 
Backlight Preset Level—Lets you set the default backlight level. If you ever restart or power the 
Touch Screen again, this is the backlight level it would go to. Click Set to save. 
WiFi Signal Strength—If using WiFi, shows you the strength of your wireless signal. 
Enable Camera—Check to use the camera with this device for video intercom. 

2.5.8.5 Configure a 7” Tabletop Touch Screen 
Use the Control4® Composer Pro System Design and Connections views to add and configure this 
device. 
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Prerequisites 
1. Ensure that the 7" Tabletop Touch Screen (C4-TST7-EG-B or C4-TSTR7-EG-B) is installed and 

on (not in Sleep Mode) as directed in the Control4 7" Tabletop Touch Screen Installation Guide. 
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system. 
 
To add and configure a 7" Tabletop Touch Screen: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My 

Drivers tab > User Interface > double-click Touch Screen - 7" to add the object to the project 
tree. 

4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 
6. Select the Touch Screen - 7" object, and click the Identify button. 
7. In Identify mode, notice the Touch Screen button highlighted in the Composer Pro pane, go to the 

physical 7" Touch Screen, and press the button indicated in Composer Pro to identify the Touch 
Screen to the Control4 system. 

8. When the address appears on the Composer Pro screen, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the Touch Screen - 7" object. 
11. View and change the properties in the Properties pane. 

  
Modifiable properties include: 
Backlight Level—Use the up or down arrows to set the light level of the backlight, and then click 
Set. You can change the brightness of the backlight with this option by percentage, so 100% is 
On at full brightness and 0% is Off. 
Backlight Preset Level—Lets you set the default backlight level. If you ever restart or power the 
Touch Screen again, this is the backlight level it would go to. Click Set to save your changes. 
Button Animation Enabled—Lets you enable animated buttons for a 3D effect. 
Wake on proximity—Lets you set the Touch Screen to wake up when someone approaches 
within four (4) feet of the device. 
Detect Ambient Light Levels—Lets you set the options according to how much light is in the 
room. You can use this option in programming also. 

Set Threshold—Threshold settings from 0 to 100; 0 means no light; 100 means full light. 

Current Light Level—Shows current light level. 

2.5.8.6 Configure an 5” or 7” In-Wall Touch Screen 
Use the Control4® Composer Pro System Design and Connections views to add and configure this 
device. 
 
Note: This Touch Screen includes full duplex point-to-point Intercom sessions, broadcast support to 
multiple Touch Screens, and monitoring from the interface. An Intercom driver and agent must be 
added and configured in the Composer project. See this section, the Control4 System User Guide, 
and “Example: Program Using the Intercom Agent” for details. 
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Also, you must purchase, assign, and check in an Intercom license for consumers who want this 
feature. See Managing Dealer Accounts on My.Control4.Com for information about how to purchase 
and assign an Intercom license. 

2.5.8.6.1 Scenarios 
1. User wants to have full-duplex, room-to-room calling. In this case, the Control4 system must 

have at least two (2) 5" or 7" In-Wall Touch Screens installed. 
2. User wants to broadcast a message without a response. In this case, the Control4 system 

must have at least one (1) 5" or 7" In-Wall Touch Screen installed. 
3. User wants to broadcast a message with a response. In this case, the Control4 system must 

have at least two (2) 5" or 7" In-Wall Touch Screens installed. 
4. User wants to monitor the sounds in another room. In this case, the Control4 system must 

have at least two (2) 5" or 7" In-Wall Touch Screens installed. 
 
Prerequisites 
1. Ensure that the 5" In-Wall Touch Screen (C4-TSWMC5) or 7" In-Wall Touch Screen (C4-

TSWMC7) is installed as directed in the Control4 5" and 7" In-Wall Touch Screen Installation 
Guide available on the Control4 Dealer website. 

2. Ensure that your project has a Control4 Controller added and identified in the Control4 system. 
 
To add and configure a 5" or 7" In-Wall Touch Screen: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My 

Drivers tab > User Interface > double-click to add the 5" or 7" driver, C4-TSWMC5-EG or  
C4-TSWMC7-EG, to the project tree. 

4. Click Connections. 
5. In the Connections view, click the Network tab to make the necessary network connection. 

 
Note: If this Touch Screen will be providing audio output, the Touch Screen needs 
to be identified as an Audio end point for the room. 
 

6. Select the IE 5" Touch Screen or IE 7" Touch Screen object, and click the Identify button. 
7. In Identify mode, notice the Touch Screen button highlighted in the Composer pane, go to the 

physical 5" or 7" In-Wall Touch Screen, and press the button indicated in Composer to identify the 
Touch Screen to the Control4 system. 

8. When the address appears on the Composer screen, click Close. 
9. (Optional) To configure the properties, click System Design. 
10. In the project tree, select the IE 5" Touch Screen or IE 7" Touch Screen object. 
11. View and change the properties in the Properties pane as needed. 

 
Modifiable properties include: 
 
Backlight Level—Use the up or down arrows to set the light level of the backlight. 
You can change the brightness of the backlight with this option by percentage, so 
100% is On at full brightness and 0% is Off. 
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Backlight Preset Level—Lets you set the default backlight level. If you ever restart 
or power the Touch Screen again, this is the backlight level it would go to. Click 
Set to save your changes. 
Button Animation Enabled—Lets you enable animated buttons for a 3D effect. 
Volume Control Follows Selected—Lets you select other rooms aside from the one that 
contains the Touch Screen, and change its volume when leaving the room. 

2.5.8.6.2 Configure Mobile Devices or PCs/Tablets as Navigators 
Use the Control4® MyHome apps to configure an iPod Touch, iPad, iPhone, Android, or PC device 
for use as a Touch Screen in a Control4 system. 
 
Prerequisites 
Ensure that the license and correct apps are installed as indicated in the Control4 MyHome Setup 
Guide for Dealers or Control4 MyHome Setup Guide for homeowners. These documents are located 
on the Control4 website. 
 
Follow the instructions in the documents mentioned previously to set up the apps for these devices. 
You don't need to do anything in Composer Pro. 

2.5.9 Configuring Contacts and Relays 
Use the Control4® Composer Pro System Design and Connections views to add and configure 
contacts and relays. 

  
These sections provide information about specific contacts and relays. 
 
“Configure a Gas Fireplace Relay” 
“Configure a Wireless Fireplace Switch” 
“Configure Pulse Single Relay Support” 
“Configure Single Contact Relay Support” 

2.5.9.1 Configure a Gas Fireplace Relay 
Use the Control4® Composer Pro System Design and Connections views to configure a Gas Fireplace 
Relay. 
 
Prerequisites 
Ensure that the Wireless Fireplace Switch is installed as directed in the Control4 Wireless Fireplace 
Switch Installation Guide available on the Control4 Dealer website. The Gas Fireplace Relay installs 
with the Wireless Fireplace Switch. 
 
To add and configure a Gas Fireplace Relay: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the gas fireplace resides. In the Items pane > My 

Drivers tab > Motorization > double-click Gas Fireplace to add the relay object to the project tree. 
4. Click Connections. 
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5. In the Connections view, click the Control/AV tab to make the necessary connection to the Relay 
Output Device. 
a. Select the Gas Fireplace object in the Gas Fireplace pane under Control & Audio Video 

Connections. 
b. Drag the Relay to the device you choose in the Relay Output Devices pane, for example, 

Home Controller HC300. 
  

 
  

6. (Optional) To configure the properties, click System Design. 
7. In the project tree, select the Gas Fireplace object. 
8. View and change the properties in the Properties pane. 

  
Modifiable properties include: 
  
Invert Relay: Normally, the relay is open when the switch is off. If you check this option, the 
switch's off position closes the relay. 
  
Radio Buttons: 

Toggle Type. Select if the fireplace needs two (2) wires always touching to stay on. 

Pulse Type. Select if two (2) fireplace wires only need to touch momentarily to turn the 
fireplace on or off. 

  
Pulse length is x milliseconds. Add the desired value here. 

2.5.9.2 Configure a Wireless Fireplace Switch 
Use the Control4® Composer Pro System Design and Connections views to configure a Wireless 
Fireplace Switch. 
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Prerequisites 
Ensure that the Wireless Fireplace Switch is installed as directed in the Control4 Wireless Fireplace 
Switch Installation Guide available on the Control4 Dealer website. The Gas Fireplace Relay installs 
with the Wireless Fireplace Switch. 
 
To add and configure a Wireless Fireplace Switch: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the project tree, select the room where the gas fireplace resides. In the Items pane > My 

Drivers tab > Motorization > double-click Fireplace Switch to add the relay object to the project 
tree. 

4. Click Connections. 
5. In the Connections view, click the Control/AV tab to make the necessary connections to the 

Output Device. 
a. Select the Fireplace Switch object in the Fireplace Switch pane under Control & Audio Video 

Connections. 
b. Drag the desired Button Links to the device you choose in the bottom pane, for example, 

Home Controller HC300. 
  

 
  

6. (Optional) To configure the properties, click System Design. 
7. In the project tree, select the Fireplace Switch object. 
8. View and change the properties in the Properties pane. 

  
Modifiable properties include: 
Properties: 

Invert Relay—If checked, the relay that appears as normally open becomes a closed circuit. 
The default is open. 
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Advanced Properties: 
LED  

Top Color 

o On. The LED color for the Top LED when the LED state is On.  
o Off. The LED color for the Top LED when the LED state is Off. 

Bottom Color 

o On. The LED color for the Top LED when the LED state is On.  
o Off. The LED color for the Top LED when the LED state is Off. 

Options 

Top LED Link—Select to enable. If checked, swap on and off the state and color on the 
top LED. 

Bottom LED Link—Select to enable. If checked, swap the on and off state and color on 
the bottom LED. 

Buttons Attached—Select to enable. If checked, pressing the buttons on the Switch 
directly controls the connected load. 

LED Attached—If checked, the LED state is controlled by the button presses. If 
unchecked, the LED state and colors can be controlled by custom programming. 

Hold Ramp Rate (Seconds) 

Up—The rate in seconds when the load increases when the top button is held down. 

Down—The rate in seconds when the load decreases if the bottom button is held down. 

Network—The network information is added automatically (Channel, Gateway, MAC, and 
Version). 

2.5.9.3 Configure Pulse Single Relay Support 
Use the Control4® Composer Pro System Design view to check and change relay properties. 
  
When using a Pulse Type Relay in your project, you can add a single relay device, and then choose 
to configure it as a “Pulse Type” relay rather than having to program anything to provide the pulse 
functionality. This option is in the System Design Properties pane when you select a relay. 
 
To view relay properties: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Select the relay object from the project tree. View its properties in the Properties pane. 

  
Modifiable properties include: 
  
Invert Relay: Normally, the relay is open when the switch is off. If you check this option, the 
switch's off position closes the relay. 
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Radio Buttons: 
• Toggle Type. Select if the device needs two (2) wires always touching to stay on. 
• Pulse Type. Select if two (2) wires only need to touch momentarily to turn the device on 

or off. 
  

Pulse length is x milliseconds. Add the value here. 
  

4. To use this option, select the Pulse Type radio button, and select the Pulse Length is x 
milliseconds for the relay pulse (the default is 500 milliseconds). 

  

 
 

2.5.9.4 Configure Single Contact Relay Support 
Use the Control4® Composer Pro System Design view to check and change Single Contact Trigger 
support for contacts. 
  
When using a contact in your project, the physical change of the contact’s state might not always 
result in a single open-to-close or close-to-open state change, but rather bounce between states 
multiple times before the final state is reached. 
  
To eliminate false notification of the contact state to the Control4 system, you can configure a 
'Debounce Timer' to allow the system to see only a single state change. 
  
In the System Design view, you can set this option in the Properties pane when you select a contact. 
 
To set this option: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Select the contact object from the project tree. View its properties in the Properties pane. 
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Modifiable properties include: 
  
Invert Sensor: Depending on the sensor type, the Controller sends a small amount of voltage 
through the sensor to close it, if for example when a door is closed with feedback indicating such. 
You use Invert Sensor if you want to feedback to be the opposite. 
  
Enable Debounce Timer: Sets an amount of time that lapses before the sensor triggers to on. 
  
Debounce Time(ms): The amount of time in milliseconds before the sensor state changes to on. 

  
4. Check the Enable Debounce Timer box. 
5. In the Debounce Time(ms) (in milliseconds) drop-down menu, select to delay notification of the 

contact state (the default is 100 milliseconds). 
  

 
 

2.5.10 Configuring HVAC Systems 
Use the Control4® Composer Pro System Design and Connections views to configure a Control4 
Wireless Thermostat. Control4 also supports multiple third-party thermostat models. 
  
Note: Previous releases of Composer Pro documentation included instructions about how to configure 
third-party products and older versions of the Wireless Thermostat. Starting with OS 2.0, third-party 
device configurations are no longer included in the documentation, although they are still supported in 
the drivers list (for example, EnviraZone and Aprilaire RS232). Refer to previous releases of the 
Composer Pro User Guide for information about these third-party drivers and examples of older 
Thermostat models. 
 
These sections provide information about the Wireless Thermostat. 
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“Setting Up a Wireless Thermostat” 
“Programming the Control4 Thermostat Schedule” 
“Using the Wireless Thermostat Advanced Properties” 

2.5.10.1 Setting Up a Wireless Thermostat 
Use the Control4® Composer Pro System Design and Connections views to set up a Control4 
Wireless Thermostat. 
 
Prerequisites 
1. Ensure that your project has a Control4 Controller added to the project tree and is identified on 

the Control4 system. 
2. Ensure that the Thermostat is installed at the wall as directed in the Control4 Wireless Thermostat 

Installation Guide available on the Control4 Dealer website. 
3. Ensure that the Control4 Wireless Thermostat is added to the project tree. 
 
To configure a Wireless Thermostat for the Control4 system: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Verify that the Wireless Thermostat is in the project tree. 
4. To identify the device, click Connections. 
5. Click the Network tab. 
6. Make the network connection. To do this, select the Control4 Wireless Thermostat object in the 

IP Network Connections pane, and click Identify. 
  

 
  

7. In Identify mode, go to the physical Control4 Thermostat, and press the center button four (4) 
times. This identifies the Thermostat's network address to the Controller, and identifies the device 
to the Control4 system. The device’s address appears in the following dialog and in the IP 
Network Connections pane. 
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8. Click Close to exit the wizard. 
• To program the schedule, see “Programming the Control4 Thermostat Schedule.” 
• To set up advanced properties, see “Using the Wireless Thermostat Advanced Properties.” 

2.5.10.2 Programming the Control4 Thermostat Schedule 
Use the Control4® Composer Pro System Design view to set a heating and cooling schedule for your 
Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and later). The Control4 
Wireless Thermostat works with your heating and cooling system to maintain a consistent 
temperature called a ‘set point.’ Using the Control4 Wireless Thermostat, you can specify separate 
heating and cooling set points. 
  
Tip: New in OS 2.0 and later, you can set the heating and cooling schedule from a Touch Screen or 
On-Screen Navigator. See the Control4 System User Guide for details. 
  
The Control4 Wireless Thermostat automatically engages the appropriate heating or cooling system 
until the room reaches the desired temperature. In Composer Pro, you can set up a Heat Point and a 
Cool point for six (6) possible Program Events in a day time period. 
  
Program Events include: 

• Awake—Sets the wakeup time and related Heat/Cool Points. 
• Leave—Sets the away time and related Heat/Cool Points. 
• Return—Sets for return time and related Heat/Cool Points. 
• Sleep—Sets for sleep time and related Heat/Cool Points. 
• Custom 1—Sets a specified time and related Heat/Cool Points. 
• Custom 2—Sets a specified time and related Heat/Cool Points. 

  
You can enable these Program Events for weekdays, weekends, or individual days to match activity in 
the home. 
 
Prerequisites 
Ensure that the Thermostat is installed as directed in the Control4 Wireless Thermostat Installation 
Guide available on the Control4 Dealer website. 

http://www.control4.com/documentation/System_User_Guide/�
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To program the Wireless Thermostat Schedule: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the System Design view, select the Control4 Wireless Thermostat object. 
4. The Properties appear in the center pane. Fahrenheit is selected by default; select Celsius as 

needed. 
5. In the Properties tab, select View/Edit Schedule. The Schedule dialog appears with the currently 

programmed schedule for Monday through Sunday. 
  

Note: You can schedule the Thermostat either in Composer Pro or in the Control4 Touch 
Screens, MyHome apps, or On-Screen Navigators. See the Control4 Wireless Thermostat User 
Guide or the Control4 System User Guide for information about scheduling a Wireless 
Thermostat from a Navigator. 

  

 
  

Tip: To return to the original settings, click the Restore Default button. 
  

6. For each line item: Awake, Leave, Return, Sleep, Custom 1, and Custom 2, use the up and down 
arrows to set the day and temperature Heat and Cool set points. 

 

Notes: (1) You can view the schedule by selecting the 12 Hour Display or the 24 Hour Display. 
(2) The Cool and Heat Points stay two (2) degrees apart. Example: If you set the Heat Point to 
72 degrees, the lowest you can set the Cool Set Point is 74 degrees. This keeps your furnace 
and your air conditioner from competing with each other. 
 

7. When you are finished, click Ok. Your updated schedule displays. You may then set the 
modifiable properties. See “Using the Wireless Thermostat Advanced Properties.” 

2.5.10.3 Using the Wireless Thermostat Advanced Properties 
Use the Control4® Composer Pro System Design view to view and change the Wireless Thermostat 
properties. Set the Properties to create a schedule and the Advanced Properties to modify the 
Thermostat’s configuration. 
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Prerequisites 
Ensure that the Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and 
later) is installed as directed in the Control4 Wireless Thermostat Installation Guide available on the 
Control4 Dealer website. 
 
To use the Thermostat Advanced Properties: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. Select the Control4 Wireless Thermostat in the project tree. 
4. Click the Properties tab to view the list below. 

  
Note: Different properties may appear, depending on the Thermostat model. The properties 
below apply to the Control4 Wireless Thermostat for OS 2.1. 

  

 
  

Modifiable Advanced Properties include: 
  
Properties 

Fahrenheit or Celsius—Sets the temperature display in Fahrenheit or Celsius. 

View/Edit Schedule—Brings up the schedule page to set heat and cool set points for auto 
mode (see below). In the mode (Awake, Leave, Return, etc.), set the day and temperature set 
points. Click OK to close the window. Note: You can view the schedule by selecting the 12 
Hour Display or the 24 Hour Display.  
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Vacation—Lets you set the Heat Set Point and Cool Set Point when the homeowner is on 
vacation. Use the up or down arrows to set the heat and cool set points, and then click OK. 

 

 
 

Use Remote Temperature Sensor—Sets the Thermostat to use either the on-board Local 
temperature sensor (default) or an optional Remote temperature sensor to control the HVAC 
system by selecting the Use Remote Temperature Sensor radio button. 

Buttons— Locks local buttons to prevent unwanted changes to Thermostat settings. Select the 
Locked and Unlocked radio buttons. Note: If buttons are disabled, they will be re-enabled 
when the Thermostat power cycles. This is a safety mechanism to prevent a Thermostat from 
becoming completely inoperable if it were removed from a project while the buttons were 
disabled. 

  
Advanced Properties 

General Setup 

Backlight Mode—Lets you select your preferences for the backlight. Select On Button 
Press to light the backlight for ten (10) seconds when any button is pressed. Select 
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Always On to keep the backlight on constantly. When using batteries for power with power 
stealing enabled, the Always On option is not recommended. 

Battery—Shows the power source or battery level; e.g., "Externally Powered." 

Time Format (Date and Time)—Lets you set preferences regarding Date Format 
(MM/DD/YYYY or DD/MM/YYY) and Time Format (12 h or 24 h). Click the Sync Time 
button under Time Format to update the time on your Thermostat manually to the 
Controller. (The Thermostat also updates automatically at 3:00 AM each morning.)  

Network—Displays informational boxes that provide ZigBee networking information (MAC 
and Firmware Version). 

Select Apply to... to apply the current properties to the selected Wireless Thermostats. 

 
Advanced Device Configuration 
Control4 has enhanced the available Thermostat settings to allow users and installers to modify 
engage and cutoff temperature deltas as well as maximum and minimum run time, off, and delay 
times so that the Thermostat can be configured to run optimally with any HVAC system.  
 
Note: Allowing such fine tuning of all settings can result in setting improper values and 
combination of values to cause the HVAC system to run less than optimal. To prevent thrashing 
the cool and heating engage (constant heat, then cool, engagement), cutoff and set points are 
enforced to have at least a one (1) degree difference for engage temperatures.  
 
The formula for the dependency of these values is: 
 
Heat/cool engage delta—Opposite stage (if heat engage, then cool cutoff and visa versa) cutoff 
delta + set points delta (cool set point – heat set point) >=1  

 
The screen below shows the Advanced Device Configuration properties. 
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Temperature Calibration—Use the up or down arrows to set x degree(s), and then click 
Set Calibration. This lets you fine tune the current temperature reported by the Thermostat 
by +/- 5 degrees. Example: If your Thermostat reads 72 degrees Fahrenheit, and you 
determine that the current temperature should be 70 degrees Fahrenheit, press the down 
button two times to lower the Thermostat’s reading to 70 degrees Fahrenheit. Click Set 
Calibration.   

Note: No changes to calibration should be made within 20 minutes of powering on the 
Thermostat. The Thermostat generates a small amount of heat which affects the 
calibration. After 20 minutes of continuous operation, this will stabilize allowing proper 
calibration. 

Heating Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, 
and then click Set Heat Cutoff. This sets how far over the setpoint you want the heating 
system to remain engaged before shutting off. Example: If the heat set point is set to 68 
degrees Fahrenheit and the cutoff point is set to 2 degrees Fahrenheit, the heating system 
will engage until reaching 70 degrees. 

Cooling Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, 
and then click Set Cool Cutoff. This sets how far under the setpoint you want the cooling 
system to remain engaged before shutting off. Example: If the cool setpoint is set to 68 
degrees Fahrenheit and the cutoff point is set to 2 degrees Fahrenheit, the cooling system 
will engage until reaching 66 degrees.  

Stage Minimum Off Time (Minutes)—Use the up or down arrows to set the minimum off 
time in minutes. Note: This setting takes effect as soon as the Advanced Device 
Configuration box is closed.  

This is the minimum amount of time that the heating or cooling will remain off before 
initiating again. Example: If while cooling, the temperature does not reach the designated 
cutoff point before the maximum run time is reached, the cooling system will shut off and 
not initiate cooling again until the Minimum Off Time is reached. Note: Some HVAC 
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systems automatically enforce a Minimum Off Time. In this case, the heating or cooling will 
remain off for the higher of the two settings (Thermostat or HVAC system). 

 
Stage Configuration (Heat Stage 1, 2; Cool Stage 1, 2; Auxiliary; Emergency) 
The stage configuration boxes allows for setting the engage delta, minimum run time and 
maximum run time for each stage.  

 
Note: These settings take effect as soon as the Advanced Device Configuration box is 
closed. 

Delta (degrees)—Use the up or down arrows to set the stage engage temperature delta. 
This sets how many degrees the current temperature will reach beyond the setpoint before 
the stage engages.  

Example:  

For heat, if the heat setpoint is 70 degrees Fahrenheit and the engage delta is 2 degrees 
Fahrenheit, the heat stage will engage when temperature reaches 68 degrees.  

Note: For multi-stage systems, the deltas for the first and second stages are cumulative. If 
the first stage delta is set at 2 degrees Fahrenheit and the second stage delta is set at 2 
degrees Fahrenheit, the second stage will not engage until the current temperature has 
passed the stage setpoint by 4 degrees Fahrenheit. However, the Auxiliary Heat and 
Emergency Heat deltas are NOT cumulative. 

Minimum Run Time—Use the up or down arrows to set the stage x minimum run time in 
minutes. . The minimum run time is one (1) minute. This sets the minimum time the heating 
and cooling will run before shutting off.  Example: If while cooling or heating, the 
temperature reaches the designated Cutoff Point before the Minimum Run Time is 
reached, the system will not shut off until the Minimum Run Time is reached. Also, if heat or 
cool is engaged and shut off manually, the system will not shut off until the Minimum Run 
Time is reached. Note: Some HVAC systems have built-in Minimum Run Times that may 
be greater than that set on the Thermostat. 

Maximum Run Time—Use the up or down arrows to set the Heat Stage x maximum run 
time in minutes.  The maximum run time is 255 minutes. This sets the maximum time the 
heating or cooling will run before turning off. Example: If heating or cooling is engaged, but 
does not reach the Cutoff Point before the Maximum Run Time is reached, the cooling 
system will turn off. Note: The Maximum and Minimum Run Times are not per stage, but for 
cooling and heating run times regardless of first or second stage transitions.  

Auxiliary Stage 
The Auxiliary and Emergency Heat stages are specifically for heat pump systems. The switches 
on the back of the Thermostat allow the Thermostat to operate a heat pump system.  

 

Note: These settings take effect as soon as the Advanced Device Configuration box is closed. 
 

Stage Delay (Minutes)—Use the up or down arrows to set the stage delay for x minutes. 
This sets the allotted time the main heat pump system will run without reaching the desired 
heat setpoint goal before the Auxiliary stage engages. Note: If set to the maximum time 
allowed, the auxiliary system will be disabled and never engage.  

Stage Cutoff Delay (seconds)—Use the up or down arrows to set the stage cutoff delay 
in seconds. This sets how much of a delay before the main heat pump cuts off, leaving the 
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Auxiliary heating stage to run on its own. Note: If set to the maximum time allowed, the 
main heat pump stage and the Auxiliary heat stage will run together indefinitely.  

 
IMPORTANT! 
Starting with OS 2.0, the new Thermostat driver and firmware use a different temperature scale. 
Due to this, existing programming which evaluates temperature values will not work correctly and 
must be deleted and re-done. Also, any Thermostat variables used for the Email Notification 
Agent must be changed to use the new V1 variables for the temperatures to be displayed 
correctly. 

 

2.5.11 Configuring an IP Camera or Web Image 
Use the Control4® Composer Pro System Design and Connections views to configure this device. 
Internet Protocol (IP) Security Cameras, including on-screen controls in Navigators, such as Pan, Tilt, 
Zoom, and preset settings are supported along with HTTP control and JPEG or MJPEG images. 
 
Prerequisites 
1. Ensure that your project has a Control4 Controller added to the project tree and is identified on 

the Control4 system. 
2. Ensure that the IP Security Camera is installed at the wall as directed in the manufacturer's 

installation guide. 
 
To add and configure an IP Security Camera or Web JPEG image: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the System Design view, click the My Drivers tab > IP Cameras and locate the IP Camera 

model. 
4. Double-click the IP Camera model to add its driver to the project tree. 
5. In the Properties pane, do the following: 

• For an IP Security camera, configure the IP Address, port, and authentication information (if 
applicable).  

• For Web JPEG Image only, enter the URL and authentication user name and password (if a 
secure HTTP address), select the refresh rate in minutes, and tests. 

• Click Test HTTP Connection to test it. 

2.5.12 Configuring Black & Decker Locks 
Use the Control4® Composer Pro System Design view to add and configure Black & Decker Kwikset® 
SmartCode® with Home ConnectTM Technology ZigBee Deadbolt locks. In general, these instructions 
can be used to add and configure lock drivers for other lock products compatible with Control4 
systems. 
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Prerequisites 
Ensure that the Black & Decker locks are installed as directed in the Black & Decker Installation 
instructions shipped with the product. 
 
To add and configure Black & Decker locks: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In the System Design view on the project tree, select the rooms where the Black & Decker locks 

are installed. In the Items pane, click the Search tab and search for Black and Decker in the 
Manufacturer box. 

4. Double-click Black and Decker SmartLock RF ZigBee to add the object to the project tree.  
Tip: If you are adding several locks in a home, it might be useful to give each lock a unique name. 

5. For each lock you add to the project, add a Relay to the project tree also. See “Configuring 
Contacts and Relays.” 

6. To identify the device, click the Connections view and Network tab. Select the Black and 
Decker ZigBee Lock object, and click the Identify button. When prompted, press the Join 
Network button four (4) times. For more information, see the table in “Example: Verify the 
Network Connections.” 

  

 
  

7. Click the Connections view. 
8. In the Connections view, use the Control & Audio Video Connections tab to make the 

necessary control connection.  
9. Under Control Outputs, select the Lock State and drag it down to the Relay in the RELAY Input 

Devices pane. 
10. (Optional) For additional Black and Decker ZigBee Lock setup, configure the Properties.  

a. In the System Design view project tree, select the Black and Decker ZigBee Lock object.  
b. Modify the properties in the Properties pane, and then click Set (if applicable). 

Debug Mode: Use the drop-down menu to select logging and printing. 

Lock Sleep Timer:  Use the drop-down menu to select how long the lock is in sleep mode 
(in seconds). 

Last Status. Last change made in Debug Mode. 

Instructions. See the Documentation tab. 

Name, Code x: Enter the lock name and code here. You can enter up to 32 code entries. 
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c. Click the Documentation tab for additional information about setting the properties, user 
codes, and actions for the locks.  

 
Properties  
 

Debug Mode. Set to On or Off if using to debug a problem. 

Lock Sleep Timer. The default is 7 seconds. Set to the amount of time the lock sleeps before 
sending out a request for lock status. 

# of Log Items. Use the up or down arrows to set the number of items to log. 

Last Status. Indicates the last action on the lock. 

Firmware Version. Indicates the ZigBee firmware version for the lock. 

Instructions. Details about how to set the user codes.  

Name, Code 1. Set up the user codes here. Type the user's name, then a comma (,), and then 
add the numeric code (4 to 8 characters allowed). Example: Bob, 12345. Up to 30 codes can 
be entered. Tip: The codes can be entered also on the Touch Screen or On-Screen Navigator 
if you download the Black & Decker application from 4Store. 

Documentation. Describes how to use the locks and events. 
 
Actions 

Get Battery Status. Click to show the status of the battery on the lock. 

Show User Codes. Click to show all of the user codes assigned to this lock. The user codes 
appear in the Properties tab. 

Hide User Codes. Click to hide all user codes assigned to this lock. The user codes appear as 
x's in the Properties tab. 

Delete All Codes. Click to delete all user codes assigned to this lock. 

  
Note: You can set the user codes either from Composer Pro, or from the Touch Screen or On-
Screen Navigator in My Apps (downloaded from 4Store). The priority for setting user codes and 
Actions is whoever set the codes or actions last, whether it was in Composer Pro or on a Touch 
Screen or On-Screen Navigator, will be the valid codes or actions used. See the Black & Decker 
Kwikset® SmartCode® with HomeConnect™ Locks User Guide on the Control4 website for 
details. 

2.6 Configuring SNMP 

2.6.1 Installing the SNMP MIBs 
The following SNMP MIBs are required to use SNMP to manage a Control4 network remotely: 
 

• Control4 MIBs. CONTROL4-DIRECTOR-MIB, CONTROL4-GLOBAL-REG, and 
CONTROL4-TEST MIB. These MIBs are installed by default when you install Composer 2.2. 
They appear in Program>Files>Control4>Composer 2.2>SNMP>MIBs/ on the computer 
where Composer resides. 
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• SNMP MIBs. Make sure the NMS console you use has the following SNMP MIBs: SNMPV2-
SMI, SNMPV2-TC, SNMPV2-CONF, and INET-ADDRESS-MIB. The Control4 MIBs 
reference these MIBs. 

These sections provide information about how to set up and use the SNMP Configuration Agent. 
Refer to this document and Composer Pro User Guide, Part 2 for details. 
 
“Programming with Agents” 
“Example: Program Using the SNMP Configuration Agent” 
“Configuring the SNMP Configuration Agent” 
“SNMP Configuration Agent Properties” 
“SNMP Configuration Agent System Variables” 
“SNMP Configuration Agent User Variables” 

2.6.2 Configuring the SNMP Configuration Agent 
Use the Control4® Composer Pro Agents view to use and manage SNMP devices, including; adding 
trap targets; setting up route information; enabling SNMP; configuring SNMP settings; setting up 
SNMP system and user variables, and more. 
 
You can change the SNMP Configuration Agent settings either using Director or Virtual Director. 
Note: If you use Virtual Director, even though you click Apply to save your changes, they will not take 
effect until the project displays and the SNMP-enabled devices are online. 
 
Note: If you use SSH and VI at the command line to edit a configuration file, and later change any 
settings in the Agents view, your changes in Composer will overwrite those made at the command 
line. 
 
Prerequisites 
To use SNMP in a Control4 system, you need: 
 
1. An NMS console or an installed MIB browser and the three (3) Control4 MIBs (installed by default 

with Composer 2.2): CONTROL4-DIRECTOR-MIB, CONTROL4-GLOBAL-REG, and 
CONTROL4-TEST-MIB. These MIBs are located in Program>Files>Control4>Composer 
2.2>SNMP>MIBs/ on the computer where Composer resides. 

2. SNMP MIBs. Make sure the NMS console you use has the following SNMP MIBs: SNMPV2-SMI, 
SNMPV2-TC, SNMPV2-CONF, and INET-ADDRESS-MIB (Dave to provide links). The Control4 
MIBs reference these MIBs. 

3. SNMP Configuration Agent. To configure SNMP in a Control4 system you must add the SNMP 
Configuration Agent in the Composer Pro Agents view. See Example: Program Using the SNMP 
Configuration Agent to add the agent. 

 
Procedure 
1. Start Composer and connect to a Director. 
2. Click Agents. 
3. In Agents, select the SNMP Configuration Agent, or add it if it's not already in the list. 
4. When you are finished with your changes, click Apply at the top of the page. 
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To configure SNMP settings in the Properties pane: 
 
1. In the SNMP Configuration pane, click Properties. 
2. If they are SNMP-enabled, all of your Controllers, IO Extenders, and Touch Screens in the project 

will appear in the Managed SNMP Devices pane. If you've updated the system to OS 2.2, those 
devices appear automatically. 

3. Use the Properties pane to disable SNMP from the project, add traps, set community strings, and 
change contact information. 
• SNMP Enabled. By default SNMP is enabled if Controllers, IO Extenders, and Touch 

Screens have been updated to OS 2.2. Uncheck to disable a selected device. 
• Trap Targets. Use to add the IP address for the NMS console or MIB browser to send traps 

to. See "To add trap targets" below. 
• Community Strings. The default is Read: Public, Write: Private. Use the MIB browser and 

this Properties tab to change these settings for Get and Set commands. The strings must 
match in the MIB browser and in this page. Example: Read: Public must be the same in the 
MIB and in the Properties tab. 

• Contact Information.  
• sysContact. Check Use Project Primary Contact to populate this text box with information 

from the Info tab in the System Design view, or uncheck and type a contact name here. 
• sysLocation. Check Use Project System Owner Address to populate this text box with 

information from the Info tab in the System Design view, or uncheck and type the owner's 
address and city here. 

• sysName. Check Use Room to populate this text box with information from the room name 
that the device is in (appears automatically), or uncheck and type another value, for example, 
a hotel room number. 

 
To add one or more devices:  
 
Add devices that you want to manage using SNMP in the Properties pane. 
 
1. In the Managed SNMP Devices pane, click Add or right click and select Add Device. 
2. In Add Device, select the device to add. To add several devices use CTRL or SHIFT and select 

the devices. 
3. Click OK. The device(s) appear in the Managed SNMP Devices pane. 
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Note: If you select multiple devices and their properties are different, a red warning message 
appears, and Composer attempts to notify you of the conflict. 
 
Tip: You can configure one device and then copy it to other devices to save the properties you've 
defined. See the next steps for details. 

 
To copy a device: 
 
Copy a device to other devices if you want to use the device's properties. 
 
Note: You cannot copy a device to another device that's already been identified in Composer. 
 
1. In the Managed SNMP Devices pane, click Copy or right click and select Copy Device. 
2. In Target Device, select the device to copy. 
3. Click OK. The device appears in the Managed SNMP Devices pane. 
4. In the Managed SNMP Devices pane, select the devices to copy to. 
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To delete a device: 

 
Remove a device from the managed list in the Properties pane. 

 
1. In the Managed SNMP Devices pane, click Delete or right click and select Delete Device. 
2. In Target Device, select the device to delete. To delete several devices use CTRL or SHIFT and 

select the devices. 
3. Click OK. The device(s) disappear from the Managed SNMP Devices pane. 

 
Notes: (1) Deleting a device removes it from the list, but the properties are saved. 
(2) You can add the device back into the project with the last saved SNMP settings. 
 

To add trap targets: 
 
Add the IP address or host name of the NMS console to send trap targets to in the Properties pane. 

 
1. In the Managed SNMP Devices pane, select the device to manage. 
2. In the Trap Targets pane, click Add. 
3. In Add Trap Target, type the following:  

• Target. IP address of the console that will receive the traps. 
• Community. (Optional) Information will be taken from the Community Strings boxes. 
• Port. (Optional) The default is 162. 

4. Click OK. The information will be added to the Trap Targets pane. 
 

 
 
Tip: If you click the System Variables tab, and check SNMP Trap Enabled, the traps will be 
enabled for the selected variable. 
 
Note: You may have conflicts if the Trap Enabled values in System Variables are different (some 
True, some False). 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  109 of  199 

 

 

 
To change the 'Trap Enabled' system variables in the System Variables pane: 
 
Change the 'Trap Enabled' status in the System Variables pane when you want traps sent to the NMS 
console you set up (see the previous steps) for the selected variable(s) agents or in programming. 
Example: You can set a 'Trap Enabled' status to 'True' for the CURRENT_SELECTED_DEVICE 
variable in Room 100. 
 
1. In SNMP Configuration, click the System Variables tab. 
2. Select the Variables to change. Select all that apply. 
3. Check or uncheck SNMP Trap Enabled or right click and select Enable Trap or Disable Trap in 

System Variables. The 'Trap Enabled' column changes from 'False' to 'True' or vice versa for 
those selections. 
 

 
 

To change the 'Trap Enabled' user variables in the User Variables pane: 
 
Change the 'Trap Enabled' status in the User Variables pane when you want traps sent to the NMS 
console you set up (see the previous steps) for the selected variable(s) agents or in programming. 
Example: You can set a 'Trap Enabled' status to 'True' for 'Boolean Var.' 

 
1. In SNMP Configuration, click the User Variables tab. 
2. Select the Variables to change. Select all that apply. 
3. Check or uncheck SNMP Trap Enabled or right click and select Enable Trap or Disable Trap in 

System Variables. The 'Trap Enabled' column changes from False to True or True to False for 
those selections. 
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2.7 Customizing the Navigators 
Use the Control4® system Navigator interface on your Navigator to make adjustments to the Navigator 
you're using. 
  
Tip: You or your customer can customize pages in the Touch Screens, MyHome apps, or On-Screen 
Navigators also. See the Control4 System User Guide for information. 
 
These sections provide information about how to customize Navigators. 
 
“Setting Up the Photo Screen Saver Option” 
“Setting Up Custom Screen Saver” 
“Programming the Screen Saver Sleep Mode or Other” 
“Changing the Time on a Navigator Screen Saver” 
“Hiding Device Availability” 
Viewing Device Availability in Navigators 

2.7.1 Setting Up the Photo Screen Saver Option 
Use the Control4® Composer Pro Agent and Media views to set up a photo Screen Saver agent to 
view photos from the Touch Screens, MyHome apps, or On-Screen Navigators. With OS 2.1, you can 
now use a single photo to display on all of your Navigators. If you change the interval on one 
Navigator, it will change all of them. 
 
Prerequisites 
Have one of the following storage types available before you copy the photos. You will need to set up 
one or more of them later when you add your photos. 
  
Note: In some cases, the Control4 system may take a few minutes to recognize the device. 

http://www.control4.com/documentation/System_User_Guide/�
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• Controller —If the Controller has no storage, add and connect a device that contains storage 
for your photos; for example a USB drive or Network File Share (see Step 6 in the next 
section). 

• USB Drive—Ensure that the USB drive is attached to the Controller. When you insert the 
USB drive, it will appear in the project tree in the same room as the Controller. 

• Network File Share—Ensure that the Network File Share object is added to the project tree 
and connected (see the steps to do this later in this procedure). Ensure that you have access 
to the Network File Share, that you have a valid Username, Password, and Workgroup, and 
that you can identify the network location (you will need to add the path). 

 
To set up the Photo Screen Saver option to display photos on the Navigators: 
1. Start Composer and connect to a Director. 
2. Click Agents. 
3. (First time only.) From the Agents view > Agents pane, click Add to add the agent to the project. 
4. From the Available Agents dialog, choose the Screen Saver agent, and click OK. 

  
Note: If Screen Saver already appears in the Agents pane, it has already been added. Go to the 
next step. If not, see “Example: Program Using the Screen Saver Agent.” 

  
5. In the Agents pane, select Screen Saver. 
6. From the storage location list, use the drop-down menu to choose the location where you will 

save your photos for use on the Navigators (Controller, CBM Flash Disk: USB drive, or Network 
File Storage, etc.). 
 
Notes: 

(1) If the storage option that you want does not appear in the list, disconnect from Director 
and reconnect. 

(2) At any given time, only one storage location can be set as the photo Screen Saver 
source. 

 
• Controller—If you have a Controller with disk space (for example, Home Controller HC-500 

or HC-1000), an option appears in the list (for example, Home Controller HC1000). 
• CBM Flash Disk (USB drive)—If you inserted the USB drive in the Controller earlier, the 

CBM Flash Disk option appears in the list. 
• Network File Storage—If you select Network File Storage, specify where the Control4 

system needs to go to copy the files. Click System Design and select the Network File 
Storage icon in the project tree (you will have to add it from the Items pane). In the 
Properties pane, type the Username, Password, Workgroup and then browse to the network 
location. Click Connect. 

7. Click the Media view, and select Screen Saver. 
8. Click Configure in the Screen Saver pane, set the location to copy the files to (for display in the 

Navigators), and click OK. 
  

Note: If you didn’t choose a storage location in Step 6, an error message appears. Click OK, and 
then click Configure to set the location. 
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9. In the Screen Saver pane, click Add. In the My Pictures dialog, browse to the photos you want to 
copy to the storage location, select them, and click Open. The files will be copied to the storage 
location you specified in Step 8, and a folder may be created for you using the Control4 name 
(Example: Control4 pictures). 

  
Note: When media is added (copied) to the storage device, it is pre-scaled to the resolution for all 
of the Navigators. Control4 preserves the aspect ratio of the original image, and boxes the extra 
space with bars for any given screen size. 
 

 
 

  
10. In Composer Pro, click Tools > Refresh the Navigators to display the copied photos. 
11. To activate the Screen Saver in each Navigator (On-Screen, Touch Screen, or MyHome app), do 

the following: 
a. Go to Info > Config > Screen Saver (on System Remote Controls) or More > Settings > 

Screen Saver. 
b. Enable the Custom option, and then choose the Photo Screen Saver option along with any 

other Screen Saver option you want to include. For photos only, check the Photo option. See 
“Setting Up a Custom Screen Saver” to display the photos on the Navigator or see the 
Control4 System User Guide. 

2.7.2 Setting Up a Custom Screen Saver 
Use the Control4® Navigator to create a custom screen saver to view on Touch Screens, MyHome 
apps, or On-Screen Navigators. 
  
Note: This task must be completed on a Navigator. Either the Installer or homeowner can set this up. 
The Custom Screen Saver option lets users mix and match available screen saver options, including 
the option to use stored photos. 
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Prerequisites 
Before setting up a custom screen saver, photos must be available for viewing from the Navigator. 
See “Setting Up the Photo Screen Saver Option.” 
 
To set up a custom screen saver: 
1. From the main menu on an On-Screen Navigator, MyHome app, or Touch Screen press More > 

Settings > Screen Saver or Info > Config > Screen Saver from a System Remote Control. 
2. In Screen Saver, press the drop-down arrow, and press Custom. 
3. In Turn on, press the drop-down arrow, and press an option to enable the Screen Saver. 
4. Press Settings. 
5. Press to select one or more of the following options: 

• Media 
• Time 
• Date 
• Temp 
• Photo 
• Shuffle 

6. Press Done. 
7. (Optional) Press Preview to test the settings. 
  
To set up a custom screen saver in the Touch Screens, MyHome apps, or On-Screen Navigators for 
OS 2.0 and later, see the Control4 System User Guide for details. 

2.7.3 Programming the Screen Saver Sleep Mode or Other 
Use the Control4® Composer Programming view to schedule a Screen Saver mode change, such as 
a ‘Go To Bed’ mode during sleep hours. 

  
1. In Programming, select Navigator actions. 
2. Create a Scheduled Event (such as ‘Go To Bed’). See “Programming with Agents” in Part 2 of 

this document for details. 
3. Add the following script: 

“Set the screen saver mode on the [graphical navigator device] to Blank.” 
“Turn the screen saver on after [time interval] on the [graphical navigator device].” 

2.7.4 Changing the Time on a Navigator Screen Saver 
Use the Control4® Composer Pro System Design view to change screen saver date, time or time 
zone. 
 
To change the time on a Navigator screen saver: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In System Design, click the Properties tab. 
4. Use the Date & Time drop-down boxes to modify the time and date. 

http://www.control4.com/documentation/System_User_Guide/�
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Date: To change the Date (month, date, or year), click the drop-down arrow for a calendar to 
appear. Click the left or right arrows to select the month, and then select the day. 
Time: To change Time (hour, minute, second), click the up or down arrows to the appropriate 
time in hours, minutes, or seconds. 

  

 
  

Tip: An easy way to change the hour, minute, or second is to highlight the hour, minute, or 
second number, and then type the new number over the old one. 

  
Time zone: To change the Time Zone, at the Timezone box, click Edit. Choose the time zone 
from the drop-down menu, and click OK. 

2.7.5 Hiding Device Availability 
Use the Control4® Composer Pro System Design view to hide a device from view in a Navigator. 

  
Example: Set availability so that the Touch Screen in the Bedroom cannot control music in the 
Theater. 
 
Prerequisites 
Ensure that the following devices are added and identified to the network: 

• Controller  
• Digital Audio 
• Navigator 

 
To hide a device so others cannot see it: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
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3. In System Design and in the project tree, select Bedroom. 
4. Go to the Navigator tab in the Properties tab. 
5. Select Music in the Menu box, and then click Modify. 
6. Select Digital Audio in the Theater, click Hide, and then click OK. 

2.7.6 Viewing Device Availability in Navigators 
Use the Control4® Composer Pro System Design view to change the order of devices to view. This 
task is useful if you have a lot of media devices, and some are used more frequently than others. 
  
Example: Change the order of a Tuner to appear in a Navigator before the Receiver. 
 
Tip: In OS 2.2 and later, you can use Shift+Click or Ctrl+Click to add or remove devices. 
 
Prerequisites 
Ensure that the following devices are added and identified to the network: 

• Controller  
• Digital Audio 
• Navigator 

 
To enable a device to be viewed in a specific order in a Navigator: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. In System Design, select Theater. 
4. Go to the Navigator tab in the Properties tab. 
5. Select Radio under Menu, and then click Modify. 
6. Click Tuner, and then click Move Up. 
7. Click OK. 

2.8 Updating Composer and Director 
Use the Control4® Composer Pro software to update Composer Pro and Director. 

  
IMPORTANT: Before you begin any update, check the Control4 website for any Release Notes or 
upgrade documents associated with the update, especially if it's a major update such as up to 
Release 1.8.2 or OS 2.0. Read those documents first. 
  
Tip: The Release Notes for Release 1.8.2 provides a table of all of the releases that Control4 has 
delivered and their dates. See Composer Pro Software Release Update Instructions – 1.7.4 to 1.8.2 
for details. 
  
Depending on the type of upgrade you need to perform, the following tools and website may need to 
be used. 
 

http://www.control4.com/�
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• Control4 website 
• Update Manager 
• Network Status 
• System Manager 

2.8.1 Control4 Website 
Composer Pro updates (software releases) are available on the Control4 Dealer website at 
http://www.control4.com/dealer/products/software/. You will need a Dealer login and password to 
access this site. 
 
Prerequisites 
Ensure that Release 1.8.2 and Composer Pro 2.0 are installed before you begin a subsequent 
update. See Composer Pro Getting Started for details. If you have an earlier release, see the update 
instructions for that release. You must update first to Release 1.7.4 and then 1.8.2 before updating to 
OS 2.0 and later. 
  
Activate your licenses. See "Purchasing and Setting Up Dealer Licenses" in Composer Pro Getting 
Started or Managing Dealer Accounts on my.control4.com on the Control4 Knowledgebase for details. 
 
To access the software updates: 
1. Log in and go to: http://www.control4.com/dealer/products/software/. 
2. Under Software Updates select the software version to download and install. 

  
The following software releases are available on the Control4 website: 

• Composer 1.2.5 
• Composer 1.3.2 
• Composer 1.6.0 
• Composer 1.7.4 
• Composer 1.8.2 
• Composer 2.0.4 
• Composer 2.0.5 
• Composer 2.0.6 
• Composer 2.1.0 
• Composer 2.1.1 
• Composer 2.2.0 

  
Other software utilities are available for download also at the Dealer software download site. 
  
IMPORTANT: For new installations, it is always a best practice to use the latest version of the 
released software. 

http://www.control4.com/�
http://www.control4.com/dealer/products/software/�
http://www.control4.com/dealer/products/software/�
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2.8.2 Update Manager 
Update Manager in Composer Pro automatically updates Director and all of the IP-connected devices 
that are available in your project (identified and online), allowing you to update all the devices in the 
project configuration also. You can use Update Manager to update from all previous releases. 
  
To support multiple releases, the release (for example, 1.7.x) installs in a Composer Pro directory (for 
example, Composer17x), which differs from previous releases that were installed in the Composer 
Pro directory. You do not need to uninstall previous releases to install a new release, but you must 
install Composer 2.0 or later before you begin the update to the latest release. 
  
The update to OS 2.0 does the following: 

• Converts the Media Database for better Screen Saver resolution. 
• Converts metadata to id3 tags. Note: If your customer is using iTunes or another media 

manager, you may not want to convert the metadata tags. See the OS 2.0 or later Release 
Notes and upgrade instructions for details. 

• Recalibrates to Flash on the Navigators. You will need to refresh your Navigators. Note: If 
you don't want to use Flash on some Navigators, you can choose not to update that device. 
Also, not all Navigators support Flash. See the OS 2.0 or later Release Notes for details. 

• Updates ZigBee firmware. 
• For internationalization, locale changes are reflected in the update. 

 
To access Update Manager: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, click Update Manager. 

2.8.3 Network Tools 
Composer Pro Release 1.7.3 and later use this option. 
 
To access Network Tools: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, click Network Tools. 
3. Network Tools has three (3) tabs (Release 1.8.0 and later). Use these tabs as required by the 

software:  
• IP Network 
• ZigBee Network 
• EmberNet Upgrade 

2.8.4 System Manager 
System Manager provides some of the functionality as in previous releases, but it does not perform 
the update functionality. Use System Manager to add, refresh, connect, or disconnect devices. 
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2.8.5 Updating Firmware 
Sometimes you'll get devices that aren't on the same firmware version. For all devices to be able to 
communicate, they do need to be on the same firmware version.  

2.8.5.1 ZigBee Devices 
ZigBee devices update automatically to the current firmware version when they are installed and 
identified to the system. 

2.8.5.2 IP Devices 
To update IP devices, run Update Manager. You can check the firmware version either in System 
Design > Properties pane (for the device), or in Tools > Network Tools > ZigBee tab for ZigBee 
devices.  

2.8.5.3 Black & Decker Locks 
Note: Ensure you're running a current version of Composer Pro and Director on the system. Without 
the current version, the latest firmware will not be available. 
  
To force a firmware update on the lock: 
1. Remove the batteries from the lock (press a key or two to eliminate any charge in the lock). 
2. Put the batteries back in. 
3. Press the top left button four (4) times. 
4. Press the top right button four (4) times. 
 
The firmware should start updating. If it does not, ensure that your batteries are fresh. If you cannot 
manually start the firmware update, the lock should automatically check in for an update after the first 
check-in of the lock, at 3 AM. 

2.8.6 Guidelines for Updating a Control4 System 
Use these Control4® guidelines to update a Control4 system. 
  
IMPORTANT: Before you begin any update, check the Control4 Dealer website for any Release 
Notes, Read This First, or upgrade documents associated with the update and the release. Read 
those documents first. 
  
Note: The update behavior and steps for various releases differs. Make sure you review any 
documentation associated with the release before you begin your updates. 
 
Follow these important guidelines for updating Composer Pro: 
1. Back Up Your Project. If you have a project in an earlier version of Composer, back it up before 

you update. 
2. Verify the Network Connections. Update Manager requires an active network connection to 

function properly. Ensure that the network connection is up and working prior to performing the 
upgrade. 
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3. Update Errors. If you notice any errors during the update process in the Update Manager’s 
output pane, take note of the error message, and follow instructions provided at “Troubleshooting 
the Upgrade Process.” 

  
IMPORTANT: You cannot have both connection methods identified on the system. Remove the 
network connection to Zigbee and identify it again using the Ethernet connection. 

  
4. Power On. Ensure that the power state of all devices is On. You can verify that all devices are 

online from the Network Tools page. 
5. Know When the Update is Completed. When upgrading the Control4 Controller running 

Director, you are disconnected from Composer Pro and streaming audio stops. 
a. After this occurs, restart Composer and reconnect. 
b. Go to Tools > Update Manager and watch the update process. 
c. Also, go to Tools > Network to ensure that everything is connected. If it is not connected, it 

cannot update that firmware. 
d. After Update Manager indicates that it is completed (you may see a message like “Finished 

site update attempt,” all the IP devices on the system are now updated. This does not include 
ZigBee devices or hybrid devices (containing both IP and Zigbee). 

e. Go to Tools > Network Tools to view the firmware versions to ensure they are updated to 
this release. 

2.8.7 Guidelines for Updating Specific Devices 
• Primary Controller. The Primary Controller holds a new firmware image file, which is 

transferred and reflashed when an Ethernet network connection is present. After the update, 
disconnect the IP identification and identify again using Zigbee. 

• ZigBee Devices. When upgrading a Controller associated with ZigBee devices, such as 
Dimmers, Switches, and Keypads, these are also upgraded. As these devices upgrade, the 
device’s LEDs and the associated lighting loads may flicker. This is normal behavior. 

• ZigBee Pro Devices. Follow the instructions in Composer Pro Software Release Update 
Instructions - 1.7.3 to 1.8.0 for details about ZigBee Pro updates. 

• Home Theater Controller and Speaker Point. During the update, the LEDs flash, indicating 
the upgrade process is in a critical mode. 

  
Note: For OS 2.0 and later, Speaker Point does not support the M4P/AAC format. Use MP3. 

  
WARNING: Do not stop the update or disconnect the network during an update. 

  
• Audio Matrix Switch or Multi Channel Amplifier. If you are updating an Audio Matrix 

Switch or Multi Channel Amplifier that is using a ZigBee connection, you must temporarily 
connect these devices to an Ethernet connection before updating for the firmware update to 
occur. 

2.8.8 Estimating Control4 System Update Times 
Use Control4® Composer Pro to update the Control4 system. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  120 of  199 

 

 

2.8.8.1 Estimating Update Times per Device Type 
The update time is dependent on the size of the Control4 system, the available network bandwidth, 
and the types of devices you are updating. 
  
There are three (3) types of devices: IP devices that communicate solely by TCP/IP, ZigBee, ZigBee 
Pro devices that communicate via ZigBee or ZigBee Pro, and hybrid devices that use both TCP/IP 
and ZigBee for communication. 
  
Depending on the device type, some devices, such as the IP devices update in parallel; other ZigBee 
or hybrid devices are updated sequentially, one after another. Generally, the IP devices are updated 
in parallel immediately after the Primary Controller updates. After that, the ZigBee devices update in 
sequence starting with the System Remote Control, and then followed by the hybrid devices which 
update in sequential order. The System Remote Control is the first ZigBee device to update if it is in 
Wake mode. During or after the update, if the System Remote Control was in Sleep mode, it updates 
immediately after it wakes up. 

  
The following list identifies some typical Control4 devices and update time estimates. 

• IP Devices (updated in parallel immediately after the Primary Controller): 
• Controllers (Home Controllers—20 to 40 minutes 
• 7” Touch Screens—15 to 20 minutes 
• Speaker Point—10 to 15 minutes 

• ZigBee Devices (updated sequentially): 
• System Remote Control—3 to 5 minutes (updated as the first ZigBee device if awake) 
• Dimmer/Keypad/Switches—3 to 5 minutes 
• Thermostat—10 minutes 

• Hybrid Devices (both Zigbee and IP - updated sequentially): 
• Multi Channel Amplifier -16—5 minutes 
• Contact / Relay Extender—5 minutes 
• Audio Matrix Switch—5 minutes 
• Multi Tuner V1 and V2—5 minutes 
• XM Module—5 minutes 
• Dock for iPod—5 minutes 
• Media Player—5 minutes 
• IO Extender—5 minutes 

  
Note: An update from Release 1.7.4 to Release 1.8.2 may take longer. 

  
Example: a total of 

• 20 devices may take 110 minutes or longer 
• 30 devices may take 150 minutes or longer 
• 60 devices may take 300 minutes or longer 

to complete the process. Dimmers and Switches do not need to be updated. 
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You may want to practice on your own Control4 system first before upgrading a customer's home; for 
example, an update to Release 1.8.2 is not trivial. 

2.8.9 Best Practices for Updating a Control4 System 
These sections will help you understand the best practices to follow when performing a Control4® 
update in Composer Pro. If you follow these sections in order until your system updates successfully, 
you may avoid some unnecessary pitfalls. 

2.8.9.1 General Procedure 
To update your system and software: 
1. Back up the current project and media. 
2. Check that you have a good network connection. 
3. Check the currently-installed Composer Pro and Director versions. 
4. Update Composer Pro software and drivers. 
5. Update Control4 products using Update Manager. 
6. If you have problems, see “Troubleshoot the Upgrade Process” or contact Control4 Technical 

Support. 
  
Tip: The update process is highly dependent on valid network configurations and Internet connection 
availability and bandwidth. Please confirm that the devices on your network have a valid connection to 
the Internet. If you are using DHCP, confirm that your DHCP is active and can issue valid IP 
addresses to clients on the network. 
  
IMPORTANT: Do not use a previous release of Composer Pro to modify a 2.0 system. Likewise, do 
not use a 2.0 version of Composer Pro to modify a previous release of the Control4 system. 

2.8.9.2 Back Up the Current Project and Media 
To back up your current project and media: 
1. Back up your current project file from a previous release by using File > Backup As. Give it a 

filename that clearly identifies it as the backup. 
2. (Optional) Back up your media. Copy all directories to your computer's hard drive or other storage 

media from the media storage location on your Control4 Controller at: \\<ip address of Control4 
controller>\media\audio. 

3. Continue to the next section. 

2.8.9.3 Check the Currently-Installed Composer Version 
It is helpful to check the currently-installed Composer Pro version before installing the update to make 
any necessary project adjustments. 
 
To check currently installed Composer Pro version: 
1. In Composer Pro, click Help > About Composer. 
2. From the dialog that appears, write down the Composer Pro and Director versions. 

 
Example: Composer, version 2.2.0.190 and Director version: 2.2.0.190. 
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To ensure that the Control4 system is working properly, the Composer Pro and Director version 
should always be consistent and have the same version number. 
 
Note: You do not need to be on a certain version, however, to update. Update Manager updates 
the Control4 system from all previous releases. The only reason you need to know this 
information is to determine when your project was set up. Control4 always recommends that you 
write down these versions in case this information is needed later. 

3. Continue to the next section. 

2.8.9.4 Update Composer Software and Drivers 
The Composer Pro software download consists of Composer Pro software and new or updated device 
drivers to support Control4 hardware and other third-party products. The following steps outline how 
to launch the software executable and ensure that you have the latest drivers. 
  
Note: The Inspector utility can be used to verify each package after installation. Inspector reads all of 
the md5sums in the /var/lib/dpkg/info directory, and runs a new md5sum against them. Any missing 
files or files where the md5sums have changed are reported in /tmp/Inspection.$timestamp. 
 
To install a released Composer Pro software version: 
The following steps are an example of a software installation. Refer to the Release Notes associated 
with the software release for specific instructions. 
 
1. Download the software package from the Internet at www.control4.com. 
2. Install the current Composer Pro software, for example, Composer Pro 2.2.0. 
3. Follow the on-screen instructions to complete the installation. 
4. During the installation process, click the Continue Anyway button for the installation to proceed. 
5. Continue to the section, "Update Control4 Products Using Update Manager." 

  
(Optional) To ensure the driver database is updated: 
1. From the Driver menu, select Manage Drivers. In the utility, you can see the creation and 

modification dates for all drivers in the local database residing on your computer. 
2. Click Add to search the Online Database, and compare the modified dates to determine if a new 

driver is available. 
3. If a newer driver is available and you want to download it, check the box next to the device model 

number, and click OK to download the newer associated driver. 
  

Tip: When Composer Pro is first installed, the My Drivers tab is pre-populated with a list of drivers. 
The My Drivers tab provides shortcuts to commonly-used drivers. You can add, remove, and re-order 
items to the My Drivers tab as needed. Removing drivers from My Drivers tab only removes the driver 
from the list. It still exists in the Local Database. To get back to the default My Drivers tab list and to 
include newly-added Control4 devices, right-click any device and click Restore Default List. This 
action does not affect the Local Database in any way. Also, right-click the My Drivers tab, select Add 
Driver, and then select all the Control4 devices not currently in the list. 

2.8.9.5 Update Control4 Products Using Update Manager 
Refer to the following sections to guide you through the update process: 

http://www.control4.com/�
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• Update from older releases. See “Information About Older Releases.” 
• Update from Release 1.7.4 to 1.8.2. See “Update from Release 1.7.4 to 1.8.2.” 
• Update from Release 1.8.2 to 2.0. See “Update to Release 1.8” or “Update to Release 2.0.” 
• Refer to the Release Notes in subsequent releases for additional update instructions. 

2.8.10 Update from Release 1.7.4 to 1.8.2 
Use Control4® Composer Pro to update your system from Release 1.7.4 to Release 1.8.2. Detailed 
instructions about how to update from Composer Pro Release 1.7.4 to 1.8.2 are not included in this 
document. For those instructions, refer to the Composer Pro Software Update Instructions - Release 
1.7.4 to 1.8.2 on the Control4 Knowledgebase. The document provides general steps, terms and 
concepts, and what to prepare for prior to performing the update. It then describes the steps for the 
update. 
  
Ensure that Composer Pro and Director are using the same version of 1.7.4, and that all devices are 
identified on the network before starting this update. 

2.8.10.1 What’s New in the Update? 
Release 1.8.x introduces support for ZigBee Pro 1.1. During the update from 1.7.4 to 1.8.2 all ZigBee 
devices will be updated to run on the ZigBee Pro stack which requires a complete replacement of the 
firmware on all devices. This enhancement allows Control4 to operate with other ZigBee Pro-
compliant devices which opens up a whole world of new devices that are compatible with the Control4 
system. 

2.8.10.2 Highlights of the Update 
1. New terms such as ZigBee Access Point (ZAP), ZigBee Pro, MiniApp, and EmberNet are 

introduced and described. 
2. Two (2) stages of upgrade occur for MiniApps (Dimmers, Switches, Keypads, and outlet 

modules): the ZigBee Pro stack is installed, and then all the devices must be joined to the 
network. When updating the MiniApps, special LEDs on the devices indicate their status. 

3. Products not supported with ZigBee Pro at this time: 
• System Remote Control V1 and V2 
• LCD Keypad (use Ethernet) 
• Contact/Relay Extender (use Ethernet) 
• Audio products (Audio Matrix Switch, Multi-Channel Amplifier, and Multi-Tuner). Use 

Ethernet. 
4. The Network Tools screen (formerly Network Status) has a new tab for EmberNet Upgrade. This 

shows all of the devices on the current network that haven’t been updated to ZigBee Pro. 

2.8.11 Update to Release 1.8.2 
Use the Control4® Composer Pro Update Manager to update to Release 1.8.2. 
  
IMPORTANT: To update to Release 1.8.2, the Control4 system first must be updated to Release 
1.7.4. After that, follow the instructions in the Composer Pro Software Release Update Instructions - 
Release 1.7.4 to 1.8.2 on the Control4 Knowledgebase. 

https://support.control4.com/kb/admin/login.php�
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2.8.12 Update to Release 2.0 and Later 
Use the Control4® Composer Pro software to update to OS 2.0. 
  
Note: Before you begin the update, ensure that the Control4 system has been updated first to 
Release 1.7.4 and then to 1.8.2. Also, ensure that you have installed Composer Pro 2.0. 
  
For update instructions, refer to 

• Composer Pro Software Release Update Instructions - Release 1.7.4 to 1.8.2 
• Control4 System Software Release Version 2.0 Release Notes 

  
on the Control4 Dealer website or on the Control4 Knowledgebase. These documents provide 
important terms and concepts that you must understand, and what to prepare for prior to performing 
the update. It then describes the steps to follow to complete the update. 
 
To install updates later than OS 2.0, follow the instructions in “Updating Composer and Director.” 

2.8.13 Updating with a USB Device (USB Stick Creator) 

2.8.13.1 Create an Install on a USB Device 
These steps show you how to create an install to a USB device attached to your computer’s hard 
drive and use the same USB device to install your customer’s system without an Internet connection. 
 
Prerequisites 

• Have a USB device handy, formatted for FAT32 with at least 2GB total available disk space. 
• Only installs for OS 1.7.4, 1.8.2, or 2.1 and later can be created using this procedure. Note: 

This particular creation procedure does not work on OS 2.0.x releases. If you are creating an 
install using an older software version, refer to USB Update Stick User Instructions (200-
00149, Rev. B) to create the install. 

• A valid license on the Controller to be updated. 
 
To copy an install to a USB device: 
1. On your C: drive, open the Control4 Programs folder. 
2. Select the USB Stick Creator program. 
3. Select the version of the install to create: Before 1.8.x, 1.8.x, or 2.x and later (see next figure). 

Tip: You can update an OS 1.7.4 or 1.8.2 system to OS 2.1 or later offline, but you must be 
connected to the Internet to update an OS 2.0 system to OS 2.1 or later. 

 

https://support.control4.com/kb/admin/login.php�
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4. Use the default URL.  
5. Click Update. 
6. Select the Controller model. 
7. Type the MAC address. The version will populate automatically. Tip: You can obtain this address 

from the product packaging, or you can obtain it from the Identify window. 
8. You can add or remove any number of Controllers. Click Get Licensed Versions to add or 

remove them. 
9. Click Next. The installation is copied to the USB device. 
10. Connect to your customer’s system using Composer Pro, and then follow the next section. 

2.8.13.2 Update a System Using the USB Device 
These steps show you how to update your customer’s Control4 system from a USB device. You do 
not have to be connected to the Internet to perform these steps. 
 
Prerequisite 
A USB device with the customer’s license and the appropriate USB Install version on it. 
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To install the software: 
1. Use the USB device with the required install and insert it in the USB port on the Primary 

Controller of the customer’s project. 
2. Start Composer and connect to a Local Director. 
3. In the menu bar, click Tools > Update Manager.  
4. Click Update. A “Detected USB device…” message appears in the message box. 

The Update Manager screen shows the entries that are being updated from the USB device in 
the Update Available column (example: “Yes 2.1.0.108476 -USB”). See the next figure. 

 

 
 
5. When the update completes, click Close. 

2.9 Example Projects 
Refer to the sections below to use Control4® Composer Pro Interviewer or Composer Pro views to 
help you understand how to add and identify devices for a Control4 system. 
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2.9.1 Example Smith Home: Interviewer Method 
The following sample project sections step you through the creation of a Control4® project using 
Interviewer wizard in Composer Pro. Alternatively, you can create a new project using the Composer 
Pro views in Composer Pro. See Composer Pro Getting Started for details. 
 
To use the Interviewer wizard: 
1. Start Composer and connect to a Director. 
2. Click System Design. 
3. From the File menu, select Run Interview. 

  
Refer to the following sections to use the Interviewer wizard: 
“Example: System Specifications” 
“Example: Design and Create the Project” 
“Example: Define Devices in Each Room” 
“Example: Identify the Devices on the Network” 
“Example: Define the Audio/Video Connections” 
“Example: Define the Control Connections” 

2.9.1.1 Example: System Specifications 
Use either the Control4® Composer Pro views or the Interviewer wizard to create a project. 
  
First start by reviewing these system specifications to understand what is in three (3) rooms of the 
home and which Control4 devices are used in each room. The example scenario sets up home 
control for a Theater, a Bedroom, and the Front of the home. Follow the sections in order. 

2.9.1.1.1 Devices by Room 

 
  

This project includes the following rooms and Control4 devices in those rooms: 
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• Theater 
• Controller  
• Theater Dimmer 
• Theater Light Switch  
• Wireless Outlet Switch 
• System Remote Control 
• 6 Button Keypad 
• Receiver 
• Television 
• DVD player or Sony CX 777ES DISC Changer 
• Motorized Screen 
• Door Contact Sensor 

• Bedroom 
• Touch Screen  
• Bedroom Dimmer 
• Gas Fireplace 
• Gas Fireplace Relay 

• Front 
• 3 Button Keypad or 6 Button Keypad 
• Thermostat 
• Electronic Gate 
• Sprinklers, Doorbell 
• Motion Sensor 

2.9.1.1.2 Hardware Connections 
The following tables detail the connections that need to be made for the devices to be automated. 
Refer to these tables as you move through the project creation process. 

  
Table 1. Output to Input 

Connect From Output Device: Connect To Input Device: 
Controller 
Video Out 1 (Video—COMPOSITE) Receiver (INPUT VIDEO 1—Theater) 

Stereo 1(Audio—STEREO) Receiver (INPUT VIDEO 1—Theater) 

Contact Sensor 1 (Control—
CONTACT_SENSOR) Motion Sensor (Contact Sensor—Front) 

Contact Sensor 2 (Control—
CONTACT_SENSOR) Doorbell (Contact Sensor—Front) 

Contact Sensor 3 (Control—
CONTACT_SENSOR) Door Contact Sensor (Contact Sensor—Theater) 

IR Output 1 (Control—IR_OUT) Television (IR Sensor—Theater) 
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Connect From Output Device: Connect To Input Device: 

IR Output 2 (Control—IR_OUT) Receiver (IR Sensor—Theater) 

IR Output 3 (Control—IR_OUT) DVD (IR Sensor—Theater) 

Relay Port 1 (Control—RELAY) Gas Fireplace (Relay—Bedroom) 

Relay Port 2 (Control—RELAY) Sprinklers (Relay—Front) 

Relay Port 3 (Control—RELAY) Motorized Screen (Relay—Theater) 

Relay Port 4 (Control—RELAY) Electronic Gate (Relay—Front) 
Receiver - Tuner — Harman Kardon AVR 230 
Output (Video—COMPOSITE) Television (AV In — Theater) 

Output (Audio—STEREO) Television (AV in —Theater) 
DVD Player — Samsung HD841 
Video Out (Video—COMPOSITE) Receiver (INPUT DVD—Theater) 

Mixed Audio Out (Audio—STEREO) Receiver (INPUT DVD—Theater) 
 

Table 2. Input to Output 

Connect from Input Device: Connect to Output Device: 
Receiver — Harman Kardon AVR 230 
INPUT VIDEO 1(Video—COMPOSITE) Controller (Video Out 1— Theater) 

INPUT DVD (Video—COMPOSITE) DVD (Output—Theater) 

INPUT VIDEO 1(Audio—STEREO) Controller (Stereo 1—Theater) 

INPUT DVD (Audio—STEREO) DVD (Output—Theater) 

IR Sensor (Control—IR_OUT) Controller (IR Output 2—Theater) 
Television — Samsung TX-P1430 
Input Side (Video—COMPOSITE) Receiver (Output—Theater) 

Input Side (Audio—STEREO) Receiver (Output—Theater) 

IR Sensor (Control—IR_OUT) Controller (IR Output 1—Theater) 

Contact Sensor (Control—Contact_Sensor) Television 
DVD Player — Samsung HD841 
IR Sensor (Control—IR_OUT) Controller (IR Output 3—Theater) 
Motorized Screen 
Relay (Control—RELAY) Controller (Relay Port 3—Theater) 
Door Contact Sensor 
Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 3—Theater) 
Gas Fireplace 
Relay (Control—RELAY) Controller (Relay Port 1—Theater) 
Electronic Gate 
Relay (Control—RELAY) Controller (Relay Port 4—Theater) 
Sprinklers 
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Relay (Control—RELAY) Controller (Relay Port 2—Theater) 
Doorbell 
Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 2—Theater) 
Motion Sensor 
Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 1—Theater) 

 
Refer to “Example: Design and Create the Project” to go to the next example steps. 

2.9.1.2 Example: Define Devices in Each Room 
This section discusses using Control4® Interviewer wizard in Composer Pro to define devices in each 
room. 
  
Note: This procedure follows “Example: Design and Create the Project.” If you have not read that 
section, go there first before you review this section. 
  
You are now in the Rooms section of Interviewer. In this section, Interviewer asks you a series of 
questions about each room to find out what devices you want to control there, and it asks questions 
about the selected room before moving to the next room. 
 
To define devices in the Theater: 
1. Check the boxes to indicate the types of devices in this room. 

  
Example: For the Theater room: De-select Multi-Room Audio. Check Controllers, User Interface, 
AV Components, Lighting, Motorization, and Sensors. 

  
2. Click next. 
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3. Add the Controllers that reside in the room. 

  
The Digital Audio and Controller objects appear in the 'Devices in the Room' pane. The Digital 
Audio object represents the audio that exists on the Control4 Controller. Only one (1) Digital 
object added per project, so if you tried to add another Controller, a second Digital Audio object 
would not be added to the project tree. 

  
Note: When you click next and return to this screen, the object no longer appears on the screen. 
However, if you look in Composer Pro project tree, it still appears. 
  
Example: Add the Controller to the Theater. The Digital Audio and Controller objects appear. 

  
4. Click next. 
5. Add the objects for the devices to this room. Double-click a device (or select it and click Add) to 

move the devices from the 'Available Devices' list to the 'Devices in Room' list. 
  

Example: Double-click 6 Button Keypad and System Remote Control to add them to the 
Theater room (If you do not have a 6 Button Keypad, add a 3 Button Keypad). 
  
Note: If you have access to a Wireless Touch Screen, add it to your project now. 

  
6. Click next. 
7. Add all AV component devices in this room. For example, if a DVD player, a receiver, and a 

television are in this room, add them as described in the following sub-steps. 
  

Tip: To add AV components, double-click the device; from the dialog that appears, choose a 
manufacturer (from the drop-down list), and double-click the model. 

  
a. Add DVD to the 'Devices in Room' list from the Online Database. 

  
Example: Add the DVD Player, choose Online Database, choose the manufacturer 
Samsung, and then double-click the model DVD-HD841 [IR] model from the Online Database. 
If you can access the Sony CX 777ES Disc Changer, add this instead. Instructions about how 
to scan this bi-directional Disc Changer is described later in this section.  

  

Double-click to add a DVD to the project. On the dialog that appears, click the Online Database 
radio button, then use the scroll-down menu in Manufacturer to select Samsung.  

  

Double-click to add the model to the Devices in the Room list. 
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b. Add the Receiver to the Devices in Room list using the Online Database. 
  

Example: Add the Receiver, select the Online Database, choose the manufacturer Harmon 
Kardon, and then double-click the model AVR 230[IR] from the list. 

  
c. Add the Television to the 'Devices in Room' list using the Online Database. 

  
Example: Double-click Television, select Online Database, choose the manufacturer 
Samsung, and then double-click the model TX-P1430. This adds the device driver for cable TV 
and UHF/VHF. 

  
d. Click next. 

  
8. Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give each a 

descriptive name (edit immediately after adding while still in edit mode, or right-click later). 
  

Example: Use the previous examples to 
  
Add a Wireless Dimmer, and rename it Dimmer. 
Add a Wireless Switch, and rename it Light Switch. 
Add a Wireless Outlet Switch, and rename it Television Outlet Switch. 

  
9. Click next. 
10. Add the Sensors and Contacts to the Devices in Room list, and give each a descriptive name. 

  
Example: Add a Door Contact Sensor for the door to the Theater. 

  
11. Click next. 
12. Add the Motorized Devices to the Devices in Room list. 

  
Example: Add a Motorized Screen to the Theater. 
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13. You have just completed the setup for the Theater. Click next to move to the Bedroom. 
 
To define devices in the Bedroom: 
1. Notice that the selected room on the left is now Bedroom. For the selected room, check the 

appropriate boxes to indicate the devices used in this room. 
  

Example: For the Bedroom: De-select AV Components and Sensors. Check User Interface, 
Multi-Room Audio, Lighting, and Motorization. 

  
2. Click next. 
3. Add the devices to this room. Double-click a device to move the devices from the Available 

Devices list to the Devices in Room list. 
  

Example: Add a Touch Screen to the Bedroom. 
  

4. Click next. 
5. Choose how the digital audio is received in this room. 

  
Example: Audio is sent digitally to the Touch Screen. Choose Through a Touch Screen. 

  
6. Click next. 
7. Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give each a 

descriptive name (edit immediately after adding while still in edit mode, or right-click later). 
  

Example: Add a Wireless Dimmer and rename it Dimmer. 
  

8. Click next. 
9. Add the Motorized Devices to the Devices in the Room list. 

  
Example: Add the Gas Fireplace to the Bedroom. 

  
10. You have just completed the setup for the Bedroom. Click next to move on to the Front of the 

house. 
 
To define devices in the Front Room: 
1. Notice that the selected room on the left is now Front Room. For the selected room (Front Room), 

check to identify the types of devices you have in that room, and then click next. 
  

Example: De-select AV Components, Multi-Room Audio, and Lighting. Check User Interface, 
Motorization, and Sensors. 

  
2. Click next. 
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3. Identify which Navigators are included in each room by selecting the Navigator, and then clicking 
the double-arrow button. 

  
Example: Add the 3 Button Keypad for the Navigator in the Front Room. 

  
4. Click next. 
5. Add the Sensors to the Devices in the Room list. 

  
Example: Add the Doorbell and Motion Sensor to the Front Room. 

  
6. Click next. 
7. Add the Motorized devices to the Devices in the Room list. 

  
Example: Add the following: Electronic Gate and Sprinklers. 

  
If you have a Thermostat, add it in Composer Pro after you exit Interviewer. See “Configuring HVAC 
Systems.” 
  
You have just completed defining the devices in each room. Click next to continue to the next section 
to identify the network connections. 

2.9.1.3 Example: Identify the Devices on the Network 
This section discusses using Control4® Interviewer wizard in Composer Pro to identify the devices 
you've added in the project to the network. 
  
Note: This process follows “Example: Define Devices in Each Room.” 
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You are now ready to set up the network connections in the Network section of Interviewer. In this 
section, you identify the physical device to its network address so the devices can communicate with 
the Controller. 
  
Follow the on-screen instructions specific to the selected device to identify it on the network. The first 
item is selected by default automatically. When selected, the device is placed in 'Identify' mode. 
Devices that use network connections and associated instructions are found in “Example: Make and 
Verify the Connections.” 
  
Note: To program lighting and Keypad buttons, see “Programming the System.” To set up Lighting 
Scenes, see “Program with the Lighting Scenes Agent.” 
 
To identify devices on the network, go to the physical device and follow these instructions.  
The diagram for the device indicates which button to press. 
1. Go to the Controller hardware, and press the Select dial to identify the device. When the address 

appears, click next. 
  

 
  

2. Pick up the System Remote Control, and press the 4 button to identify the device. You may 
need to press it repeatedly until the address appears. When the address appears, click next. 

3. Go to the 6 Button Keypad, and press the top left button four (4) times in rapid succession to 
identify the device. When the address appears, click next. 

4. Go to the Theater Dimmer, and press the top button four (4) times to identify the device. When 
the address appears, click next. 

5. Go to the Theater Light Switch, and press the top button four (4) times to identify the device. 
When the address appears, click next. 

6. Go to the Theater Outlet Switch, and press the button four (4) times to identify the device. When 
the address appears, click next. 

7. Go to the Touch Screen, and identify the device. When the address appears, click next. 
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8. Go to the Bedroom Dimmer, and press the top button four (4) times to identify the device. When 
the address appears, click next. 

9. Go to the 3-Button Keypad, and press the top button four (4) times in rapid succession to 
identify the device. When the address appears, click next. 

10. Click next to continue to the next section to define Audio/Video connections. 

2.9.1.4 Example: Define the Audio/Video Connections 
This section discusses using Control4® Interviewer wizard in Composer Pro to define the audio and 
video connections. You set up the software for audio and video connections that directly correspond 
to your hardware connections between your devices. 
  
Note: This process follows “Example: Identify the Devices on the Network.” 
  
You are now in the Audio/Video section of Interviewer. In this section you identify any devices and 
their connections that carry audio and/or video signals. Using the Smith Home example project (a 
Controller project), complete the following steps. 
 
To define audio/video connections: 
1. Choose the device(s) to which the specified Controller sends audio and video signals. 

  
Example: The Controller in the Theater Room sends audio and video to the Receiver. Add 
Theater > Receiver to the Connected Devices list. 

  
2. Click next. 

  

 
  

The Receiver is the only device connected to the Television. Both the DVD player and the 
Controller route their audio and video signals through the Receiver to get to the Television. 
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3. Choose how the Controller Stereo Outputs connect to the Receiver. 
  

a. Choose how the Controller Stereo 1 Output connects to the Receiver. 
  

Example: In Audio Connections, check INPUT VIDEO 1 and check STEREO. 
  

b. Click next. 
c. Choose how the Controller Stereo 2 Output connects to the Receiver. 

  
Example: Ensure that none is checked (Controller Stereo 2 does not connect to the 
Receiver). 

  
d. Click next. 
e. Choose how the Controller Stereo 3 Output connects to the Receiver. 

  
Example: Ensure that none is checked (Controller Stereo 3 does not connect to the 
Receiver). 

  
4. Click next. 
5. Choose how the Controller Video Out Outputs connect to the Receiver 

  
a. Choose how the Controller Video Out 1 Output connects to the Receiver. 

  
Example: In Video Connections, check INPUT VIDEO 1, and then check COMPOSITE. 

  
b. Click next. 
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6. Choose the device(s) to which the DVD sends audio and video signals. 
  

Example: In the Audio/Video list on the left, check DVD, and then double-click Theater > 
Receiver to add it to the Connected Devices list. 

  
a. Click next. 
b. Choose how the Theater DVD Output connects to the Receiver. 

  
Example: In Audio Connections, check INPUT DVD, and then check STEREO. In Video 
Connections, check INPUT DVD, and then check COMPOSITE. 

  
c. Click next. 
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7. Choose the device to which the Theater Receiver sends audio and/or video. 
  

Example: Double-click Theater > Television to add it to the 'Connected Devices' list. 
  

a. Click next. 
b. Choose how the Theater Receiver Output connects to the Television, and then click next. 

  
Example: In Audio Connections, check INPUT AV1, and then check STEREO. In Video 
Connections, check INPUT AV1, and then check COMPOSITE. 

  
c. Click next. 
d. If applicable, choose the device(s) to which the Theater Tuner sends audio and/or video 

signals. Make connections only to stand-alone tuners. A tuner that is a built-in component to 
another AV device, such as Receiver, uses the host’s connections. 

  
Example: The Tuner in this project is a built-in tuner to the Receiver, and therefore, uses the 
same AV Connections set up previously for the Receiver. 

  
e. Click next. 

  
8. Choose how the Bedroom Touch Screen sends audio and/or video signals. 

  
Example: The Touch Screen does not send audio to any of these devices. It only sends audio to 
the powered speakers, which are not shown in Composer Pro projects. Ensure that nothing is 
selected. 
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9. You have just completed defining audio/video connections. Click next to continue to the next 
section to define Control connections. 

2.9.1.5 Example: Define the Control Connections 
This section discusses using Control4® Interviewer wizard in Composer Pro to define the Control 
connections. 
  
Note: This process follows “Example: Define the Audio/Video Connections.” 
  
You are now in the Control section of Interviewer. In this section, you identify all Control connections 
in the system. 
  
Tip: To complete this section, refer to the control connection tables shown in the "Hardware 
Connections" section "From Output to Input" in “Example: System Specifications.” 
  
Using the Smith Home example project (a Controller project), complete the following steps. 
 
To define Control connections: 
1. Define the IR OUT port connections on the Controller. 

a. Choose IR OUT 1 to Television IR Sensor, and then click next. 
  

 

b. Choose IR OUT 2 for the Receiver IR Sensor, and then click next. 
c. Choose IR OUT 3 for the DVD IR Sensor, and then click next. 

Tip: If you prefer to set up a video or contact sense loop instead of using a macro, see “Changing 
Power Management Options.” After you add a video sense loop connection to the DVD player 
driver, add a control connection between the Controller and DVD player. 
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2. Define the Contact and Relay connections on the Controller. 

a. Choose Contact 3 for the Theater Door Contact Sensor, and then click next. 
b. Choose Relay 3 for the Theater Motorized Screen, and then click next. 
c. Choose Relay 1 for Bedroom Gas Fireplace, and then click next. 
d. Choose Contact 2 for the Motion Sensor, and then click next. 
e. Choose Contact 1 for the Motion Sensor, and then click next. 
f. Choose Relay 4 for the Electronic Gate, and then click next. 
g. Choose Relay 2 for the Sprinkler, and then click next. 

  
3. You have completed the setup of the system. Click next to exit the system. 

  
After you have completed setting up the system using Interviewer, you may want to do one of the 
following: 

• If you followed the “Example” instructions exactly and have completed all the Interviewer 
screens, you are ready to verify your connections and test the device control on the system. 
For instructions about how to do this, see “Connecting Devices.” 

• If you want to learn how to set up the same example project using the Composer Pro screens 
rather than Interviewer, you can clear your sample project, and go to “Example Smith Home: 
Composer Views Method.” 

• If you understand what occurred in the previous procedure and you are ready to create your 
own project, go the Composer Pro Getting Started for planning and design steps. 

2.9.2 Example Smith Home: Composer Views Method 
The following sample project sections step you through the creation of a Control4® project using the 
Composer Pro views. Alternatively, you can create a new project using the Interviewer wizard in 
Composer Pro. 
 
To use Composer Pro views: 
1. Start Composer and connect to a Director. 
2. Click System Design. 

  
Follow these sections in the order shown to use the Composer Pro views: 

  
“Example: System Specifications” 
“Example: Design and Create the Project” 
“Example: Make and Verify the Connections” 
“Example: Verify the Network Connections” 
“Example: Define the Control and Audio/Video Connections” 

2.9.2.1 Example: Design and Create the Project 
There are two (2) ways you can design and create a project. Use the Control4® Composer Pro views 
or Interviewer wizard in Composer Pro to design and create a project. 
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2.9.2.1.1 Interviewer Wizard 
You begin the Interview with the System section. In this section, Interviewer asks you questions 
regarding the entire system, including types of devices, the rooms that contain devices, etc. 
 
To define system information: 
1. Start Interviewer. 
2. Type the Project Name: Franklin Smith Home. 
3. Type a valid zip code to automatically populate the appropriate latitude and longitude coordinates, 

and then click next. These coordinates are editable if necessary. The Control4 system uses these 
coordinates to identify the local sunrise and sunset times (to be used in future programming 
calculations). 

  
Example: Enter Zip code: 84003 

  

 
  

4. Check the boxes to indicate which types of devices you are adding to the system. 
  

Example: Check AV Components, Multi-Room Audio, Lighting, Motorization, Temperature 
Control, and Sensors. 

  
5. Click next. 
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Tip: Temperature control is not fully implemented in Interviewer. If you have a Thermostat, you 
need to add it and identify it to the system outside of Interviewer. For instructions on how to do 
this, see “Configuring HVAC Systems” for more information. 

  
6. Add rooms by double-clicking a room or selecting a room, and clicking the double-arrow button. 

  
Example: Add Theater, Bedroom, and Front. 

  
7. When you’ve added the rooms, click next. 
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8. Choose the method that distributes multi-room audio. Multi-room audio choices include: 

• Digitally—Set up a multi-room audio system utilizing the network as an audio distribution 
system with digital-end points. 

• Audio Switch —Install and set up a multi-room audio system, utilizing a traditional analog 
audio switch and amplifiers. 

• Receivers—Install and set up a multi-room audio system, utilizing a receiver in each room to 
distribute audio. 

  
Example: Audio is streamed (through Ethernet) to the Touch Screen to the Bedroom, so you 
would choose Digitally. 

  
9. You have just completed your System setup. Click next to continue to the next section to 

complete Rooms setup. 

2.9.2.1.2 Composer Views 
In this view, you create the foundation of the Control4 system by building the project tree. 
 
To design the Smith Home project: 
1. Start Composer and connect to a Director on a Local Network. 
2. Enter the Project Properties for the Smith Home. 

• Name: Franklin Smith Home. 
• Zip Code: 84003 or enter a Latitude and Longitude manually. 
• Date & Time: Use the drop-down menu to change these as desired. 
• Time Zone: Use the drop-down menu to select the appropriate zone. 

3. Add rooms to the project tree. 
a. In the Locations tab, double-click on a room to add it to the project tree. 
b. Continue to add rooms until you have included all rooms you want in the house (rooms that 

will have automated devices). You can also drag these items to an object in the project tree. 
  

Example: Add three (3) rooms. 
  

• Theater 
• Bedroom 
• Front 

  
Tips: To build the system design, define the project configuration in the project tree. You do not 
have to add all the items in the project tree manually, such as Site > Building > Floor > Room 
because Composer Pro automatically adds the required infrastructure.  

  
Also, you can rename the objects as desired; for example, Franklin Smith Home > Home > 
House > Main >Theater. For more information, see Composer Pro Getting Started. 
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To add the devices: 
1. Add the Controller to a room in the project tree. 

a. When setting up a system, first add the Controller driver to the list. In the project tree, choose 
the room where you want the Controller to reside. In the Items pane > My Drivers tab, 
double-click a Controller to move it to the room. See the example below. 

  
Note: If you installed this version of Composer Pro on a computer with an older version of 
Composer Pro, right-click in the My Driver tab, and choose Restore Default List. This will 
update the My Driver list. 
  
Example: Add a Controller to the Theater Room: 
  
b. From the project tree, select Theater. In the Items pane > My Drivers tab under Controllers, 

double-click Controller or drag it to the room where it resides—in this case, Theater. The 
Controller and Digital Audio appear in the project tree. The Digital Audio object resides on the 
Controller, but shows up as a separate object in the project tree. The Digital Audio provides 
the functionality to play media. 
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2. Add the Lighting and Navigators to the applicable rooms. The example below shows some 

devices you can add. 
  
Example: Select Theater in the project tree. In the My Drivers tab, do the following: 
  
a. In Lighting > Light, double-click Wireless Dimmer, and then rename to Dimmer. 
b. In Lighting > Light, double-click Wireless Switch, and then rename to Light Switch. 
c. In Lighting > Light, double-click Wireless Outlet Switch, and then rename to Television 

Outlet Switch. 
d. In User Interface, double-click System Remote Control. 
e. In User Interface, double-click 6 Button Keypad. 

  
Tip: Use a descriptive name. When adding devices to the home, right-click and choose Rename 
to rename them with a descriptive name. For example, if you have two (1) Dimmers in a room, 
give them a descriptive name such as “Wall Dimmer” or “East Dimmer.” This helps you identify 
the specific Dimmer later when identifying connections. If there's only one Dimmer or Switch in a 
room, however, you can keep the generic title "Dimmer" or "Switch." 

  
3. Add a Receiver to the applicable room. 

  
Example: Add a Receiver to the Theater. To add, select Theater in the project tree. From the 
My Drivers tab, do the following: 

  
a. In Audio/Video, double-click Receiver. 
b. In the dialog box that appears, choose Online Database, choose the manufacturer Harmon 

Kardon, and then double-click AVR146[IR] to add the Receiver to the project tree. 
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4. Add a Television to the applicable room. This will probably be the same room where the 
Controller is. 

  
Example: Add the Television to the Theater. To add, select Theater in the project tree. From 
the My Drivers tab, do the following: 

  
a. In Audio/Video, double-click Television. 
b. In the dialog box that appears, choose Online Database, choose the manufacturer 

Samsung, and then double-click HC-J655W[IR]. 
  
The UHF/VHF object may be added to enable you to scan for UHF/VHF broadcast channels. 
  

 
  

5. Add additional Audio/Video devices to the room. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  148 of  199 

 

 

  
Example: Add the DVD Player to the Theater. To add, select Theater in the project tree. From 
the My Drivers tab, do the following: 

  
a. In Audio/Video, double-click DVD. 
b. In the dialog box that appears, choose Online Database, choose the manufacturer 

Samsung, and then double-click DVD HD841[IR]. 
  

Note: If you can access a Wireless Touch Screen, add it now to your project. If you previously 
had a Wireless Touch screen on your system prior to Release 1.3, follow the special update 
instructions in “Information About Older Releases.” 
  

6. Add a motorized device or sensor to the applicable room. 
  

Example: From the My Drivers tab, add a Motorized screen and a Door Contact Sensor to the 
Theater room from the Online Database. To add, select Theater in the project tree. In the My 
Drivers tab, do the following: 

  
a. In Motorization, double-click Motorized Screen. 
b. In Sensors, double-click Door Contact Sensor. 

  
7. Repeat Steps 2 through 6 as needed to add more devices to the applicable rooms. 

  
Example: To finish creating the project tree for the example project, add devices to the Bedroom 
and Front Room as follows. 

  
Bedroom: 
  
Select Bedroom in the project tree. In the My Drivers tab, do the following: 

  
• In Lighting > Light, double-click Wireless Dimmer, and then rename it to Bedroom Dimmer. 
• In User Interface, double-click Touch Screen. 
• In Motorization, double-click Gas Fireplace. 

  
Front Room: 
  
Select Front Room in the project tree. From the My Drivers tab, do the following: 

  
• In User Interface, double-click 3 Button Keypad. 
• In Motorization, double-click Electronic Gate. 
• In Motorization, double-click Sprinklers. 
• In Sensors, double-click Doorbell. 
• In Sensors, double-click Motion Sensor. 
• In HVAC, double-click Wireless Thermostat. 
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2.9.2.2 Example: Make and Verify the Connections 
This section discusses using Control4® Composer Pro views to make and verify the connections. 
  
Note: This process follows Example: Design and Create the Project. 
  
In the Connections view, you can: 

• Identify Control4 devices to establish a Network connection  
• Check all Network connections 
• Define AV connections 
• Define Control connections 

  
Note: When only one appropriate connection is available in a room for a given connection type, 
Composer Pro assumes the connection (example: if a TV is the only Audio Output device in a room, 
the system assumes that the Audio Output connection is routed to the TV). This feature adds value to 
Composer Pro, but increases the need to verify every connection. 

  
Note: To remove a connection, right-click on the connection and choose Disconnect. 
 
To make connections: 
1. In Composer Pro, click the Connections view. 
2. Identify the Control4 devices that connect to the Controller through the network. Go to each 

physical device and press the button indicated on the Composer Pro screen. 
  

a. Click the Network tab > IP Network. 
  

Notice the devices that do not have an address listed under the Address column. 
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b. Select the Controller, and then click Identify. The screen to identify the Controller appears 
(in this example, the HC1000).  

c. At the physical Controller, press the Identification button. This identifies the Controller with a 
unique address in the system. When the address appears on the screen, click Next. 

  

 
  

d. Select Dimmer, and then click Identify. The screen to identify the Dimmer appears. Press the 
top Dimmer button four (4) times. This identifies this specific Dimmer with a distinctive 
address to the system. When the address appears, click Next. 

  

 

  
e. When the Light Switch identification screen appears, press the top button four (4) times. 

When the address appears, click Next. 
f. When the System Remote Control identification screen appears, holding the physical System 

Remote Control press the red 4 button once. When the address appears in the box, click 
Next to continue. 

g. If you have a Touch Screen in your project, press the Enter button on the front of the Touch 
Screen. When the address appears in the box, click Next to continue. 

h. When the Outlet Switch identification screen appears, press the button on the module four 
(4) times. 

i. When the 6 Button Keypad identification screen appears, press the top left button four (4) 
times. When the address appears, click Next. 

j. When the Dimmer identification screen appears, press the top button four (4) times. When 
the address appears, click Next. 
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k. When the Touch Screen identify screen appears, press the indicated button as shown. When 
the address appears, click Next. 

l. When the 3 Button Keypad identification screen appears, press the top button four (4) times. 
When the address appears in the box, click Next. 

m. When the Control4 Wireless Thermostat identification screen appears, press the middle 
button four (4) times. When the address appears in the box, click Close to exit Identify mode. 

n. When you finish identifying the devices, notice that the Address column now has an address 
for every network device. 

  

 
  

3. Define the AV and Control connections. 
  

Control and AV connections for a device are visible when you click the Connections view > 
Control/AV tab, and then select the device. To make a connection between inputs and outputs, 
from the top pane drag a device’s input (or output) to the output (or input) in the bottom pane. 
  
For each device, define the following when applicable: 
• Video connections (path of video signals) 
• Audio connections (path of audio signals) 
• Control connections (how the Controller communicates with the device) 
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a. Define the AV connections for the Receiver. 

  
Example: In the Connections view under Theater, click Receiver. The right top pane displays all 
the inputs and output on the back of the Receiver. For Receiver, from the top pane in Audio 
Video Inputs, make the following connections: 
  
• Click INPUT DVD (Video—COMPOSITE), and drag it to DVD (Output—Theater) in the 

bottom pane. 
• Click INPUT VIDEO 1 (Video—COMPOSITE), and drag it to Home Controller HC300(Video 

Out 1— Family) in the bottom pane. This connects the Receiver Video 1 input to the 
Controller Video 1 output. 

• Click INPUT DVD (Audio—STEREO), and drag to DVD (Output—Theater) in the bottom 
pane. 

  

 
  

b. Define the Control connection for the Receiver to the Controller. 
  

Example: In the Connections view under Theater, click Receiver. The right top pane displays all 
the inputs and output on the back of the Receiver. 
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For Receiver, from the top pane under Control Inputs, make the following connections: 
• Click IR Sensor (Control—IR_OUT), and drag it to Controller (IR Output 2—Theater) in the 

bottom pane. 
  

 

  
c. Define AV and Control connections for the Television. 

  
Example: In the Connections view under Theater, click Television. The right top pane displays 
all the inputs and outputs on the back of the Television. For Television, from the top pane do the 
following: 

  
In Audio Video Inputs: 
• Click AV (Video—COMPOSITE), and drag it to Receiver (Output—Theater) in the bottom 

pane. 
• Click AV (Audio—STEREO), and drag it to Receiver (Output —Theater) in the bottom pane. 

 
In Control Inputs, click IR Sensor (Control—IR_OUT), and drag it to Controller (IR Output 1—
Family) in the bottom pane. 
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d. Define the Control connections for the DVD player to the Controller. 

  
Example: In the Connections view under Theater, click DVD. The right top pane displays all the 
inputs and outputs on the back of the DVD. From the top pane, do the following: 
  
In Control Inputs, click IR Sensor (Control—IR_OUT) and drag it to Controller (IR Output 3—
Family) in the bottom pane. 

  

 
  

Tip: If you prefer to set up a video sense loop instead of using a macro, see “Changing Power 
Management Options.” After you add a video sense loop connection to the DVD player driver, 
add a control connection between the Controller and the DVD player. 

  
e. Define the Control connections for the Motorized Screen to the Controller. 

  
Example: In the Connections view under Theater, click Motorized Screen. The top right pane 
displays all the inputs and outputs on for the screen. 
  
In the top pane under Control Inputs, click Relay (Control—RELAY), and drag to Controller 
(Relay Port 3—Family) in the bottom pane. 
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f. Define the Control connections for the Door Contact Sensor to the Controller. 
  

Example: In the Connections view under Theater, click Door Contact Sensor. The top right 
pane displays all the inputs and outputs for the Door Contact Sensor. 
  
In the top pane under Control Inputs, click Contact Sensor (Control—CONTACT_SENSOR), 
and drag it to Controller (Contact Port 1—Family) in the bottom pane. 

  
g. Define the Control connections for the Gas Fireplace to the Controller. 

  
Example: In the Connections view under Bedroom, click Gas Fireplace. The top right pane 
displays all the inputs and outputs for the Gas Fireplace. 
  
In the top pane under Control Inputs, click Relay (Control—RELAY), and drag it to Controller 
(Relay Port 1—Family) in the bottom pane. 

  
h. Define the Control connections for the Electronic Gate to the Controller. 

  
Example: In the Connections view under Front, click Electronic Gate. The top right pane 
displays all the inputs and outputs for the Electronic Gate. 
  
In the top pane under Control Inputs, click Relay (Control—RELAY), and drag it to Controller 
(Relay Port 4—Theater) in the bottom pane. 

  
i. Define the Control connections for the Sprinklers to the Controller. 

  
Example: In the Connections view under Front, click Sprinklers. The top right pane displays all 
the inputs and outputs for the Sprinklers. 
  
In the top pane under Control Inputs, click Relay (Control—RELAY), and drag it to Controller 
(Relay Port 2—Theater) in the bottom pane. 

  
j. Define the Control connections for the Contact Sensor to the Controller. 
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Example: In the Connections view under Front, click Doorbell. The top right pane displays all the 
inputs and outputs for the Doorbell. 
  
In the top pane under Control Inputs, click Contact Sensor (Control—CONTACT_SENSOR), 
and drag it to Controller (Contact Sensor 2—Theater) in the bottom pane. 

  
k. Define the Control connections for the Motion Sensor to the Controller. 

  
Example: In the Connections view under Front, click Motion Sensor. The top right pane displays 
all the inputs and outputs for the Motion Sensor. 
  
In the top pane under Control Inputs, click Motion Sensor (Control—CONTACT_SENSOR), and 
drag it to Controller (Contact Sensor 1—Theater) in the bottom pane. 

4. Go to the next section, “Example: Verify the Network Connections.” 

2.9.2.3 Example: Verify the Network Connections 
This section discusses using Control4® Composer Pro views to verify the network connections. 

  
Note: This process follows “Example: Make and Verify the Connections.” 

  
There are two (2) places to verify network connections: 
1. The Network tab (shown below) 
2. The Tools menu 

  

 
  

Follow the instructions below to check your connections in both locations. 
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To check your connections from both locations: 
1. From the Connections view > Network tab, verify that every device that communicates to the 

Controller using TCP/IP, WiFi, and/or ZigBee has a network address. If a device doesn’t have a 
network address, the device needs to be identified. 

2. To identify a device from this location, right-click on the device and choose Identify (or click the 
Identify button). Follow the on-screen instructions provided for each device, such as those listed 
in the following table. 

  
After identifying the network connection, the device’s address appears in the list. 
 

Device Instructions to Identify a Device to the Control4 System  

Controllers Press the Identification button on the Controller. 

Lights and Keypads 
Press top button 4 times (6 Button Keypad — press top left button). For Release 
1.8 and later, press any button 4 times. MiniApp mode: press bottom left or bottom 
button 4 times. 

System Remote 
Controls 

Press the red 4 button on the remote control. 

Speaker Point Press button 1 time. 

Multi Tuners Press button 1 time. 

16 Channel Amps Press button 1 time. 

Thermostats Press center button 4 times. 

Wireless Outlet 
Switches  Press button 4 times. 

Wireless Touch 
Screens Press the Enter button on the front of the Touch Screen 1 time. 

Black & Decker 
Kwikset Locks 

Press the Top Left button on the top of the board (remove the lock's cover first) 4 
times. To disconnect, press the Top Right button on the top circuit board 9 times. 

1-Button Products Release 1.8 and later, press 4 times. 

IO Extenders Press the Link button on the back of the IO Extender. 

Media Players Press the Link LED button on the front of the Media Player. 

Touch Screens Press the button indicated on the diagram of the device in Composer Pro. 

 

2.9.2.3.1 Using the Network Tab 
 
To ensure all devices have been identified from the Network tab: 
1. Click Connections > Network tab > IP Network. 
2. In the Address column, check if there is an address for every line item. 
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2.9.2.3.2 Using Network Tools 
 
To ensure all network connections exist and are active from Network Tools: 
1. From the Tools menu, select Network Tools. 
2. Check both the IP Network and Zigbee Network tabs for Green, Yellow, and Red connection 

icons. The colors indicate the following: 
• Green—An address is identified, and the device is online (communicating). 
 
Example: The Dimmer is identified and communicating to the system. 

  
• Yellow—An address is identified, and the device is offline (not communicating). 
 
Example: If the System Remote Control goes to sleep, the status turns Yellow. This indicates 
that the System Remote Control has been identified, but is offline (not communicating). Make the 
device active so it can communicate to the system. 

  
• Red—A device is not identified. Go to the Connections view > Network tab, and identify the 

device to the system or see “Example: Make and Verify the Connections.” 
  

3. If you find Yellow or Red icons, do the following: 
• Yellow Icons—Go to the device, and activate it according to its documentation. 
• Red icons—Go to the Connections view > Network tab, and identify the device to the 

system. 
 
Example: At this point in your example project, the System Remote Control should be yellow (or 
the only device not green). The System Remote Control turns green as soon as you wake up the 
System Remote Control. To wake up the System Remote Control, press the red Control4 4 
button. 
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2.9.2.4 Example: Define the Control and Audio/Video Connections 
This section discusses using Control4® Composer Pro views to define AV connections. 
  
Note: This process follows “Verifying the Network Connections.” 
  
Control/AV connections are visible when you select the Control/AV tab in the Connections view. The 
Control/AV tab lets you define the physical connections between the Controller or other devices, 
including AV signals, IRs, relays, contacts, and/or serial connections. 

  

 
  

Tip: If connections do not appear as needed, edit the driver to create the needed connections. See 
“Editing a Driver Using the Driver Wizard.” 

  
The following steps are described in the next sections: 

“Verify that all Control and AV Connections use Room Properties” 
“Disconnect/Remove Control/AV Connections” 
“Re-assign Control/AV Connections” 
“Update Connections in the project if you change locations” 

2.9.2.4.1 Verify that all Control and AV Connections Use Room Properties 
 
To verify all Control and AV connections by checking room properties: 
1. Click the System Design view. 
2. Select a room. 
3. On the default tab Audio Video Devices, see if your AV devices are accessible in the room. If an 

AV device is not there, see “Make and Verify Connections.” 
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2.9.2.4.2 Disconnect/Remove Control/AV Connections 
 
To disconnect or remove a control/A/V connection: 
1. Click the Connections view. 
2. Select the Control/AV tab. 
3. In the Control/AV project tree, select a device for the device’s control and AV connections to 

appear. 
4. In the Control and AV Connections pane, right-click an input (or output) connection and choose 

Disconnect. 

2.9.2.4.3 Re-assign Control/AV Connections 
 
To reassign Control/AV connections: 
1. Click the Connections view > Control/AV tab. 
2. In the project tree, select a device for the device’s control and AV connections to appear. 
3. In the Control and AV Connections pane, drag an input from the top pane to a different output on 

the bottom pane. The connection is moved to the specified output. 

2.9.2.4.4 Update Connections in the Project if You Change Locations 
If you use the same project but you change locations, you have to update all of the connection 
information. 
 
To update the connection information in an existing project: 
1. Click the Connections view. 
2. Click the Control/AV tab, and review your connections to ensure that they are updated in the 

current control and AV topology. 
3. Click the Network tab and disconnect all connections by right-clicking and selecting 

Disconnect. 

2.10 Troubleshooting the System 
These sections provide some information about troubleshooting a Control4® system. 
 
“Guidelines for Troubleshooting” 
“Troubleshooting a Director Connection” 
“Troubleshooting Controllers” 
“Troubleshooting Device Control” 
“Troubleshooting Dimmers, Switches and Keypads” 
“Troubleshooting Driver Creation” 
“Troubleshooting Media” 
“Troubleshooting Navigators” 
“Troubleshooting the System” 
“Cannot Identify the Device to the Network” 
“Troubleshooting the Upgrade Process” 
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2.10.1 Guidelines for Troubleshooting 
This section outlines general troubleshooting guidelines to check first if you are having problems with 
a Control4® system. 
  
The following table lists the main areas typically found to resolve some issues on the Control4 system. 
 

Guideline Where To Go 

Check room connections 

Composer Pro automatically sets room connections when you set up a system. 
These settings are default settings, and may not necessarily match your 
physical connection. Ensure that the room connections are set to match your 
specific system.  
 
If you move a device to another room, move it in the project tree also, and then 
identify it again to make sure it's connected properly.  
 
For more information, see:  
“Connecting Rooms”  
“Testing Device Controls”  

Check Control/AV 
connections 

The Control and AV connections identify the physical connections to the 
system. When these are defined, the system is completely automated and 
programmable. However, if one of the connections is not correctly identified, it 
can cause the system not to run properly. Ensure that the control and AV 
connections match the physical configuration. 
  
For more information, see: 
“Control/AV Tab” (see Composer Pro Getting Started) 
“Control and Audio Video Connections” (see "Control/AV Tab" in Composer Pro 
Getting Started) 

Check network connections 

If a device is not using a control connection to communicate to the Control4 
Controller, it uses a network connection: a type of connection that uses a 
network address such as TCP/IP (Ethernet), ZigBee, ZigBee Pro and WiFi. 
  
1. Ensure that the network connections viewable in the Connections view > 
Network tab all have a network address associated with the device. If not, 
identify the device again. 
2. Ensure that the Control4 Controller, such Home Controller HC-300, has a 
network address. If the address is not appearing, identify the device again. 
 
From the Tools menu, select Network Tools. This lets you see all of the 
ZigBee and IP network addresses on the network. It shows whether the device 
has an address, and if it has an active connection to the network (status is 
online). 
  
For more information, see: 
  
“Network Tab”  (see Composer Pro Getting Started) 
“Network Tools Dialog”  (see "Tools Menu" and "Network Tools Dialog"  in 
Composer Pro Getting Started) 
Connecting a Device to the Network (see “Connecting Devices”) 
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Guideline Where To Go 
“Cannot Identify the Device to the Network” 
“Verifying the Network Connections” 

Ensure Navigators are 
connected to Director  

From any of the Navigators, press Info > Director (for releases prior to 2.0) or 
More > Settings > Network (OS 2.0 and later) to ensure that you are 
connected to the Control4 Controller’s network address. You can find out the 
Control4 Controller’s network address from the Connections view > Network 
tab. 
  
For more information, see ”Customizing Navigators.” 

Ensure music is added and 
scanned 

In Composer Pro, ensure that your music is available (added to the Controller) 
and is scanned into the system. 
  
1. Make sure the stored or broadcast media is added or scanned. 
2. Check the Room Properties page to see if the media was added. 
3. Ensure that Navigators were refreshed after scanning media. 
4. If the Controller reboots, re-scan the media. 
  
For more information, see: 
  
“Items Pane” (see Composer Pro Getting Started) 
“Setting Up Media Stored on a Controller” 
“Setting Up Media Stored in a Disc Changer” 
“Setting Up Media for Television Channels” 
“Setting Up Media for Radio Stations” 
“Using External Storage Devices” 
“Adding an Audio Switch or Audio/Video Switch” 
“Creating a Playlist” 
“Editing Media Information” 
“Testing Media Control” 

Refresh Navigators Whenever you update or scan music, or update devices or device information, 
from the File menu, select Refresh Navigators. 
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2.10.2 Troubleshooting Controllers 
The following table lists troubleshooting problems on Control4 system Controllers. 
 

Symptom Possible Problems and Solutions 

The Controller has 
N/A for IP address 

1. The Controller has no network connection. Plug in your Ethernet cable. After 
a few moments, the addresses should appear. 
2. The power cable is not plugged in. Plug in your power cable. 
3. No DHCP on the network. Ensure that DHCP is operational. 

The Controller has a blank 
front display 

1. Either your cables are unplugged, or they are not connected. If both are 
connected, unplug them and connect the Ethernet cable before connecting the 
power cord. 
2. The Controller is not connected to a cable/modem/switch/ using DHCP. 
3. Ensure that the Reset button is not jammed behind the plastic cover. 

The Controller doesn't come 
back up after a power 
outage 

To receive a notification of the Controller going down and coming back up, set 
up an Email Notification agent to alert you when the project is loaded and the 
Controller comes back up. When you create the alert, place the alert on the 
project (Device Events top level). See Example: “Program Using the E-Mail 
Notification Agent.” 

 

2.10.3 Troubleshooting a Director Connection 
The following table lists troubleshooting problems connecting to a Director. 
 

Symptom Possible Problems and Solutions 

Cannot see the Network 
Address of Director in the 
Director’s dialog 

1. In Tools > System Manager, click Refresh several times to see if the network 
address appears. 
2. If not, choose Add and enter the name and network address. 
3. Make sure Director is enabled on the controlling device. 
     a. At a command line, enter telnet [controller IP address]. 
     b. Enter the root username and password. 
     c. Enter sysman status. 
     d. If Director is not enabled, enter sysman enable director. 
     e. Enter sysman status and verify the Director is now enabled. 
     f. Enter exit. 
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2.10.4 Troubleshooting Media 
The following table lists troubleshooting problems with Control4 system media. 
 

Symptom Possible Problems and Solutions 

DVDs not showing up in the 
Disc Changer 

Ensure that you have a serial Disc Changer. Only bi-directionally-controlled 
serial Disc Changers can scan media. 
  
If you have a serial Disc Changer, see the following: 
  
1. Ensure that music is added and scanned 
2. Check these sections: 
   “Setting Up Media Stored in a Disc Changer” 
   “Connecting Rooms” 
   “Checking Control/AV Connections” 
   “Connecting a Device to the Network” 

Cannot play music or music 
channels not appearing in 
the Navigators 

If music is not running, see the following: 
  
1. Ensure that the Navigator is connected to the Director. See Composer Pro 
Getting Started. 
2. Ensure that a room is appearing on the Navigator. If not, click the room and 
change the room to one that can play music. 
3. Ensure that music is added and scanned. 
4. See “Connecting Rooms.” 
5. See “Checking Control/AV Connections.” 
6. See “Connecting a Device to the Network.” 
7. Refresh the Navigators. See the Composer Pro Getting Started. 

 

2.10.5 Troubleshooting Device Control 
The following table lists some control problems on Control4 system devices. 
 

Symptom Possible Problems and Solutions 

The Device is not 
Controllable from a 
Navigator  

If the device, such as a Dimmer, is not controllable from the Device Control 
window (double-click the device from the project tree); no connection exists. 
  
Refer to the following sections: 
“Connecting Rooms” 
“Checking Control/AV Connections” 
“Connecting a Device to the Network” 
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2.10.6 Troubleshooting Navigators 
The following table lists troubleshooting problems with Control4 Navigators. 
 

Symptom Possible Problems and Solutions 

Not seeing Room Location 
on the Navigators 

From a Navigator (On Screen or Touch Screen), ensure that the device is 
connected to Director. See “Connecting Rooms.” 
Check the connections: 
1. For an On-Screen Navigator, see “Checking Control/AV Connections.” 
2. For Touch Screens, see “Connecting a Device to the Network.” 

 

2.10.7 Troubleshooting Driver Creation 
The following table lists troubleshooting problems when creating Control4 drivers. 
 

Symptom Possible Problems and Solutions 

IR Learning is not working 

1. A Controller must exist in the project to run IR Learning. Add a Controller. 
2. The process of capturing IR codes is very sensitive to lights, such as 
sunlight, fluorescent lights. If it is not working properly, turn off the lights or 
cover the physical hardware so that the light cannot interrupt the code capture. 
For a complete list of IR capturing guidelines, see “Guidelines for Capturing IR 
Codes.” 

 

2.10.8 Troubleshooting Dimmers, Switches, and Keypads 
The following table lists troubleshooting problems with Control4® system Dimmers, Switches, and 
Keypads. 
 

Symptom Possible Problems and Solutions 

Dimmers, Switches, or 
Keypads are 
not behaving correctly 

1. Reboot. Try rebooting the device by tapping the top button 15 times. On the 
6-Button Keypad, this is the top left button. This action reboots the device, but 
does not clear programming associated with the device. 
2. Reset. 
     a. Tap the top button 5 times. 
     b. Tap the bottom button 5 times. 
     c. Tap the top button again 5 times. If you are using the 6-Button Keypad, 
this is the top left and bottom left button. This clears all your network 
connections. 
     d. Go back into the Connections view > Network tab, and identify the 
device again after resetting. 
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2.10.9 Cannot Identify the Device to the Network 
This section provides troubleshooting instructions to identify a Control4® system device on the 
network. 
  
If you cannot identify a device on the network, follow these steps until the problem is resolved: 
1. Make sure the Control4 Controller is identified in Composer Pro. In the Connections > Network 

tab, see the line item for the Control4 Controller. Is there a network address for the Controller? 
2. (Controller only) In System Design, select the Controller object to check the Zserver status. Is the 

Zserver running? If not, click Enable. 
3. If the Control4 Controller is identified and Zserver is running, check whether any other devices 

identify. Do they? 
• If yes, a problem exists with the individual device. On Switches, Dimmers, and Keypads, if 

you tap the top of the button 9 times, the bottom 9 times, and the top 9 times again (pause for 
a breath in between each 9 count), this will reset the device. Doing the same thing with 7, 4, 
and 7 will make the device’s LED flash the channel it’s on (if it’s on channel 14, it will flash 14 
times). If the channel doesn’t match the one for your System Remote Control and Controller, 
the channel will need to be changed. Call Control4 Technical Support. 

 
Note: For Release 1.8 and later, ZigBee Pro devices choose one (1) channel. Control4 
recommends that you not change the channel; Zserver determines which channel to use 
automatically based on the available frequency space. Refer to the Composer Pro 
Software Release Update Instructions - 1.7.4 to 1.8.2 on the Control4 Knowledgebase or 
on the Dealer website for details. 

• If no, some other devices in the house may be causing interference. Power down any 2.4 
GHz devices, such as microwaves and cordless phones. Continue to the next step. 

4. Will the devices identify now? 
• If yes, something in the house is causing interference. Replace whatever it is, or reset the 

channel on all of your devices. You cannot reset the channel on Wireless Dimmers, 
Switches, etc., at this time. Call Control4 Technical Support. 

• If no, a problem exists with the Controller’s radio transmitter. Call Control4 Technical 
Support. 

2.10.10 Troubleshooting the Upgrade Process 
Follow these guidelines if you are experiencing Control4® upgrade or update problems.  

2.10.10.1 Basic Troubleshooting Guidelines 
1. Reset the device’s network settings. See “Resetting the Control4 System.” 
2. Attempt to have the update successfully downloaded while connected to a different network or by 

using a USB drive update (see “Information About Older Releases”). 
3. Allow the device to retry downloading the update as it automatically restarts and retries it. 
4. Is the defect install/update related to an ongoing system operation? 
5. Media not available? If it is a USB drive or network file share, make sure it is mounted (use the 

System Design view). If the media is on USB drive connected to a Secondary Controller, re-scan 
the media for that device. 

6. Navigator not connected to Director? Reconnect Navigator to Director. 
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7. Are strange things happening to the devices?  
• Make sure all ZigBee devices are updated to the latest firmware.  
• Make sure Director and Composer Pro are using the same version. 
• Disconnect and identify any problematic devices again.  
• Powercycle all IP devices. 
• Be patient. 

8. Turn on Diagnostic Logging (in Composer Pro, Tools > System Diagnostics > Logging > Start). 
Use the Logging tool to determine what was happening on the system. Can you duplicate it, and 
is there a workaround? For details, see “Logging Diagnostics Information.” 

  
Tip: Report any problems during the update process to:  

  
Control4 Technical Support: http://www.control4.com/residential/products/resources/#techsupport  
Email: support@control4.com 
Telephone: 1-888-400-4072 
 

Status Message  Description Resolution 

1. Device IP address detected with 
a different version — update 
needed. 

The Director discovered a device 
that is a different version than the 
Director box. 

Perform update. 

2. Device IP address indicated it 
needs to be updated.  

The device sent a status message 
to the Director that says it needs to 
be updated. 

Perform update. 

3. Finished update attempt. 

Current update is completed. A 
separate message notifies you of 
how many devices succeeded or 
failed. 

(Status message only) No action is 
required. 

4. Update information was missing 
or invalid. Reinstall the files for the 
USB drive, and attempt the update 
again. If the problem persists, 
contact Technical Support. 

A Director could not find the 
matching update information for a 
device retrieved from the USB 
drive. This would be the case if files 
were deleted from the USB drive. 

Re-install the files for the USB 
drive, and attempt the update 
again. If the problem persists, 
contact Technical Support. 

5. Update information was missing 
or invalid. Contact Technical 
Support.  

The Director could not find the 
matching update information for a 
device retrieved from the Web. The 
database contains invalid data. 

Contact Technical Support. 

6. Director device is not yet 
identified. Please identify the 
Director device and attempt the 
update again. 

The system has not yet discovered 
the Director device. 

Identify the Director device, and 
perform the update again. 

7. Starting update to version 
<targetVersion>. Director version is 
<version of Director>. 

An update has started.  (Status message only) No action is 
required. 

8. Detected USB device containing 
update information. The USB 
device will be used for the update.  

The system has detected a USB 
drive. 

(Status message only) See "Update 
from 1.3.x Release with a USB 
Stick" in “Information About Older 
Releases” for information about 

http://www.control4.com/residential/products/resources/#techsupport�
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Status Message  Description Resolution 
updating with a USB drive. 

9. Device <ipaddress>: <Status 
data received from the device> 

The system received data from the 
device.  

(Status message only) No action is 
required. 

10. Updated: <number of updated 
devices> Failed: <number of failed 
devices> 

Follows the message “Finished 
update attempt” (number 3) to 
provide specific details. 

Reconnect, re-identify, and restart 
the update. 

11. Device <ipaddress> failed to 
update. 

Provides the specific IP address of 
any device that failed to update. 
Follows the message number 10 
when applicable.  

Try to identify the device again, and 
try the update again. If not 
successful, contact Technical 
Support. 

12. Failed email results to <entered 
email address>”. Error was: <error 
number>. Verify that the VPN is 
correctly setup and functioning on 
your Director box and that a valid 
mail address was entered. Contact 
Technical Support if this problem 
persists. 

This is called if an error is returned 
when trying to send the summary 
via email. 

Verify that the VPN is correctly set 
up and functioning on your Director 
box, and that a valid mail address 
was entered. Contact Technical 
Support if this problem persists. 

13. Unable to obtain update version 
information from the Web interface 
at URL <url used for getting the 
version, i.e., http://webdev-
1.control4.com/...>. Verify that 
Internet access is available from 
Director. 

System has not received the 
version information back from the 
database.  

1. Ensure that you can 
communicate to the Internet to the 
Website from your computer. Use a 
prompt box to ping the address. 
2. Ensure that you can connect to 
the Control4 Controller through the 
Local Area Network. 
3. Ensure that a firewall is not 
blocking the update. 
4. If you still cannot update, use a 
USB drive for the installation. 

14. Detected devices that still need 
to be updated. Restarting the 
update process. 

To allow an update to propagate 
throughout the system, the system 
waits 5 minutes after the start of the 
update before checking the status 
of connected devices. If outdated 
devices are still detected, this 
message is sent, and the system 
restarts the update process. 

(Status message only). No action is 
required. 

15. The information on the USB 
drive is invalid. Reinstall the update 
on the USB drive and attempt the 
update again. 

The system cannot parse the 
update-info.html file on the USB 
drive. The file is not valid xml.  

Re-install the update on the USB 
drive, and attempt the update 
again. 

16. Not enough free space on file 
system to store update information. 
Disk free = <amount of free space> 
needed = <space needed>.  
Remove stored media, log files, 
etc., and attempt the update again.  

There is not enough free space on 
the box running Director to store 
the largest set of packages for a 
device type.  

Remove the stored media, log files, 
etc., and attempt the update again. 

17. Unable to access the directory 
for update information. Please 

System cannot access the 
/packages directory. Either the disk 
has a serious problem, or the 

1. Ensure that you can 
communicate to the Internet to the 
Website from your computer. Use a 
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Status Message  Description Resolution 
contact Technical Support.  mounts didn’t work right.  prompt box to ping the address. 

2. Ensure that you can connect to 
the Control4 Controller through the 
Local Area Network. 
3. Ensure that a firewall is not 
blocking the update. 
4. If you still cannot update, use a 
USB drive for the installation. 

18. Out of file space for packages.  

Ran out of disk space while 
downloading the software 
packages. The update fails, then 
restarts after 5 minutes, and the 
“Not enough free space” message 
(number 16) displays. 

Remove the stored media, log files, 
etc., and attempt the update again. 

19. Device <ipaddress> failed 
because it reported a status of 
<reported device status>. 

The device reported that it failed to 
update. 

Try to identify the device again, and 
restart the update. If it fails again, 
contact Technical Support. 

20. Touch Screen device at <IP 
address> must be docked before 
upgrading. Please dock the Touch 
Screen and restart the update. 

A Wireless Touch Screen was not 
properly seated in its dock when 
the update started. 

Please dock the Touch Screen, and 
restart the update. 

 

2.10.10.2 Diagnosing Trouble Spots 
Use the Control4® System Diagnostics tool in Composer Pro to view, monitor, and troubleshoot a 
Control4 system. 
 
These sections provide information about system diagnostics. 
 “System Diagnostics Tool” 
“System Diagnostics Interface” 
“Viewing Controller Performance Information” 
“Using the Controller Networking Information” 
“Using System Information” 
“Logging Diagnostics Information” 

2.10.10.2.1 System Diagnostics Tool 
Use the Control4® Composer Pro System Diagnostics tool to view, monitor, and troubleshoot a 
Control4 system. 
 
To access the System Diagnostics tool: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, select System Diagnostics. The tool is available over a LAN connection 

using remote access. 
3. Use the tool to diagnose problems on your own, or capture and send information to Control4 

Technical Support. 
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The diagnostics information is organized into four (4) tabs: 
1. Controller Performance 
2. Controller Networking 
3. System Info 
4. Logging 

  
The Control4 system includes many devices running embedded operating systems communicating 
over a wired or wireless network. During installation, configuration, and troubleshooting, the ability to 
look at the overall status of the components becomes very useful. 
  
The System Diagnostics tool lets you gather system information to help you determine if any issues 
encountered are configuration problems, performance issues, or potential defects. 
 

2.10.10.2.1.1 System Diagnostics Uses 
Possible uses of the System Diagnostic tool include: 

• Viewing Controller Performance information: 
• CPU usage 
• CPU usage history 
• Memory usage 
• Memory usage history 
• Processes running 

• Viewing Controller Networking information: 
• Network type 
• Connection status 
• MAC address 
• IP address 
• Subnet mask 
• Gateway  
• DHCP status 
• DNS server information 
• View system information 

• Viewing System Information: 
• Detailed lower-level information about the devices listed 

• Viewing Logging information: 
• When troubleshooting a problem that is reproducible, use the System Diagnostics tool to 

capture logged information while reproducing the problem to email to Control4 Technical 
Support. 

• When troubleshooting a problem that is not reproducible, connect the Controller, enable 
logging, and allow the logging to continue running for a specified period of time to capture 
the problem. The logs are then captured and emailed to Control4 Technical Support. 
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2.10.10.2.2 System Diagnostics Interface 
Use the Control4® System Diagnostics tool in Composer Pro (Tools menu > System Diagnostics) to 
view the interface and these tabs: Controller Performance, Controller Networking, System Info, and 
Logging. 

  
• Controller Performance—Lets you view Controller performance information, including CPU 

and memory usage. 
  

1. Click the History button to view the history of the CPU and memory performance. 
  

 
  

• Controller Networking—View Controller networking information, including network type, 
connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and 
DNS server information. 

  
2. Click the Test Internet Connection button to test the current Internet connection. 
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• System Info—View detailed System information. 
  

3. Click the Save to File button to specify the location and filename for a text-file version of the 
output. 

  

 
  

• Logging—Log system problems. 
  

4. Click the Start Logging button to indicate what type of logging you want displayed, and then 
allows you to “Start” the logging process. 
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5. Click the Stop Logging button to stop the tool from logging information. 
6. Click Open Controller Log to view the logged information in a file. 

2.10.10.2.3 Viewing Controller Performance Information 
Use the Control4® Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) to 
view Controller performance. 
  
The Controller Performance tab contains information regarding CPU and memory utilization for the 
Primary Controller of the project. Asynchronous messages from the Director regarding its current 
state are also displayed. 
 
To view Controller Performance information, including CPU and memory usage: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, select System Diagnostics. The Controller Performance tab is viewable 

by default. 
3. View information displayed on the Controller Performance tab: 

• CPU Usage—Shows a graphical form of current CPU usage and CPU usage history for the 
Primary Controller, which is the Control4 Controller used to control the system if multiple 
controllers exist on a system. 

• Memory Usage—Shows in graphical form the current memory usage and memory history for 
the Primary Controller. 

• CPU and Memory Usage by Component—Shows percentages of CPU and memory use 
per component. 
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4. Refresh the screen or update the speed. To do this, from the View menu you can: 
• Refresh Now—Restart the real-time display of CPU and Memory usage. 
• Update Speed—Change the speed to High, Normal, Low, or Paused. 

5. View the Directory messages by clicking the History button. 

2.10.10.2.4 Using the Controller Networking Information 
Use the Control4® Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) to 
use Controller networking information. 
  
View the information, including: 

• Network type 
• Connection status 
• MAC address 
• IP address 
• Subnet mask 
• Gateway 
• DHCP status 
• DNS server information 

 
To use Controller Networking information: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, select System Diagnostics, and then click the Controller Networking 

tab. 
3. Ensure that the network information shown is reflective of your network. 
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4. To test your Internet connection, click the Test Internet Connection button. The screen displays 
the current status of networking services, including the CD & DVD Lookup Service, Media Web 
Service, and Updates Web Service. 

  
This screens shows that the example services failed. 

  

 
  

5. Click Close to exit the dialog box. 
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2.10.10.2.5 Using System Information 
Use the Control4® system Composer Pro System Diagnostics tool (Tools menu > System 
Diagnostics) to use system information. 
  
View System Info current configuration settings, state of the Primary Controller and any other Control4 
device in the Control4 system’s current project. The information displayed is a summary of several 
commands. 
 
To use system information: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, select System Diagnostics, and then click the System Info tab. 
3. Select a device or sub-category (expanding the list as needed) in the left pane to display the 

system configuration information in the right pane. 
  

 
  

4. To save the displayed information to a file, click Save to File and specify the location and name 
for the file. 

2.10.10.2.6 Logging Diagnostics Information 
Use the Control4® system Composer Pro System Diagnostics tool (Tools menu > System 
Diagnostics) to use the logging feature and log files. 
  
View Logging to configure, start, stop, and schedule diagnostic logging of the Control4 system. 

• Capturing Information While Reproducing a Problem—When troubleshooting a problem 
that is reproducible, use the System Diagnostics tool to capture logged information while 
reproducing the problem to email to Control4 Technical Support. 

• Enabling Logging for Debugging—When troubleshooting a problem that is not 
reproducible, connect to the Controller, enable logging, and allow the logging to continue 
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running for a specified period of time to capture the problem. The logs are then captured and 
emailed to Control4 Technical Support. 

• ZigBee and I/O Communications—These items are available for logging in System 
Diagnostics. 

• DirectorState.corrupt—If for any reason Director is unable to load a project file, it is saved 
to DirectorState.corrupt prior to loading a clean project file (Tools > System Diagnostics > 
Logging). 

 
To use system logging: 
1. Start Composer and connect to a Director. 
2. From the Tools menu, select System Diagnostics, and then click the Logging tab. 

  

 
  

3. To enable logging, click Start Logging, and then choose whether to save the information 
currently displayed (if any). 

4. Select the logging categories, and then click Start. The results are displayed. 
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5. (Optional) To save the log, but continue logging the results, click Clear Output. The logging 
feature remains enabled, but a Save As dialog box lets you specify the location and name of the 
text version of the log. 

6. (Optional) To save the log and disable the logging process, click Stop Logging. The logging 
feature is disabled, but a Save As dialog box lets you specify the location and name of the text 
version of the log. 

7. To view the Controller Log, click Open Controller Log. 

2.11 Information about Older Releases 
Some Composer Pro tasks may refer to older software releases (prior to OS 2.0) for the Control4® 
system. See the sections below (Release 1.3 and earlier and Release 1.8 and earlier) or refer to the 
Release Notes for a particular release. 

2.11.1 Release 1.8.x and 1.7.x 

2.11.1.1 Release 1.8.2 
• Navigators. Resolved focus issues which were fixed in Release 1.7.4 but not included in 

Release 1.8.2.56194 due to release timing. 
• Dock for iPod. Resolved a problem where the Control4 Dock for iPod would prematurely 

stop playing music when it was being used in a multiple room session and rooms left the 
session.   

• Rhapsody. Resolved the problem with the Rhapsody agent always being re-enabled (if it had 
been disabled) when Director loads the project. 

• Composer. Fixed the issue with the ‘Project is Locked’ message which would occasionally 
occur even if the Controller was not being updated. 

• ZigBee Server. Fixed a problem where the ZigBee Server would not talk to the ZAP if its IP 
address changed. Other minor fixes to improve ZigBee Server are also included. 

• Thermostat Firmware/Driver.  
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• The minimum separation between the Heating/Cooling Engage and Cutoff points has 
been reduced from two (2) degrees to one (1) degree Fahrenheit.  

• Improvements to the Control4 Thermostat’s ability to control residential heat pump 
systems.  

• New Advanced Properties: Disabling The Call For Auxiliary Heat—Setting the Auxiliary 
Heat Stage Delay to 255 will prevent the Thermostat from making a call for auxiliary heat. 
Values in the range of 0 to 254 will be the number of minutes the Thermostat engages the 
heat pump before calling for auxiliary heat. 

• New Advanced Properties: Heat Pump and Auxiliary Heat Overlap—The Auxiliary Heat 
Cutoff Delay is the length of time in seconds that the Thermostat allows concurrent 
operation of the heat pump and auxiliary heat. A value of 255 will cause them to run 
together indefinitely (subject to maximum run times and/or achieving the goal 
temperature).  

• Card Access. Updated Card Access firmware for the Wireless Contact Relay and Heavy 
Duty Power Switch devices that enables them to support parenting functionality. This change 
will benefit installations with sparse meshes that are using these Card Access devices to 
extend the mesh. 

• Black & Decker Smart Code Door Locks. 
• Improvements were made to the Black & Decker Door Lock driver and firmware 

(01.05.00). 
• The Black & Decker door lock doesn’t update until after 3 AM; a message “update failed” 

will appear until the update takes place. The following functionality does not work until the 
locks have been completely updated: 

o Email notifications 
o Incorrect status feedback – UI and Composer Pro 
o Is controllable from Composer Pro and bound to a keypad  
o Message “Unknown response from lock” appears in the last status message 

dialog box in Composer Pro  
o Firmware Version will state “Not Connected” 

• Media. Changed the media lookup service to c4lookup. 
• Security. Added a check to the SSL server certificate creation to detect a malformed 

certificate. If detected, the server certificate will be recreated automatically when the 
Controller is rebooted. This corrects the occasional occurrence of "project locked" when not 
being updated. 

2.11.1.2 Release 1.8.0 
• Agents 

• The Composer Pro Timer agent interface has been updated to allow for specification of 
timer duration in a more flexible way. Timer selection is now in the format hh:mm:ss. 

• Now include Control4 system and user-defined variables in the templates created using 
the E-mail Notification agent.  To use this new capability, the Installer can create or 
modify email templates using Composer Pro, Agents, E-mail Notification, and then use 
the ‘Add Variable’ option. 

• Deleting the Timer agent doesn’t remove the programming. 
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• Audio 
• Fixed a problem where using the Apply To button to set parametric equalizer settings on 

the Amplifier settings were not getting set correctly. 
• Channels 

• In Control4 Software Release 1.7.0 and previous versions, Dealers used multiple ZigBee 
Servers running on different channels to enable more responsive and higher node count 
(or distributed) EmberNet networks. With ZigBee Pro, only one channel is used for the 
entire system. The channel is selected automatically based on an RF energy scan at the 
time that the ZigBee Pro network is established; but it can be changed manually. Multi-
ZAP configurations automatically and seamlessly provide the benefits that used to be 
realized by multiple Zserver and channels. 

  
Prior versions of Control4 systems used Channels 1-14. With ZigBee Pro, the channel 
numbering now uses Channels 11-26 in order to comply with the channel numbering 
specified in the ZigBee Pro standard. The actual channel frequencies are the same 
throughout. The new channels are the same as the old channel number + 11. Example: 
The default channel was 14 on which all EmberNet devices were shipped. 

  

In ZigBee Pro, it is now channel 25 (14+11=25). The ZigBee channel number can be 
changed any time as long as the Control4 system is not being updated. All ZigBee Pro 
devices on the mesh network automatically move to the new channel. 

• Controllers 
• Fixed a problem where the Announcement agent was not showing the Home Controller 

HC-200 as a video end point. 
• Diagnostics 

• Corrected the ‘Test Internet Connection’ feature in System Diagnostics so that it doesn’t 
return invalid failure notices. 

• Drivers 
• Added a driver for Black & Decker locks. 

• Keypads 
• When programming a conditional on a Keypad, we now include the Keypad name in the 

programming script. 
• Lighting 

• Implemented multicast Lighting Scenes in conjunction with the ZigBee Pro firmware. Each 
device stores information about its defined behavior in up to 32 different Lighting Scenes. 
When you execute a scene, a multicast is sent to all devices on the mesh.  Devices 
immediately respond based on their defined behavior, eliminating “popcorn” lighting. 

• Added an option to the Properties page of the 2-button, 3-button, and 6-button Keypads 
to ‘Follow Bound Color.’  This is the default configuration, and has been the only option in 
previous releases. In this configuration, the Keypad LED colors are set based on the 
device to which they are bound using button-link connections. New with Release 1.8.0, 
Installers can uncheck this option. This lets the Installer specify the on/off colors for the 
Keypad LEDs independently of the device to which they are linked. 

• Added double- and triple-tap events to the Control4 Dimmers, Switches, and Keypads. 
When you tap a button consecutively two (2) or three (3) times for about one-half of a 
second, these events fire.  Now you can use these events for programming without 
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requiring the more complex programming logic tied to timers and button Press / Release 
events. 

  
Note: When programming using double and triple-tap events, be aware that Press and 
Release events also occur when double and triple-tap events occur.  Plan your 
programming using these events so that they don't conflict with the intended outcome. In 
most cases, when using double and triple-tap programming events, don't program on the 
Press and Release events. 

• Network 
• Added a new Network Tools menu. We replaced the Network Status menu with enhanced 

functionality including tree views. 
• System Remote Control. Added programming events to the System Remote Control SR-

150 and SR-250 ‘Watch’ and ‘Listen’ button presses.  This lets the Installer use Control4 
programming to define room-specific behavior when the Watch / Listen buttons are pressed. 
The Watch / Listen button options now include: ‘No Action’ (new – used for programming 
your own behavior), ‘Select Most Recently Used Device,’ and ‘Show Device List.’  You can 
select the desired behavior using the Composer Pro System Design view. Programming 
triggered by the Watch and Listen buttons is performed using the room events. 

• Thermostat 
• Undershoot/overshoot configuration now applies to both heat and cool. With the updated 

Thermostat firmware, the ‘undershoot’ and ‘overshoot’ settings are now used to determine 
when the Thermostat will call for heating and cooling. 

  
Previously, the overshoot setting was only used for determining when to disengage the 
heat, and the undershoot setting was only used for determining when to disengage the air 
conditioning.   

  

With Release 1.8.0, the undershoot setting determines when both the heating and cooling 
systems are engaged, and the overshoot setting determines the cutoff for when the heating 
and cooling systems are disengaged. 

  

Examples: 

Heating – Set point set to 72.  With an undershoot of 1, the heater will engage at 71 
degrees.  With an overshoot of 1, the heater will cut off at 73 degrees. 

  
Cooling – Set point set at 78.  With an undershoot of 1, the cooler will engage at 79 
degrees.  With an overshoot of 3, the cooler will cut off at 75 degrees. 

• Third-Party devices. The following third-party devices are no longer documented in Control4 
documentation. Refer to Release 1.8 and earlier about configuration information for these 
devices. 
• VLinx Serial Server. Appendix C: Configuring Devices, "Add a VLinx Serial Server to 

Expand Serial Control" has been removed from the Composer Pro User Guide and online 
Help. 

• HVAC devices. 



 

Composer Pro User Guide 
 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 
Saved: 1/20/2012 1:31:00 PM 200-00005 Composer Pro 

User Guide Part 1 
Page  182 of  199 

 

 

2.11.1.3 Release 1.7.3 
• Updated firmware for the 4-Zone Amplifier, with the following changes: 
• Better fan speed control (less fan “noise”) 
• Input gain control from front panel 
• Power save enable/disable from front panel 
• Balance control from front panel 
• Shorted output detect 

2.11.1.4 Release 1.7.2 
• Polling. Removal of “polling” functionality from Director: With the introduction of Control4’s 

1.6 system software, functionality was added to the system for polling dimmers to determine 
their current light level.  Now, with the 1.7.2 release, Control4 has removed polling 
functionality from Director.  Each time the Dimmer light level changes, the system is 
automatically notified.  This improves graphical navigator tracking of light levels and linked 
keypad LED tracking. 

• Drivers. A new security driver for the GE Networx NX8-587E virtual keypad interface (added 
to the Online Database for drivers). 

• Commands. Added a device-specific programming command to the Control4 Dock for iPod 
driver which allows the LED on the dock to be turned on/off using programming.  Please note 
that the LED will automatically turn on when the Identify button is pressed. 

• Dimmers. In conjunction with the support for the new Control4 Wireless ELV Dimmer, on all 
Control4 Dimmers you now have the ability to configure a load profile. While the load profile 
settings are primarily intended for the Wireless ELV Dimmer, they also work on the standard 
Dimmer.  Specifically, you can use Minimum On Level (%) for Dimmers that have a dimmable 
fluorescent (or CFL) load.  This changes the dimming range so that the 0-100% seen by the 
user starts at the Minimum On Level %.   

• Touch Screens. Resolved problem where the 7” Touch Screen buttons would stop working if 
the Touch Screen was rebooted or lost, and regained its network connection while the 
system was still running. 

• Zones. 
• Resolved problem where phantom audio zones would remain displayed on the Zones 

page of a Touch Screen if a network message wasn’t received. 
• Resolved a problem with the zone feedback from an HAI OmniPro security panel 

incorrectly displaying off by 1. 
• Thermostat. Resolved a problem whereby using Composer HE or Composer Pro’s device 

control for a Control4 Thermostat would set the mode to Off. 
• Screen Saver. Enabled photo Screen Saver for Home Controller HC-200, HC-300, and HC-

500 operating in PAL display mode. 
• IP Cameras. Resolved problem which prevented IP Cameras from being hidden or re-

ordered using Composer Pro. 

2.11.1.5 Release 1.7.1 
• Support for the Control4 Dock for iPod hardware release. 
• Support for the 7" Wall-Mount Touch Screen. 
• Support for ISO file scanning using the Video Media interface on network file storage devices. 
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• Improved functionality for the Watch / Listen buttons on the System Remote Control SR-250. 
With the 1.7.1 release, you can choose between two modes of operation for the Watch / 
Listen buttons on the SR-250.  You can select either the toggle most recently used mode or 
the new device list mode of operation. This configuration is selected using the Composer 
properties page of the SR-250.  If you choose to utilize the device list mode of operation, use 
the Navigator tab (in Composer Pro, System Design) for the room you are controlling to 
configure the device visibility and display order for these menus. 

• Support within Composer Pro and driver Web service to enable the downloading of 
DriverWorks drivers from the online driver service. 

• Support for inter-command delay in one-way serial drivers. 
• Fixed bug that didn’t allow the debounce timer in the sensors drivers to be enabled. 
• Fixed bug that caused the sunrise/sunset “next occurrence” values to be incorrectly set on a 

new project after the previous project was cleared. 
• Fixed bug that prevented the selection of playlists after a media scene was deactivated. 

2.11.1.6 Release 1.7.0 
• Media Player and digital video file support. The 1.7.0 release introduces support for Media 

Player devices and the ability to select digital video files from Navigator for playback through 
Media Player devices.  The Media Player devices can be found under the A/V section of My 
Drivers in Composer Pro’s System Design view.  The Media Player device type 
encompasses A/V devices that have the ability to playback or decode digital video files for 
playback through standard A/V equipment.  Release 1.7.0 includes support for the Netgear 
EVA8000 as a Media Player.  Digital video files can be stored on a Network File Storage 
device in a Control4® system, configured with associated meta-data in Composer Pro’s 
Media view and can be selected from Navigator’s Video menu.    

• Import DVD List from File. In Composer Pro’s Media view, any Disc Changer can now 
quickly and easily be populated with all of the meta-data associated with the DVDs stored in 
the Disc Changer.  By right-clicking on the Disc Changer in the Media view and selecting, the 
“Import DVD List from File” option, Composer Pro will automatically populate the slots of the 
Disc Changer with the DVDs stored in each slot as listed in the file that is imported.  The 
imported file must be a CSV (comma separated value) file listing the slots and the titles of the 
DVDs, one per line.  This file can be created using a simple text editor or spreadsheet 
program by exporting a spreadsheet file in a CSV formatted file.  This new feature provides a 
simple and easy way to quickly configure all of the DVDs in any manufacturer’s Disc 
Changer. 

 

Example formatting for CSV file: 

1, Toy Story 

2, The Incredibles 

3, The Perfect Storm 

• Composer. 
• Composer Pro support for 64-bit edition of Windows Vista. 
• Composer Pro may not automatically reconnect during update – During the update to 

1.7.0, Composer Pro may not automatically reconnect to the controller.  If this is 
encountered, disconnecting and reconnecting to the controller will allow you to resume 
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monitoring the update status.  It is not required to be connected for the update to 
proceed. 

• Info Tab.  
• All important information relative to a customer’s project can now be stored in the project 

in Composer Pro’s Info tab. 
• When viewing the System Design view, you will find the Info tab next to the Properties 

and List View tabs in the middle pane of the window. 
• Information about the system owner, the dealer, installer, all relative contact information 

and specific notes regarding the system’s configuration can all be saved in the project 
when entered in Composer Pro’s new Info section. 

• Touch Screens. 
• Programmatically changing backlight levels on a Touch Screen when in screen saver 

mode now executes as programmed. 
• Mini Touch Screen waking up from screen saver may incorrectly display top buttons – If a 

Mini Touch Screen is configured to wake up from the screen saver and go to a default 
view that is other than the main view such as the lighting or music view, the top row of 
buttons along the top of the Mini Touch Screen’s display may be displayed incorrectly. 
 Going back to the home screen will reset this display. 

• LED Colors. Custom colors are now persistent in the custom color list for Dimmer, Switch 
and Keypad LED color configuration. 

• Agents. 
• Several configurations of announcements or deselecting the “Show OK” button in 

Composer Pro’s Announcement Agent view could cause Composer Pro to crash in 1.6.0. 
This issue is now resolved. 

• Images used in the Announcement Agent and in the web images from the camera driver 
should be no larger than 300 KB – The display of images in the Announcement Agent 
and the display of web images through the web images camera driver is designed to work 
with small images commonly used on websites or in graphical user interfaces.  The 
recommended size for these images is 300 KB or less.  Larger images will be scaled to 
the required size for Navigator but this scaling process for very large images can cause a 
Mini Touch to restart. 

• Deleting an agent configuration may not delete all associated programming – When 
deleting an agent, please confirm that all associated programming is also deleted.  It may 
be required to manually delete some elements of associated programming. 

• Events. 
• Using a randomized time for a scheduled event start time now properly uses a 

randomized time value. 
• In the 1.6 version of Composer Pro, the issue of seeing Scheduler events duplicated in 

the Scheduler Agent view has been resolved. 
• Variables. 

• Container variables in Media Scenes or connection outputs on an Amplifier now function 
as configured.  An issue was discovered with this type of configuration in 1.6.0. 

• Use of random numbers is programming variables has been improved. 
• Container variables and lights – As with previous releases, we recommend that you not 

utilize container variables for lighting. The 2-way feedback from the individual lights can 
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cause undesired light level oscillation when a light level is adjusted and multiple light 
loads are included in a container variable. 

• Blinds. The Somfy blinds’ Stop option was incorrectly grayed out in Composer Pro.  This 
function is now available and functional. 

• Thermostat. Selecting the “Locked” radio button on the Control4 Thermostat properties page 
did not work properly.  It now reflects the state properly. 

• Media Scenes. 
• In some configurations, Composer Pro may lock up and/or crash when selecting Media 

Scenes in previous releases. This issue has been resolved. 
• Controlling volume for whole session using zones page with Media Scene will cause 

volume control problems – When using a Media Scene with volume control tracking 
enabled will create volume control problems if trying to control volume from the session 
controls in the Zones page.  This configuration should be avoided in situations where the 
zones page is used and volume tracking is enabled. 

• Wakeups. An error not allowing a Wakeup to be executed during the hour of 12 PM has 
been fixed.   Attempts to configure this in 1.6 would revert to 12 AM instead of 12 PM. 

• Audio Matrix Switch. The Audio Matrix Switch no longer increments by 8 when increasing 
the volume in a room with the Audio Matrix Switch configured as its audio endpoint. 

• Conditionals. Programming conditional “If time is day time” or “night time” may not execute 
correctly within one minute after sunset – If programming exists that is triggered at sunset or 
sunrise and then other programming exists that is triggered immediately upon this change 
that executes the conditional on day time or night time, the change may not be immediately 
recognized.  It may take up to a minute for this programming to execute correctly on the 
change from night to day or from day to night. 

• Home Theater Controllers 
• Home Theater Controllers with 128 MB of internal storage should not be used as primary 

controllers in multi-controller projects – Home Theater Controllers produced earlier than 
December 2005 had 128 MB of internal storage. Home Theater Controllers produced 
subsequent to that date have 256 MB of internal storage (use System Diagnostics, 
System Info, HTC, disk free to check disk space) in the Home Theater Controller.  Using 
a Home Theater Controller with 128 MB of internal storage as a primary controller in a 
multi-controller system is not recommended.  There is insufficient internal storage to allow 
Update Manager to update the entire system.  There is no problem using an HTC with 
128 MB of storage as a secondary controller. 

• Using multiple audio outputs simultaneously on a Home Theater Controller or Media 
Controller when Navigator is running simultaneously may cause audio playback to skip – 
In systems with multiple audio zones with the HTC or MC used as audio endpoints, it is 
recommended that these controllers do not run Navigator simultaneously. 

• Home Theater Controller may take a long time to update – In some projects, we have 
found that the Home Theater Controller may take up to two hours to complete the update. 
If you suspect a problem, please let the controller continue to attempt to update for at 
least two hours. If the issue persists, please attempt to recover the controller using the 
USB Recovery Utility. 

• ZigBee. ZigBee firmware update when using an HC-300 as Zserver may not successfully 
finish the ZigBee firmware update – Some of the early HC-300s may exhibit a slow or halted 
ZigBee firmware update.  If you encounter these issues, please contact technical support for 
additional assistance. 
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• Analog. Streaming an analog source from audio input on a Controller to a WiFi audio 
endpoint is limited to one stream – Audio signals that are processed through the analog input 
on a controller are processed as a PCM stream and require much more bandwidth than 
streaming an MP3 stream to a WiFi audio endpoint.  In this configuration, Control4 
recommends that only one stream be used at any one time. 

• Hybrid Devices. Firmware on hybrid devices didn’t update? – The Multi Channel Amplifier, 
Audio Matrix Switch, Multi Tuner, and Contact Relay Extender can be configured using IP or 
ZigBee.  However, in order to receive a firmware update, they must be configured and 
connected via IP only.  If they show up in the Connections->Network Identification screen as 
being identified as both IP and ZigBee, then the ZigBee connection needs to be 
disconnected. If they were previously configured as ZigBee and have been changed to IP, 
but are still not updating, you may need to restart Director (use System Manager to Disable 
and then Enable). 

• USB stick. Scanning a large USB hard drive appears to hang Composer Pro – If you attach 
a large capacity USB hard drive (230 GB of MP3s used in this example) to an HC-300 and 
scan that drive, Composer Pro will appear to lock up and the system will appear to become 
unresponsive. This is not true.  Though the system appears to be locked up, it is processing 
the data necessary to perform the scan.  After you press the Scan button, this scenario will 
play out as follows: 
• Preparing to scan, Director Status: Idle, Connected for a second then: 
• Preparing to scan, Director Status: Idle, Disconnected for about 60 seconds then: 
• Preparing to scan, Director Status: Comparing Files with Database for about 10 or more 

MINUTES then: 
• Scanning, Director Status: Idle, Connected for another couple of minutes then you will 

finally see albums populating in the list. 
• Audio Endpoint. Static on Audio Output? – As a reminder, occasionally, when using the 

Home Theater Controller, Media Controller, Mini Touch Screen or Speaker Point as an audio 
endpoint, occasionally the devices will output static from one or both of the audio outputs 
when music is being played.  This can be resolved by power cycling the device.  The Mini 
Touch Screen’s click sound may also play very loudly, and sound very harsh. This is caused 
by the same root problem and power cycling the device will resolve it. Note: the devices need 
to be completely unplugged and not just rebooted for the audio device to reset properly. 

• Controller. Cannot register a controller with a “.” in the name – Due to network device 
naming conventions, it is not possible to successfully register a controller that has been 
configured with a “.” in the name of the controller.  Control4 advises dealers to avoid this 
configuration. 

• Zones. Hidden rooms show up as a blank line in Zones page – The hidden rooms that are 
used for audio distribution by Media Scenes show up in the Zones page on a blank line. This 
does not affect functionality. 

2.11.1.7 Release 1.3 and Earlier 
• Wireless Touch Screens. From the printed version of Composer Pro User Guide, Chapter 3, 

"Build a Project in System Design:" Previously, it was not necessary to add the Wireless 
Touch Screen in the Composer Pro project; however, this is now a requirement for versions 
1.3 and above. If you previously had a Wireless Touch screen on your system, follow the 
special update instructions at “Update the Wireless Touch Screen from Pre-1.3 Release." 

• Connecting Rooms: In the 1.3 Release, the method to assign the volume control in the room 
is using the priority End Points rather than the volume, as with earlier releases. With the 1.3 
Release, the use of Volume 1 and 2 for Volume management only when the Volume 
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management is different from the End Point as might be the case in different configurations, 
such as when a switch is part of the audio or AV path. To use the priority 1 or 2 feature (End 
Point or Volume), configure the highest-priority volume provider as the device that is least 
likely to be in the path. For example, a Television is always in the path, but a Receiver is not 
in the path unless one is added. Therefore, set the Receiver as the first device (Video 
Volume 1). 
• Audio End Points 1 and 2: With the 1.3 Release, the Audio End Points 1 and 2 also 

define the first and second device that handles Volume control for audio in the room. 
• Video End Points 1 and 2: Prior to the 1.3 Release, this option was the only way to 

manage video volume. 
• Video Audio End Point: With the 1.3 Release, the Video Audio End Point 1 and 2 also 

define the first and second device that handles Volume control for audio when watching 
video in the room. 

• Audio Volume 1 and 2: Prior to the 1.3 Release, this option was the only way to manage 
audio volume. Note that legacy projects might still contain Volume 3; however, this is no 
longer available in the 1.3 Release. 

• Latitude and Longitude. In the 1.3 Release, the longitude changed to make it consistent 
with worldwide conventions. Western hemisphere longitudes are now registered as a 
negative value rather than positive (they were all positive in prior releases). When your 
system is updated from 1.2.x to 1.3, this is automatically converted. However, if for any 
reason you load a backup project created with a prior release, this conversion does not take 
place. Your scheduled sunrise/sunset-based events still happen, but based on times 
appropriate for somewhere in the Eastern hemisphere. If it does not happen automatically, 
enter your zip code again to automatically correct your longitude value. 

• Media Scenes Agent: Prior to the 1.3 Release, if you wanted to put audio in multiple rooms, 
you needed to start a session, start a party, and add rooms. Do this each time you want to 
play music in multiple rooms. 
• Prior to Release 1.3.2, the following features were not supported: 

o Media Scene Status added —Shows activated, deactivated, or changed). 
o Discrete Volume setting available for a Scene—Used primarily with the Control4 

Multi Channel Amplifier. Works well with Tracking. Overrides Initial Volume. The 
source selections do not change the volume in a room. 

o Command “Last Selected Room” added—Activate a Media Scene based on the 
most recent room selected instead of the Last Source Selected default. 

o Event “When Scene changes” added. 
o Conditionals “If Activated” and “If Deactivated” added. 

2.11.1.7.1 Updates Earlier than Release 1.2.0 
For projects created prior to 1.2.0.91 (which was released on 9/21/2005), Control4 recommends that 
you re-create your project configuration. 

2.11.1.7.2 Update from Release 1.3 to 1.7.x from the Internet 
To update from 1.3.x to 1.7.x: 
1. Ensure that the existing installed Composer Pro version is 1.7.x. 
2. From the Tools menu, select Update Manager. 
3. Ensure that all devices that you want to update have been identified in your project before 

starting. The Update Manager dialog appears. 
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Possible states of the Update Manager: 

  
Idle—No upgrading is occurring. 
Updating—Upgrading of a device(s) is occurring. 
Update Pending—Upgrading of a device is stalled. See “Troubleshooting the Upgrade Process.” 

  
4. To begin the update, select Update. 
5. The Update System dialog appears. Click Begin Update. To cancel the upgrade, click Cancel. 

During the update, Director will disconnect from Composer Pro. 
6. A screen appears with status messages about the update. The status screen closes and Update 

Manager opens where you can check the update progress. The current update shows “Complete” 
in the Update Status column when each device has been updated. Devices that were not 
recognized as connected show as “Failed.” 

7. Wait for Update Manager to complete the full update process for all devices. 
8. Update Manager is done when the current version is correct for all devices—the status will show 

as Idle. Zserver updates continue for some time for all ZigBee devices. 
9. Reconnect to Director after the Controller restarts. 
10. Ensure that Director and Composer Pro are the same version. 
 
To update from Release 1.3.x using a USB drive: 
To use the USB drive install, first download from the Internet the USB install onto a computer, and 
then move it to a USB drive. A computer with at least 120 MG of free disk space that is formatted as 
FAT32 is required. 
  
The USB Install supports updates from version 1.3.0 to later versions. It does not support updates 
from versions prior to 1.3 (such as 1.2.5). 

  
To update using a USB drive: 
1. Download the USB Install to a local computer. 
2. Insert the USB drive into the computer. 
3. Run the file by double-clicking it for a wizard to appear. 
4. After the wizard is finished, insert the USB drive into the USB port on the Controller. 
5. Launch the USB Install in Composer Pro by going to Tools > Update Manager and selecting 

Update. The Update Manager detects the USB Install and indicates that it is using the USB Install 
for the update. 

 
To update the Wireless Touch Screen from a release prior to 1.3: 
Prior to Release 1.3, the Wireless Touch Screen — 10.5” was not part of the project. It is now a 
requirement to add the Wireless Touch Screen to the project so the update can update every device. 
 
1. On the Wireless Touch Screen, go to Info > About and write down the IP address of 
2. this device. 
3. Ensure you have successfully updated your system to 1.7.x. 
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4. In the System Design > My Drivers tab, double-click to add the appropriate Wireless Touch 
Screen to your project: 
• Mini Touch Screen 
• Touch Screen - 7” Wall Mount 
• Touch Screen - 7” Portable 
• Touch Screen - 7” Table Top 
• Wireless Touch Screen - 10.5” 
• Wireless Touch Screen V2 - 10.5” 
• In-Wall Touch Screen - 10.5” 

5. In the Connections view > Network tab, identify the device to the Control4 system. To do this, 
select the Wireless Touch Screen, and click Identify. When the Identify dialog appears, type in the 
IP address that you wrote down previously.  

6. On the Identify dialog, click Close. 
7. Launch the update to 1.7 (Tools > Update Manager) again to update the Wireless Touch Screen 

to Release 1.7. When the update is completed, the Wireless Touch Screen is updated each time 
you run the update for the Control4 system. 

8. After the Wireless Touch Screen is updated, identify the device again by following the instructions 
in Step 3 and pressing the button. 
Note: After you have completed the initial update of performing the special steps for the Wireless 
Touch Screen, you do not need to perform any additional steps; the Wireless Touch Screen is 
now part of the project and will receive updates automatically. 
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3. Glossary 
4 

4Sight: An Internet service that provides a connection to the Home-Automation System any time and 
from any place worldwide. 

A 
AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and 
encoding scheme for digital audio. Touts better sound quality. 
action: An activity that occurs when an event prompts it to do so. 
agent: In Control4 programming, agents provide the ability to perform complex programming by using 
functional modules. There are various types of agents; for example, Announcements, Email 
Notifications, Scheduler, Lighting Scenes, Wakeup, etc. 
AV: Audio Video 

B 
Boolean: The computer logic used to determine if a statement is ‘True’ or ‘False.’ 
button-link binding: The LED colors used based on the device; the Installer can set these colors 
independently from the device to which the colors are bound. 

C 
CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4 
products. 
client: A software or hardware device that communicates to a server for feedback from the server via 
an application for the user. 
Command: A ‘do’ statement; actions the Director communicates to a device. 
Composer: The Control4 software used to design and define a Control4 Home-Automation System. 
Composer Pro: Composer is used to set up and configure Control4 devices to communicate with 
each other in a Home-Automation System. 
conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer 
programming. 
configuration worksheet: Used in Composer software training to design and configure a project in 
Composer. 
connection: Binding or linking devices together in Composer so they can communicate with each 
other. 
contact: Contacts are generally used to monitor the status of something (door, window, water sensor, 
etc.) and can be hooked up through a security panel or directly using a Control4 Controller or 
Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can 
be configured either as NC (normally closed) or NO (normally open). 
Control4 system: A Home-Automation System designed and developed by Control4. 
Controller: The main device that makes Home Automation possible. There may be multiple 
Controllers within a Control4 system. The Controller that runs Director is referred to as the Primary 
Controller. 
Cover Art: An illustration of the cover of a DVD or CD album that displays in the Graphical or On-
Screen Navigators when playing music or watching videos. 
CSV: comma-separated value. Can be used when adding media to a Control4 system. 
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D 
device: A component that requires a device driver; code that is used to allow the Control4 system to 
work with that device. 
device driver: Every device in the Control4 system needs a corresponding device driver to control 
the device. 
DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client and 
a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-
defined list to clients on a network. 
Director: Each Control4 Controller (such as a Home Controller HC-500) ships with pre-installed 
Director software (Linux based) embedded in the device. The Director communicates with Control4 
products and third-party products to enable Home Automation and interaction of individual devices. 
Director runs the Control4 devices. Composer Pro is the software used to connect to and program a 
system Director that resides on a Controller. 
DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-
AV devices. 
DVD: (Digital Versatile Disc) – A media format for video and data storage. 

E 
end point: The end point is the final point (device) on the defined path over which audio and/or video 
content is routed to a room. An example of this would be a TV or Receiver. 
Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star 
network topology that allows multiple points to communicate to a single point. The Speaker Point® 
and Mini Touch Screens use Ethernet to communicate to the Control4 Controller. 
event: An action; used to trigger Composer programming when programming Control4 devices. 

F 
Forward-Phase Dimming (also known as Leading Edge Dimming): A type of phase-cut dimming 
in which the load is dimmed by cutting off the leading edge of each electrical cycle. This type of 
dimming must be used with magnetic transformers (magnetic low-voltage loads) and works well for 
many other load types including incandescent and cold cathode. It should not be used with electronic 
transformers (electronic low-voltage loads) unless the transformer specifications specifically state that 
Forward Phase dimming is allowed. 
file format: A format used by applications to store/read files. 
FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio 
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in 
quality. 
full duplex: The simultaneous transfer of data in both directions. For example, on a 5” or 7” In-Wall 
Touch Screen the caller can send out a call and the receiver on the other end of the call can answer 
via his or her 5” or 7” In-Wall Touch Screen and then respond. 

G 
gateway: (router)- Provides a means of communicating between two separate networks. 

H 
home network: A network installed in the customer’s home that provides an Ethernet or wireless 
connection so that Control4 devices can communicate with each other. 
Home-Automation System: The Control4 system: a line of Home Automation products that 
communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience. 
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I 
Intercom: A two-way audio and/or video communication among supported Control4 Touch Screens. 
Interviewer Wizard: An automated setup program in Composer that builds a project for Home 
Automation. 
IR: A device controlled using a wireless remote control device. Commands are sent via pulses of 
infrared light to the device. 

K 
keypad managed: On a Keypad, the LED state is controlled by the buttons on the Keypad. 
keypad unmanaged: On a Keypad, the LED state of the buttons is controlled through programming 
rather than from the Keypad buttons. 

L 
LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces. 
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen. 
Linux: An operating system used by several Control4 devices. 
List Navigator: A System Remote Control device uses a Navigator that lists the options. 
Live Connection: A term used in Composer Pro to indicate an actual connection to the network. 
Loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are 
on…” 

M 
Media Manager: Media information is stored in the Media Manager database, which will permit users 
to view the media information from the Navigators. 
MP3: A music format that makes streaming audio available. 

N 
Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. 
Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen 
Navigator, Touch Screen, or LCD Screen. 

O 
On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller) 
in the room that controls the source for the on-screen display. 

P 
playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or 
any combination. 
Power Over Ethernet (POE): A Control4 device that is Ethernet controlled. 
programming: A machine-readable artificial language used to express computations that can be 
performed by a device. 
project tree: A tree view in Composer where the project is layered by the larger branches (Home, 
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers). 

R 
ramp rate: The rate that a Dimmer ramps up its voltage. 
relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit. 
remote access: The ability to access a device from a remote location. 
Remote Director: Connects you to the home network while working in Composer from a remote 
location. 
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retrofit: The ability to set up a Home-Automation System in an existing structure or home. Compare 
this with new building construction. 
Reverse-Phase Dimming (also known as Trailing Edge Dimming): A type of phase-cut dimming in 
which the load is dimmed by cutting off the trailing edge of each electrical cycle. This type of dimming 
must be used with electronic transformers (electronic low-voltage loads), and works well for many 
other load types including incandescent; some types of dimmable fluorescent and compact 
fluorescent; and some LED power supplies. It should never be used with magnetic transformers 
(magnetic low-voltage loads). 
RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through Ethernet 
signals. 
router: See gateway. Functions similar to an AP but with additional functionality for controlling the 
network; for example, coordinating traffic between different networks. 

 
S 

serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol 
often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled 
devices are projectors, multi-disc DVD changers, etc. 
switch: An extension of a router that adds more Ethernet ports to support additional devices or clients 
on the local network. 
system event: An action that causes another action; for example, if a projector turns on, it enables 
the other devices in the system that work with the projector. 
system remote: System Remote Control 
System Remote Control: A Control4 System Remote Control is a universal solution that replaces 
System Remote Control devices from other manufacturers, and includes programmable buttons. This 
System Remote Control can access on-screen (Graphical) Navigators. 

T 
Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home’s 
lighting, music, videos, and other devices on the Home-Automation System. 

U 
UI (user interface): The preferred term is Navigator. The Control4 interface used with Control4 
devices to control Home Automation, such as Touch Screens, MyHome apps, or On-Screen 
Navigators. 
universal remote: Universal remote control. A third-party remote control that can be programmed to 
replace other remotes in the home so that only one remote is needed, replacing all others. Control4 
System Remote Control devices are a type of universal remote control. 
USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4 
devices. 

V 
Virtual Connection: A term used in Composer Pro to indicate a connection outside the network. 
Virtual Director: A connection to a virtual Controller only (a PC is the Director host rather than the 
Controller). Projects created or edited here are benign until the saved project is loaded onto a 
Controller. 

W 
WAP: Wireless Access Protocol. The protocol used to enable wireless access of Control4 devices. 
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WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices 
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band 
using a wireless access point. This technology uses the star network topology. WiFi uses high 
bandwidth 802.11. 
wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices 
connected to a network. 
wireless access point: A router extension with an antenna that communicates with WiFi devices and 
clients in the home. A wireless hub that connects to the wired network, and distributes the wireless 
signal. 
Wireless Switch: Uses the ZigBee. UL listed dimmer. Single or multi-gang. Has an air gap to cut 
power. 
WLAN: Wireless local area network. 
WMA: (Windows Media Audio) – Audio data compression technology developed at Microsoft; an 
audio file format that competes with MP3. 

Z 
ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer 
messages from one device to another. Unlike a star network topology where devices can only send 
messages to each other by sending them first to a single central device (which then delivers the 
message to the recipient device), a mesh network topology allows the devices to forward messages 
from one device to another, thereby extending the effective range of the network. Uses low bandwidth 
802.15.4. 250 devices are allowed per controller but Control4 recommends 125. 
ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing 
more interoperability with other Control4 devices, support for home automation profiles, and improves 
the scalability of multiple ZigBee access points. 
Zserver: A ZigBee server that contains software which runs on a Control4 HC-class Controller. 
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Index 

1.8.2 update, 130 
10" Wall Mount Touch Screen, 13 
10.5" Wireless Touch Screen V1, 13 
2, 3, 6-Button Keypad 

change LED colors, 59 
configure, 52 
Properties, 54 

3-way lights 
configure, 67 
configure 2-Button Keypad for, 67 
configure 3-Button Keypad for, 68 

4-Zone Amp 
configure, 34 
Properties, 35 

7" Portable Touch Screen 
configure, 86, 88 
Properties, 87, 88 

7" Tabletop Touch Screen 
configure, 89 
Properties, 89 

AAC, 12 
Advanced Device Configuration, Thermostat, 103 
Advanced Properties 

Wireless Dimmer, Switch, 19 
Agent 

SNMP Configuration, 110 
AMG media lookup service, 14 
Audio Matrix Switch 

configure, 31 
Audio Switch 

configure, 32 
Auxiliary Stage, Thermostat, 105 
Auxiliary Stages, Thermostat, 105 
AV devices 

configure, 30 
AV products, 13 
AV Switch 

configure, 32 
Back up system, 128 
Black & Decker lock 

configure, 106 
Properties, 109 
update firmware, 125 

Broadcast message, Intercom, 90 
CBM Flash Disk 

and Photo Screen Saver, 116 
Celsius, 101 
CFL Load 

Wireless Dimmer, 57 
Wireless Puck Dimmer Module, 74 

Change location, 168 
Cold Start Level 

Wireless Dimmer, 57 
Wireless Dimmer Module, 73 

Cold Start Time 
Wireless Dimmer, 58 
Wireless Puck Dimmer Module, 74 

Composer Pro 
advanced sections, 6 
basic sections, 6 
basic tasks, 16 
check version, 128 
defined, 6 
purpose, 6 
update, 121 

Composer Views Method 
example, 148 

Configure 5" or 7" In-Wall Touch Screen, 89 
Configure properties, 18 
Contact Information, 2 
Contact Relay Extender, 13 
Control and AV Connections 

example, 167 
Control/AV connections 

disconnect, 168 
re-assign, 168 

Control/AV tab, 61 
Control4 website, 123 
Controller 

configure, 23 
troubleshoot, 171 

Controller Networking, 179, 182 
Controller Performance 

view, 181 
Controller properties, 26 
Controllers 

configure multiple, 28 
Cooling Cutoff Point, Thermostat, 104 
Cooling system 

configure, 97 
Copyright, 2 
CPU Usage, 181 
Design project 

example, 149 
Device 

cannot identify, 174 
Device driver, locate, 22 
Device properties, 18 
Device Properties 

example, 18 
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Device, configure 
guidelines, 20 

Devices 
add, 21, 124 
change order in Navigator, 121 
connect, 124 
disconnect, 124 
hide, 120 
install, 16 
refresh, 124 
troubleshoot, 172 
view, 121 

Dimmer 
change LED colors, 58 
configure, 55 
Properties, 56 
troubleshoot, 173 

Director, 12 
troubleshoot, 171 
update, 121 

Disclaimer, 2 
Dock for iPod 

configure, 33 
Document 

new and updated sections, 14 
Document scope, 6 
Documentation 

what's new, 12 
Driver database 

updates, 129 
Drivers 

troubleshoot, 173 
Easy Importer, 13 
Easy Setup, 13 
Emergency Stage, Thermostat, 105 
Fahrenheit, 101 
FLAC, 12 
Flash Navigator, 10 
Full duplex, Intercom, 90 
Gas Fireplace Relay 

configure, 91 
Properties, 92 

GNU, 2 
Gracenote, 2 
Gracenote media lookup service, 14 
Hardware 

no longer supported or partially supported, 13 
Hardware connections 

example, 135 
Hardware supported, OS 2.0, 14 
HC-1000 

configure, 23 

HC-300 
configure, 23 

HC-500 
configure, 23 

HC-800 
configure, 23 

Heat Stage, Thermostat, 105 
Heating Cutoff Point, Thermostat, 104 
Heating system 

configure, 97 
Home Controller HC-1000 V1, 13 
Home Controller HC-1000 V3, 14 
Home Controller HC-500, 13 
Home Theater Controller, 13 
HVAC 

configure, 97 
Identify button 

System Remote Control SR-150, 78 
Identify device, 165 
Intercom, 90 
Intercom license, 90 
Intercom, user experience, 90 
Interviewer Method 

example, 134 
Interviewer wizard 

example, 134 
IO Extender, 14 

configure, 29 
IP Camera 

configure, 106 
IP device 

update, 125 
iPod dock 

configure, 33 
Properties, 33 

iTunes, 14 
Keypad 

troubleshoot, 173 
LED colors 

changing on Dimmer or Switch, 58 
Legal Notice, 2 
License 

Intercom, 90 
Lighting 

configure, 51 
List View properties, 17 
Load Profile 

Wireless Dimmer, 57 
Locks 

configure, 106 
Logging, 180, 184 
Make connections 
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example, 156 
Max On Level 

Wireless Dimmer, 58 
Wireless Puck Dimmer Module, 74 

Maximum Run Time, Thermostat, 105 
Media 

troubleshoot, 172 
Media Controller, 13 
Media Dashboard, 11 
Media Management, 12 
Media Monkey, 14 
Media Player 

configure, 49 
Properties, 51 
scan videos, 50 

Media supported, OS 2.0, 14 
Memory Usage, 181 
Mini Touch Screen V1 and V2, 13 
Minimum On Level 

Wireless Dimmer, 57 
Wireless Puck Dimmer Module, 73 

Minimum Run Time, Thermostat, 105 
MP3, 14 
MPEG, 2 
Multi Channel Amp 

configure, 38 
Properties, 39 

Multi Tuner 
configure, 41 

My Drivers list, 24 
My Drivers tab 

using, 21 
Navigator 

configure, 77 
Flash, 10 
set up Photo Screen Saver, 115 

Navigators 
troubleshoot, 173 

Network tab 
example, 165 

Network Tools, 124 
example, 166 

Online Database 
search for drivers, 22 

OS 2.0 update, 131 
Outlet Light object 

Switch, 61 
Photo Screen Saver 

setup, 115 
Pool Controller, 14 
Power Control 

Switch, 61 

Power learning 
Switch, 61 

Power Learning, 62 
Power sensing, 62 

example, 75 
Wireless Outlet Switch, 61, 63 

Project properties, 17 
Project tree 

add devices, 22 
Properties 

configure, 18 
Wireless 2, 3, 6-Button Keypad, 20 
Wireless Dimmer, 18 
Wireless Switch, 18 

Properties pane, 17 
Puck Dimmer Module 

Properties, 72 
Puck Switch Module 

Properties, 72 
Reboot Control4 system, 16 
Reboot Controller, 17 
Related documents, 7 
Relay, pulse type 

configure pulse single relay, 95 
Properties, 95 

Relay, single contact 
configure, 96 
Properties, 97 

Release 1.2.0, 195 
Release 1.3.0, 194 
Release 1.7.0, 191 
Release 1.7.1, 190 
Release 1.7.2, 190 
Release 1.7.3, 190 
Release 1.7.x, 186 
Release 1.8.x, 186 
Reset Controller, 17 
Room properties, 17 
Screen Saver 

change time, 119 
program, 119 
set up custom, 117 

SD Video Mode, 25 
Search tab 

using, 21 
Security, 12 
SNMP Configuration agent, 110 
SNMP MIBs, install, 109 
SNMP, configure, 109 
Software 

no longer supported or partially supported, 13 
Speaker Point 
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configure, 44 
configure for WiFi, 46 

Stage Cutoff Delay, Auxiliary, 106 
Stage Delay, Auxiliary, 106 
Stage Minimum Off Time, Thermostat, 104 
Switch 

change LED colors, 58 
troubleshoot, 173 

System Diagnostics, 177 
System Info, 180 
System Information, 184 
System Manager, 124 
System Remote Control SR-150 

Properties, 79 
System Remote Control SR-150B 

configure, 78 
program buttons, 80 

System Remote Control SR-250 
change Watch/Listen sources, 86 
change ZigBee channel, 83 
configure, 81 
paging, 85 
program buttons, 84 
Properties, 83 

System Remote Control V1 and V2, 13 
Temperature Calibration, Thermostat, 104 
Test Internet Connection, 179 
Thermostat 

heat/cool engage delta, 103 
lock, unlock, 102 
Remote Temperature Sensor, 102 
set backlight, 103 
set date and time, 103 
setting advanced properties, 103 

Thermostat driver, 106 
Thermostat schedule, change, 101 
Thermostat, set Vacation mode, 102 
Third-party devices 

configure, 21 
Touch Screen 

5" or 7", 89 
Touch Screen, configure, 89 
Troubleshooting, 168 

guidelines, 169 
Update Composer Pro, 121 
Update Director, 121 
Update Manager, 124 
Update system 

best practices, 128 
general steps, 128 
guidelines, 125 
software and drivers, 129 

update times, 126 
Update time 

per device, 127 
Upgrade 

troubleshooting, 174 
USB drive 

and Photo Screen Saver, 116 
USB Install, 14 
USB Restore, 14 
USB stick 

create, 131 
USB WiFi adapter 

HC-300, 25 
Version 

updating to same firmware version, 125 
Video mode 

set correctly, 27 
Web image 

configure, 106 
Web Navigator, 14 
What's New?, 7 
WiFi adapter 

HC-300, 25 
WiFi connection 

Controllers, 25 
Windows Media Player, 14 
Wireless Fireplace Switch 

configure, 93 
Properties, 94 

Wireless Outlet Dimmer 
configure, 65 
Properties, 66 

Wireless Outlet Switch 
configure, 60 
control AV device, 63 
define connection, 61 

Wireless Puck Dimmer 
configure, 69 
Properties, 71 

Wireless Puck Switch 
configure, 69 
Properties, 72 

Wireless Thermostat 
program the schedule, 99 
Properties, 101 
setup, 98 

ZigBee device 
update, 125 

ZigBee Pro, 12 
ZigBee Server, 25 

ensure it is running, 26 
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